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Chapter 1 - Getting Started

1.1 - Introduction

The Designer for WindowsTM manual is intended to give the reader a complete
overview of project development.  For information regarding hardware operation,
please see the UniOP Installation & Operation Guide.

This manual is divided into the following chapters:

• Chapter 1  Getting Started
• Chapter 2   Creating a Project File
• Chapter 3   Controller References
• Chapter 4   The Keyboard Macro Editor
• Chapter 5   Passwords
• Chapter 6   Alarms
• Chapter 7   The Reserved Data Area
• Chapter 8   The Interlock Mailbox
• Chapter 9   The Font Editor
• Chapter 10  Graphics
• Chapter 11       Color
• Chapter 12  Recipes
• Chapter 13  The UniNet Network
• Chapter 14  TouchScreen Programming
• Chapter 15  Multilanguage
• Chapter 16  Designer’s Initialization Files
• Chapter 17  Documenting a Project
• Chapter 18  Application Notes
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1.2 - System Requirements

The following minimum computer hardware is required to use Designer for
WindowsTM:

• 386 Processor

• MS Windows - 3.1, 3.11, 95, 98 or NT

• 13 MB of free hard disk space

• One RS-232C serial port to communicate with the panel

1.3 - Software Installation

To install Designer, insert the first installation disk into your computer.  Start
Windows and select Run from the File menu (if you are running Windows 95 or
98, click on the Start button and select Run from the popup menu).  The installation
file that you need to run is entitled INSTALL.EXE.  You will be prompted for a
destination drive and directory.  Once these have been defined, select the menu
option Install UniOP Designer.  You will be prompted to insert the installation
disks one at a time until all of the necessary files to run Designer for Windows are
installed.  This procedure will create a program group entitled UniOP Designer
within Windows.  Following this, you can either select Install Sample Project Files
or Exit.  If you choose to install the sample project files, a subdirectory entitled
Samples will be created.  If you choose not to install the sample project files,
clicking on Exit will complete the installation procedure.

Note:  MS-WindowsTM must be installed before installing Designer.
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1.4 - Solving Installation Problems

• The installer will report various types of errors when it runs low on disk
space during the installation.  You must have at least 13 megabytes of free
disk space to install the Designer software.

• The installer will also report various types of errors when it runs low on
memory (RAM) during the installation.

1.5 - What Install Does

All executable files, dynamic link libraries, and help files are copied into to the
user-specified directory:

The following files are copied to the Windows directory:

DESIGNER.INI Designer initialization file

DISPLAYS.INI Display and Model descriptions

All font files are copied to the Windows-System directory.

xxx.FON Font files for supported display types
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Chapter 2 - Creating a Project File

2.1 - Overview

Developing applications for a UniOP panel is quick and painless when using our
Designer for WindowsTM software.  The common functionality found among many
WindowsTM applications can also be found in Designer.  This familiar interface
style will allow new users to quickly adapt to the Designer software.

A completed project file (*.PRJ) contains all the information needed to display your
page images and controller data values in the formats defined during development.
The panel hardware will handle all of the underlying communications necessary to
transfer data to and from the controller, leaving you free to concentrate on the
appearance and functionality of your data and display pages.

Designer makes it possible to work in a more natural and intuitive way using the
logic behind your control application to guide you through development.  Instead of
writing computer programs in BASIC, PASCAL or C, you use Designer to create
one or more display pages that outline and control your application.  The multiple
page capability of each panel allows any application to be broken down into as
many pages as you want, depending only on the size of your target system memory.
Display pages can be created quickly and easily by using either the pull-down
menus or the icons from Designer's ToolBelt and Extra ToolBelt.

Completed projects can be recalled from disk or from the panel itself for further
modification.  For instance, a simple project may have only a single page and a few
data fields.  To update this project, either connect to the panel and upload the
existing project or open the file from disk.

The panel must be in Configuration Mode in order to communicate with the
PC (see the section entitled Get Panel Resources for more information).
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2.2 - Creating a Project File

When Designer initially starts, the user is presented with a blank project page
where they may begin editing.  A new project may also be created by selecting New
from the File menu (or click on the appropriate icon in the ToolBelt).  When this
option is selected, the current configuration parameters (for the controller and the
panel) are carried over for use with the new project.  This approach relieves the
user from having to reset the parameters each time a new project is created.  The
latest configuration is saved on exit for use the next time Designer is started.

When switching between two projects with different configurations, the latest
project to be opened overrides the previous and becomes the new default state for
Designer.

To prevent accidental reset of the configuration parameters, the user will be
prompted to confirm the New operation if there are pending modifications that have
not been saved.

Figure 2-1

If Yes is selected, the user will be prompted to enter the filename (if this is the first
time the project file has been saved) and the project file will be saved to disk.  If No
is selected, the current modifications will be lost.  Pressing Cancel will return the
user to the current project.
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2.3 - Identifying a Project File

There are two ways to identify a project file.  First, the user may decide to give the
project file a descriptive name when saving the file to disk.  This method can be
handy to recognize files quickly without opening them, but is often not sufficient.
By selecting Project - Application Name, it is possible to attach a forty character
description to a project file.  When this information is provided, it will be stored in
the project file and will appear on all printed documents produced by Designer.

Figure 2-2

2.4 - Opening Existing Project Files

To open an existing project, select Open from the File menu (or click on the
appropriate icon in the ToolBelt).  The dialog box shown in Figure 2-3 will appear,
allowing the user to view the files in each directory.

Figure 2-3
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Enter the name of the file to be loaded, or use the list box to select from the existing
files.  If the extension is not specified, ".PRJ" is assumed.

2.5 - Saving a Project File

To save a project, select Save from the File menu (or click on the appropriate icon
in the ToolBelt).  The cursor will be momentarily replaced with an hourglass while
the file is being saved.  If the application has not been named, the Save As dialog
box will appear.  This dialog box can also be used to save your project under a
different name.  The Save As dialog box shows the current directory path and the
current filename.  A new name and path may be entered, or the default parameters
may be accepted.  If the extension is omitted, ".PRJ" is assumed.

Figure 2-4

If the file already exists in the selected directory, the user will be prompted to
confirm the Save As operation in order to overwrite the existing file.
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2.6 - Get Panel Resources

Before you begin working on a particular project, you need to specify the type of
display that your panel contains.  The physical size of the screen, as well as it’s
type (backlit LCD, vacuum fluorescent, electroluminescent, passive color) must be
specified.  Failure to do this may result in the loss of text and data whenever you
attempt to download the project file into the panel.

The Get Panel Resources option provides a means of automatically configuring the
software for the panel you are working with.  The following list of steps illustrates
how to use this feature.

1. The UniOP panel must be connected to the PC with a CA1 or CA2 cable.
2. Connect the correct cable to an available PC port.
3. Put the panel in Configuration Mode by holding down the ENTER key for a 

few seconds.  When the Panel Command Menu appears, use the cursor keys to 
highlight the Configuration option and then press ENTER.
The panel must be in Configuration Mode in order to communicate with 
the PC.

4. Select Get Panel Resources from the Transfers pull down menu (or click on
the appropriate icon in the Extra ToolBelt).

5. Select Yes to copy the panel resources into the current project file.  This
transfers the panel size and type automatically from the panel’s memory and
updates the Designer display.

It is also possible for the user to manually configure the software.  This is done by
selecting Panel Setup from within the Project menu.  This procedure is discussed
later in this chapter in the section entitled Panel Setup.
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2.7 - Quick Start Tutorial

The following tutorial assumes that you have already installed the software as
described in section 1.3.

STEP 1 Connect the PC programming cable to the panel.

STEP 2 Connect the controller’s communication cable to the panel.

STEP 3 Locate the UniOP Designer program group.

(This group was created when the Designer software was installed)

STEP 4 Click on the icon for Designer.
(Looks like a small UniOP panel)

STEP 5 Once Designer is open, select Communications from the Options
menu.  Set up the communications port that Designer uses to
communicate with the panel.

STEP 6 To choose a port, simply click on a radio button with the mouse.  To
communicate with a panel, use the following parameters:  9600 baud,
no parity, and 1 stop bit.

(Ports that are unavailable will be grayed out)

STEP 7 Next, select Project - Change Controller Driver.  Select the
appropriate driver for your application.

STEP 8 Next, select Project - Panel Setup.  Select the type of display that the
UniOP panel has.

STEP 9 Next, choose Project - Controller Setup to select the particular
controller model being used.  Set up the communication parameters by
selecting the PLC Comm button.

STEP 10 We are now ready to begin designing the project page.  Using the PC
keyboard, type the words "This is a data value =" on the first page of
the project.
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STEP 11 Place the cursor after the equals sign that was typed above and press
ENTER.

(The Define Field dialog box will appear on the screen - see Fig. 2-
5.)

STEP 12 Fill in the controller reference portion of the define field dialog box
with the appropriate data.

The data reference MUST already exist in the controller.

STEP 13 Click on the OK button in order to confirm the operation and create the
field (see Fig. 2-6).

STEP 14 Select Save from the File menu to save the project to disk.

(Optional for tutorial)

STEP 15 Power up the UniOP panel and make sure it is in Configuration Mode.
The panel MUST be in Configuration Mode to communicate with the
Designer software!  When the unit is in Configuration Mode, the words
CONFIGURATION MODE will appear on the panel.

If you do not see the words CONFIGURATION MODE displayed on the panel:

STEP 1:  Hold down the ENTER key until the command menu appears.

STEP 2:  Use the arrow keys to highlight CONFIG or CFG and press ENTER again.

STEP 16 Select Transfers-Download from the main menu to send the project to
the panel.

(If the default setup of the Designer software has not been changed,
the project will start automatically after being downloaded)
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STEP 17 After a short pause, check the display:

The text that was typed in step 10 should be visible, along with the
data value read from the controller.

The Fault light should be off.

The Com and Run lights (if present) should be ON.

  A blinking Com light indicates a communications error.

Step 8 could have been eliminated by placing the panel in Configuration Mode and
selecting Get Panel Resources from the Transfers menu.

Figure 2-5 shows the define field dialog box described in step 11.  Keep in mind
that this dialog box is controller specific.

Figure 2-6 shows what the user’s computer screen should resemble once step 13 is
completed.
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Figure 2-5
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Figure 2-6
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2.8 - Change Controller Driver

Designer offers support for all major brands of PLCs and other controllers.  By
selecting Change Controller Driver from the Project menu, the user will be able to
select the controller family that they will be working with (i.e., Allen Bradley,
Mitsubishi, etc.).  Note that Designer uses the current controller setup and
applies this setting to all subsequent projects.

Whenever a project file is saved, Designer stores the project type ID within the
project file.  This ID is used to recall the selected driver whenever the project file is
opened.

Figure 2-7
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2.9 - Panel Setup

By selecting Panel Setup from the Project menu (or by clicking on the appropriate
icon in the Extra ToolBelt), the user will be presented with a dialog box that allows
them to configure the software for the panel that they are using.  This dialog box
allows the user to specify the time and date format that the panel will display,
whether or not to enable the UniNET network for this panel (note that the UniNET
network must first be configured before this option will become available), and if
the panel is capable of touchscreen and/or enhanced graphics support.

Figure 2-8

To choose a new panel model, click on the down arrow located to the right of the
panel description window.  A drop-down list will appear that shows the available
panels that can be selected.  To select a panel, simply single click the left mouse
button on its description and click on OK.  The page editor workspace will change
in order to reflect the available screen area on the selected model.
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The panel model may be changed at any time during development.  However, be
aware that some restrictions apply regarding the screen area.  The user can change
the display from a small screen size to a larger screen size without affecting the
contents of the project.  However, changing from a large screen size to a smaller
screen size may cause some data fields to be deleted if they are beyond the new
screen boundary.  If this occurs, the user will be given the chance to cancel the
operation before any fields are deleted.

The communication parameters between the panel and the PC can be defined by
selecting Communications from the Options menu.  All UniOP panels are capable
of communicating with a PC at a speed of at least 9600 baud.

Upload Protection

This feature allows the user to password protect the project file so that
unauthorized uploads cannot occur.  By selecting Project – Panel Setup, and
clicking on the Protection… button, you are able to specify a case-sensitive
password of up to eight characters.

Figure 2-9

Once this password is specified, every time you attempt to upload the project from
the panel onto your computer, Designer will ask you to enter the password.  If the
password that you enter matches the one that was defined in the project file, the
upload operation will be performed properly.
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However, if you enter a password that doesn’t match the one that was specified in
the project file, the panel will not start the upload process.

Note:  Your panel must contain firmware version 4.10 or later to use this feature.

Remote Passthrough

This feature will allow you to remotely put a UniOP panel into either Configuration
Mode or Operation Mode via a modem.  In this manner, you will be able to
remotely upload or download a project file, start the panel, or use passthrough
mode to access the programming port on the PLC.  Your UniOP must contain
firmware version 4.10 or later to use this feature.

To set up Designer for Remote Passthrough, select Project – Panel Setup and click
on the RPT Setup… button.  This will bring up the following dialog box.

Figure 2-10



Creating a Project File

Exor Electronic R&D                                                            2-15

To configure Designer for remote passthrough via a modem, you need to select
Remote hardware pass through.  If you select Hardware pass through, it will not
work correctly.  Hardware pass through needs to be selected only if you are
wanting to use pass through mode locally and not via a modem.

You can enter the commands that you wish to enter in order to put the panel into
Configuration Mode, to start pass through mode and to stop pass through mode in
the ‘request’ boxes.  Likewise, you can enter the response that you will receive
back from the panel in the ‘response’ boxes.

The communication parameters that you set up here need to match the
communication parameters of your modem.  Once you have everything configured,
you can use a terminal program to dial up the panel.

The configured dialog box for Remote hardware passthrough may look something
like what is shown in Figure 2-11.

Figure 2-11
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Configuration of the Modem Attached to the Local PC

The following commands are necessary for the modem that is attached to the local
end (the PC that is running Designer).

AT  &D0  &K0  &Q0  &W  &Y

Term Explanation

&D0 DTR is ignored (according to &Q setting)
&K0 Disable flow control
&Q0 Direct asynchronous operation
&W Stores setting in profile 0
&Y Profile 0 is loaded on power up

Configuration of the Modem Attached to UniOP

The following commands are necessary for the modem that is attached to the
remote end (the UniOP panel).

AT  &D0  %C0  &K0  &Q0  S0=1  &W  &Y

Term Description

&D0 DTR is ignored
%C0 Disable data compression
&K0 Disable flow control
&Q0 Direct asynchronous operation
S0=1 Auto answer after 1 ring
&W Stores setting in profile 0
&Y Profile 0 is loaded on power up
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Passthrough Commands from Designer

When remote passthrough has been configured in Panel Setup, a new entry will be
available in the Transfers menu of Designer.  This new entry is called Start remote
pass-through.  This entry will allow the user to select one of three remote
passthrough commands: Go to Configuration Mode, Start Passthrough and Stop
Passthrough.

Passthrough Status Control Variable

When passthrough mode has been activated, the UniOP does not communicate with
the controller and the dynamic data displayed on the screen may no longer be
correct.  It may be useful to inform the user that the passthrough option is active.
A new control variable has been defined for this purpose.  The control variable
name is PassThrough Status.  This variable can take on two values; zero meaning
that passthrough is not active, one meaning that passthrough is active.

Miscellaneous Panel Parameters

The Misc. Setup button allows the user to configure several different panel
parameters, including:

• Display Selected Page on Communication Error
This is the page the panel will go to when a communication error is
reported.

• Timeout for Panel Command Menu Display
When you are in the Panel Command Menu, this is the period of time the 
panel will wait for a keystroke before returning to normal operation.

• Timeout for Data Entry
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When you are in the data entry screen, this is the period of time the panel 
will wait for a keystroke before returning to normal operation.

• Timeout for Field Selection for Data Entry
This is the time period the panel will wait for a field selection to be made 
before returning to normal operation.

• Screen Saver for LCD Backlight
This option allows the user to turn off the backlighting on an LCD panel when
no keys or touchcells have been pressed for a certain amount of time.

• Enable Buzzer
This option allows the user to toggle on and off the touchscreen response
enunciator.

• Disable Battery LED
This option allows the user to disable the low battery LED (the FAULT LED)
on the UniOP.  Whenever the battery becomes low, the FAULT LED will
begin flashing.  This option allows the user to disalbe this in cases which the
battery low alarm is not required.  This feature requires firmware version 4.20
or greater.
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2.10 - Select Font

To choose a new panel font, either click on the down arrow at the right of the font
window, select the appropriate icon from the Extra ToolBelt, or choose Select Font
from the Project menu.  A drop-down list will appear showing the available fonts
for the current panel.  Click on the font name to be used and press the OK button to
confirm the change.  Existing text on the current page will change to reflect the new
selection.  Any future text additions will also appear in the newly selected font.
Selecting a new font for an existing project can alter any special characters,
message fields, and bargraphs that are contained in the project file.

Figure 2-12

The Font Size buttons can be used during programming to change the character
size of any text or variable field.  Regular characters are simply a single character.
Double characters are twice the size of a regular character (2x2).  Large characters
are four times the size of a regular character (4x4).  Extra large characters are eight
times the size of a regular character (8x8).  Note that the only panels in which it is
possible to enlarge the font size are those that are capable of graphics.
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2.11 - Controller Setup

Different models of controllers require different parameters in order to
communicate properly with the operator interface panel.  Once the controller family
(i.e., Allen Bradley, Mitsubishi, etc.) has been selected by choosing Change
Controller Driver from the Project menu, it is necessary to select the controller
model.  This can be accomplished by selecting Controller Setup from the Project
menu (or by clicking on the appropriate icon in the Extra ToolBelt).  This will
bring up a dialog box that allows the user to select the correct controller model that
is being used.

Figure 2-13

The Access Multiple PLCs checkbox shown in the above dialog box will allow the
panel to exchange data with more than one controller.  The user will be asked to
enter the slave IDs of the different controllers from which the panel will be
accessing data.  This option is not available with all controllers.

The communication parameters for any particular controller are set automatically
when the selection is made.  However, if there is a need to change the default
setting, the user may press the PLC Comm button in the PLC Setup dialog box.
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This will bring up the Communications Parameters Setup dialog box, which is
shown in Figure 2-14.

Figure 2-14

Baud Rate
This option specifies the baud rate to be used in communication between the target
panel and the controller.  The baud rate can be changed by using the selection
arrows located to the right of the Baud Rate window.

Parity
Specifies the parity to be used in communication between the target panel and the
controller.  To select a different parity, click on the appropriate radio button.

Stop Bits
Specifies the number of stop bits to be used in communication between the target
panel and the controller.  To change the number of stop bits, click on the
appropriate radio button.
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2.12 - Printing From the Panel

The printing routines from the panel have been greatly enhanced.  With the new
features, it is now possible to define the printer device driver and the
communication parameters, the report format and the timetable on which a report is
printed.  It is even possible to print a report by configuring a key or touchcell to
print a report, or to request a printout by using the Interlock Mailbox.  In order to
use these new features, your panel must contain firmware version 4.10 or higher.

To setup a serial printer, select Project – Report on Panel Printer - Printer Setup.
This will display the dialog box that is shown in Figure 2-15.  From this dialog
box, you can choose the printer you will be using and set the communication
parameters.  If you will be using a printer that is not listed, you can use the Add…
button to add a new printer to the list of available printers.  Doing so will bring up
another dialog box in which you can define the parameters for the newly added
printer.  Similarly, you can use the Edit… button to redefine the parameters for an
existing printer.  It is also possible to define the page size that you will be using.

Note that if the user will be printing reports, the paper height should be defined
here before the report is defined.  If you change the paper height with some reports
already defined, the report layouts that have already been defined will not
automatically be rearranged.
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Figure 2-15

Reports

A report is a collection of project file pages (or parts of project file pages).  Each
report is divided into two parts.  One is a common part, such as the header and
footer.  These will be common to each and every page of the report.  The second is
the display page that is the body of the report.

To define a report, select Project – Report on Panel Printer – Reports.  The user
can use the dialog box in Figure 13 to configure a basic report.  For those users
who will be creating more advanced reports, an Advanced button and a
Properties… button are present.
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Figure 2-16

You can add a report by selecting the New button and giving the report a name.  All
of the pages of your project file will be shown within the Available pages box.  To
add a page to the current report, select the page from within Available pages and
click on the <- Add button.  Doing so will place the page name into the Report
pages box.  To add all of the pages of your project file to a report, select the <<
Add All button.

Similarly, to remove a page from the current report, select the page name from
within the Report pages box and click on the Remove -> button.  To remove all of
the pages from the report, click on the Remove All >> button.  By selecting the
page that you are interested in and pressing the Properties button, the user is able
to specify what part of the project file page to print and where to start printing on
the page.  The dialog box is shown in Figure 2-17.
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Figure 2-17

By selecting the Advanced button, the user is able to select the following
parameters, which are common for every page in the report.  The dialog box is
shown in Figure 2-18.

•  Condensed or Enlarged Mode Printing

•  Wrapping – If wrapping is selected, if a line is longer than the width of the page,
it will be printed on the next line.  Otherwise, it will be truncated.

•  Packing – If the page width is longer than the display width, it is possible to print
two or more rows on a single line.

•  Non-printable characters can be printed as blanks, asterisks, or with
downloadable fonts.  The downloadable options are grayed out if they are not
supported by the printer.

•  Display attributes can be transformed into another printer attribute, such as
normal, underlined, bold or italicized.

•  The Page separator is a character that can be optionally defined as a place-holder
for empty lines in the printed page.

•  The field font specifies the default font to use when the user has not selected a
particular font to use in the page definition dialog box (see Figure 2-17).

.
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Figure 2-18

Header/Footer Definition

The last two buttons used for configuring a report are the Header and Footer
buttons.  The structure of the header and the footer are the same.  It is possible to
define the height of the header and the footer, and several predefined fields that can
be inserted into the header or footer.
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Figure 2-19
Within this dialog box, the user can specify the height of the header/footer, the
fields that are inserted into the header/footer, where they are inserted at and how the
are positioned.  The fields that can be used are the time and date, the page number,
the report name and a label (which allows the user to enter static text).

Starting a Report Printout

A report printout can be triggered in three different ways:

•  With a macro that is associated to a function key or a touchcell.
•  Cyclically at a specified time.
•  From a PLC request issued through the Interlock Mailbox.

In the Keyboard Macro Editor, there is a new macro entitled Print Report.  When
this icon is selected, the user will be presented with a dialog box which will allow
them to select which report is to be printed when this key (or touchcell) is pressed.

Any report can be printed cyclically in two different modes:  any day at a specific
time or cyclically after an interval of time.  The dialog box shown in
Figure 2-20 allows the user to define these characteristics.  This dialog box can be
chosen be selecting Project – Report on Panel Printer – Triggers.
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Figure 2-20

The third way to start a report printout is to use the Interlock Mailbox.  There are
two new Mailbox commands that are introduced for this procedure.

Start Report Printout:
Command Word: 113
Parameter 0: Report Number
Responses: 0 = OK

1 = Error, printer process already active (if START command is
       issued more than once.

Error, printer process already inactive (if CANCEL command
is issued more than once)

     2 = Error, illegal report number
     3 = Error, activation queue is full

Stop Report Printout:
Command Word: 114
Parameter 0: None required
Responses: 0 = OK

1 = Error, printer process already inactive
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Note that it is possible to start the printing of more than one report.  Up to 10
printer requests can be stored in a FIFO (first in first out) buffer.

Printer Device Driver Parameters

This section highlights the device driver parameters for the main printer types that
are supported in the Designer for Windows programming software.  The following
four printer types are currently supported:

•  ALFAPANEL.PRN – Driver for AlfaPanel printer from Edue Italia
•  IBMPRO.PRN – Driver for the IBM Proprinter (dot matrix)
•  HPLJ40.PRN & HPLJ80.PRN – Drivers for the HP LaserJet printer; the first
one for use with a 40 column operator interface panel and the second one for use
with an 80 column operator interface panel.

HP LaserJet III (or HP laser compatible printer)

The escape sequences given in this section have been tested with:

• HP LaserJet III;
• HP LaserJet IV;

The list of escape sequences for text and graphic control is given in table 2-1.  The
printer control code is 0.
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Command Sequence (decimal codes)
Initial Settings See note 1

• reset printer
• set draft mode
• set letter quality mode

27 69
27 40 115 49 81
27 40 115 50 81

BOLD set 27 40 115 51 66

BOLD clear 27 40 115 48 66

ITALIC set 27 40 115 49 83

ITALIC clear 27 40 115 48 83

UNDERLINE set 27 38 100 49 68

UNDERLINE clear 27 38 100 64

CONDENSED set 27 40 115 50 48 72

CONDENSED clear 27 40 115 49 48 72

ENLARGED set 27 40 115 53 72

ENLARGED clear 27 40 115 49 48 72

Graphic mode

27 42 48 65 27 42 116 [resolution]2 82
27 42 114 49 85 27 42 98 [line

length]3 87
75 dpi [resolution]=55 53

150 dpi [resolution]=49 53 48

300 dpi [resolution]=51 48 48

600 dpi4 [resolution]=54 48 48

Graphic LF See note 5

Table 2-1

The ratio of the character width in text and graphic mode depends on the resolution
of the graphical printout in the following way:

                                                  
1 It is possible to use any combination of these escape sequences.
2 These bytes specify resolution. It is specified with two or three bytes that represents
resolution value in the ASCII format. Allowed values are given bellow.
3 Line length depends on the width of the printed slide and the quality. See the
explanation bellow for more information. Line length is specified with the value
represented in the ASCII numeric format.
4 Allowed on the HP LaserJet V and higher versions.
5 In case of HP PCL it is not necessary to insert graphical new line separately, since the
sequence that starts new graphical line forces starting at new line.
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Resolution (dots per inch) Ratio
75 1

150 2
300 4
600 8

Table 2-2

The line length depends on the following facts:

• Width of the page that is being printed.  When printing pages with a maximum
of 40 columns, one line contains a fixed number of 60 bytes.  In the case of an
80 column page, one line contains a fixed number of 100 bytes.

• Line length varies with rasterisation quality.  When rasterisation quality is
normal, line lengths have the values mentioned above.  As rasterisation level is
increased, line length is doubled for each level, as it is shown in table 2-3.

WIDTH OF THE SLIDE
40 80

LOW (1) 60 100
NORMAL (2) 120 200

RASTERISATION
LEVEL

HIGH (3) 240 400

Table 2-3
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IBM Proprinter (or IBM matrix compatible printer)

The escape sequences defined in this section have been tested with:

• Epson LQ-400;

The list of escape sequences for text and graphic control is given in table 2-4.

Command Sequence (decimal codes)
Initial Settings 27 64 27 77 27 120 0 27 107 2

BOLD set 27 69

BOLD clear 27 70

ITALIC set 27 52

ITALIC clear 27 53

UNDERLINE set 27 71

UNDERLINE clear 27 72

CONDENSED set 27 103

CONDENSED clear 27 77

ENLARGED set 27 80

ENLARGED clear 27 77

Graphic mode See note 6

60 dpi 27 42 0 8 0

90 dpi 27 42 6 8 0

120 dpi 27 42 1 8 0

240 dpi 27 42 3 8 0

Graphic LF 13 27 74 24

Font n See note 7

Table 2-4

                                                  
6 Available printing modes depends on the printer type. Escape sequence given here
should work on all 9-pin dot matrix IBM Proprinter compatible devices.
7 Available fonts depend on the printer type. A number of older Proprinter compatible
devices support only one default font. In this case these escape sequences are obsolete and
should be set to zero.
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The ratio of the character width in the text and graphic mode depends on the
resolution of graphical printout in the following way:

Resolution (dots per inch) Ratio
60 1
90 3:2

120 4
240 8

Table 2-5

The length of the graphical data block is always set to the value 8, regardless of the
display width.  In this case, the data block width is specified with the last two bytes
in the sequence that starts graphic mode.  The length is specified with the equation
a + 256 * b, where a is the 4th byte in the sequence and b is 5th number in the
sequence.  Both numbers are integers in the range of 0 to 255.  The structure of the
sequence can be different in the case of different Proprinter compatible printers.

AlfaPanel Printer

The escape sequences described in this section have been tested with:

• AlfaPanel 2;

The list of escape sequences for text and graphic control is given in table 2-6.  The
printer control code is 2, and the ratio of the character width in the text and graphic
mode should be set to 1.
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Command Sequence (decimal codes)
Initial Settings

• normal writing
• upside down writing

27 78
27 82

ENLARGED set 03

ENLARGED clear 00

Graphic Mode 17

Graphic LF 13

Table 2-6

2.13 - Memory Used by the Project File

The user can determine how much memory is used by the current project file by
selecting Memory Use from the Project menu.  A dialog box (shown below in
Figure 2-21) will appear that contains information on the amount of memory that is
used by the project file, how many bytes of Recipe data are contained within the
project file and the amount of memory used by the graphic information (bitmaps
and touchcells) in the project file.

Figure 2-21
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Chapter 3 - Controller References

Controller references are those data items that the Designer software uses to display
information from the controller.  These data items come in the form of numeric
fields (which can be displayed in numeric format or in ASCII format),  bargraphs,
message fields, and attributes.  Each of these are discussed in detail below and on
the following pages.

3.1 - Numeric Fields

1. There are four different ways to create a numeric field.  One way is to position
the cursor at the desired location and click on the Controller Data icon in the
Extra ToolBelt.  Then, either double click the left mouse button or single click
the right mouse button on the location where you want the field.  Another way
is to position the cursor on the desired location and select Data Field Type -
Numeric/ASCII from the Edit menu.  The third and perhaps simplest way to
create a numeric field is to simply position the cursor on the desired location
and click on the Numeric Field icon in the ToolBelt.  Finally, you may click
and drag an area in which the field is to be located, then click on the Numeric
Field icon in the ToolBelt.  This method will automatically set the height and
width of the field.

2. Once the numeric field is created using one of the four methods described
above, a dialog box (shown in Figure 3-1) will appear.
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Figure 3-1

3. The upper portion of the dialog box is the PLC Reference section.  This area
is dependent upon the type of controller selected.  The data type, data format,
and address reference are all configured in this area.

 4. The lower portion of this dialog box is not controller specific.  This area is 
used to direct the panel in the manner to display the data.  The following 
items can be configured:
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•  Display format •  Numeric base
•  Data access (read only, read/write field) •  Field dimensions
•  Data scaling •  Min. & max. values 

         (read/write field only)

3.2 - Bargraphs

1. There are four different ways in which a user can create a bargraph field.  One
method is to first click and drag the mouse to select the size and location of the
bargraph, followed by selecting the Bargraph Field icon located in the ToolBelt.
Another way is to position the cursor at the location in which the bargraph is to
begin and select the Bargraph Field icon from the ToolBelt.  A third method of
creating a bargraph is to position the cursor at the location in which the field is
to begin and select Data Field Type - Bargraph from the Edit menu.  A final
method is to click and drag the mouse to select the size and location of the
bargraph and then select Data Field Type - Bargraph from the Edit menu.
Regardless of the method, the define field dialog box will automatically appear,
allowing the user to select an address in which to dynamically fix the bargraph.

2. Once the field is created using one of the above methods, a dialog box will
appear that is very similar to the one that appears when a numeric field is
created.  The address that was chosen in the PLC Reference section will be
dynamically linked to the bargraph.  In other words, the value of the register will
correspond to the fill level of the bargraph.  The maximum value of the field is
represented when the bargraph is full.  Likewise, the minimum value is
represented when the bargraph is empty.

3. Figure 3-2 represents a bargraph with a field width of 20, a field height of 3, a
minimum value of 0, and a maximum value of 100.  The minimum value is the
point at which the bargraph is empty.  Likewise, the maximum value is the point
at which the bargraph is full.
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     The border around the bargraph can be drawn by highlighting the area around
the bargraph field and then selecting Rectangles & Symbols from the Edit menu.
Doing so will bring up a dialog box that contains two different borders that can
be placed around the bargraph.  The Designer software considers this border as
a graphic.  Therefore, this feature can only be accessed on a graphics capable
panel.

Figure 3-2
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3.3 - Message Fields

Message fields can be used instead of numerical values to inform the user that an
event is occurring.  For example, assume the message ‘Voltage too high’ is attached
to the value 32.  Whenever the value of the register in the controller reaches 32, the
message will be displayed.  In this manner, a text message is displayed on the
panel, which is often more beneficial and meaningful to the operator than
displaying a numerical value.

Note:  The maximum number of messages that can be displayed is 1024.

1.  Message fields can be created in one of two ways.  One method is to first 
click and drag the mouse to highlight the area in which the message field 
is to be placed and then select the Text Message Field icon from the 
ToolBelt.  The other possible way to create a message field is to place the 
cursor at the desired screen location and select Data Field Type - Message
from the Edit menu.

2. Once the message field is created using one of the methods described above,
a dialog box will appear that is very similar to those that appear when creating
numeric fields and bargraph fields.  The number of messages to be displayed
is set by the values for the minimum and maximum values.  For example, if
the message is fixed to a bit, the field will have a maximum of two
messages.  The width of the field is equivalent to the maximum number of
characters the message field can contain.  Once the parameters are
configured, click on the Edit Message button to begin entering messages for
the different data values.

3.  Select the message you wish to edit by clicking the left mouse button on the
desired value and begin typing the message.  The dialog box in which the
messages will be entered is shown in Figure 3-3.
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Figure 3-3

4.  Special characters may be added to the message by clicking on the Spec 
chars button.  This will bring up a dialog box (shown below in Figure 3-4) in

which the user can select the character(s) to be used by double clicking on
them or by single clicking on them and pressing Select.  After confirming the
operation, the characters will appear in the last position the cursor was in before
entering the special characters dialog box.

Figure 3-4

The familiar WindowsTM features cut, copy, and paste are also available for use in
editing messages.  If you have several messages that are similar, you can use the
Copy and Paste features to copy messages and then make any necessary changes.
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Simply select which messages to copy by highlighting them.  If you want to copy
several messages that are in successive order, click on the first one and drag the
mouse down until the last one is highlighted and release the mouse button.  If you
have several messages to copy that are not in successive order, hold down the Ctrl
key, click on each of the messages that you want to copy, and release the Ctrl
key.  All of these methods will select the text to be copied.

Now, click on the Copy icon to copy the messages into Windows’ Clipboard.
Highlight the message number where you want to paste the first message and click
on Paste to copy the messages into their new locations.  You can also use a
Windows based text editor, such as Notepad, to create a list of messages.  To do
this, place each message on a separate line.  Use the Copy function of the editor to
copy the text to the Clipboard and then use the Paste feature to copy the messages
into their new locations.

3.4 - Attributes

Attributes allow the user to make an area of the screen stand out by highlighting
the area, reversing the area, or blinking the area.  A description of how to use and
create attributes follows.

1. Attribute fields can be created by clicking and dragging the mouse to select 
the area in which the attribute is to be displayed.

2. Either select Data Field Type - Attribute from the Edit menu or click on the 
appropriate icon in the ToolBelt.  Doing so will bring up a dialog box in 
which the user can choose between using static attributes and dynamic 
attributes.  This dialog box is shown in Figure 3-5.
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Figure 3-5

3. If static is selected, any combination of the blink, reverse, and highlight 
attributes may be used.

4. If dynamic is selected, the screen attribute will be fixed to a value of a word
or bit in the controller.  The address of the controller’s memory location can
be entered in the upper portion of the dialog box as was previously done with
the other data fields.
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A Note on Dynamic Attributes:

- If the attribute is referenced to a word, the attribute will be dependent upon the
three least significant bits in the controller’s memory location.

Decimal Value Bit 2 Bit 1 Bit 0 Attribute
0 0 0 0 Normal
1 0 0 1 Blinking
2 0 1 0 Highlight
4 1 0 0 Reverse

- If the attribute is referenced to a bit, there will be no attribute displayed when
the bit has the value of 0.  The blink attribute will be displayed whenever the bit
has a value of 1.

Keep in mind that not all attributes are supported on every panel.

Color Attributes

All UniOP color panels support a new type of dynamic attribute field that will
allow the user to dynamically control the color of an area on the display.  The color
attributes have been introduced as an extension to the existing monochrome
dynamic attributes (blink, reverse and highlight).

The word in the controller memory referenced by the dynamic attribute will be
interpreted as shown in the table below.

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
F0-F3 B0-B3 C M0-M2

Foreground color Background color Monochrome
attribute
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C is the bit that enables the color attribute mode:

C Color
attributes

0 Disabled
1 Enabled

The Color attributes are interpreted according to the table below.

Bit
3 2 1 0

Numeric value Color

0 0 0 0 0 Black
0 0 0 1 1 Dark Red
0 0 1 0 2 Dark Green
0 0 1 1 3 Dark Yellow
0 1 0 0 4 Dark Blue
0 1 0 1 5 Dark Magenta
0 1 1 0 6 Dark Cyan
0 1 1 1 7 Dark Gray
1 0 0 0 8 Light Gray
1 0 0 1 9 Red
1 0 1 0 10 Green
1 0 1 1 11 Yellow
1 1 0 0 12 Blue
1 1 0 1 13 Magenta
1 1 1 0 14 Cyan
1 1 1 1 15 White

Note that the Foreground color and the Background color can be independently
controlled.  UniOP firmware 4.20 or later is required to support dynamic color
attributes.
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3.5 - Scaling

Our software is capable of scaling data being sent to or being displayed from the
controller.  Scaling can be done to a field from within the define field dialog box
(see Figure 3-6).

Another feature that parallels with scaling is the ability to use fixed point numbers.
This allows the user to display decimal values on the panel.  Simply select the
Fixed Point radio button and enter the number of decimal places to be displayed in
the Placement box (see Figure 3-6).  Keep in mind that the decimal point will take
up one position in the field (i.e., a field with a width of four and a placement of 1
can display at most the number 99.9).

The Scaling Equation

The scaling equation is defined as:
Y =   (A / B ) * X + C

Where,
Y = Scaled value displayed
X = Controller data value
A,B,C = Scaling operators - these are the three entry boxes located within

    the scaling equation

Figure 3-6
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There are two important concepts to understand about scaling.  First and foremost,
the scaling operators (A, B, and C) are 16 bit integers.  Internal calculations are
done using 32 bit arithmetic, which allows the panel to report a more precise
result than if it were using only 16 bit arithmetic.

Secondly, the maximum and minimum fields refer to the scaled value, not the
value that is in the controller.

Two examples of using scaling follow.  The first is an example in which a user has
a Celsius temperature in the controller and wishes to display a Fahrenheit
temperature on the UniOP panel.  The second is an example in which a user has a
controller memory location that can range in value from 0 to 4095.  Depending
upon the value in the controller, the user wishes to display that value as a
percentage of the maximum possible value on the panel.

Example 1

Assume a user has a controller that is displaying the temperature of a motor in
Celsius.  The person operating the Exor UniOP panel is only familiar with
temperatures in the Fahrenheit scale.  By using scaling, the user is capable of
having the Celsius temperature from the controller appear as a Fahrenheit
temperature on the display panel.

1. Create a numeric field and reference it to the address in the controller that is
reporting the temperature.  For this example, assume the address is DM155.
Once the numeric field is created, the define field dialog box will appear.

2. We know that to convert a value from Celsius to Fahrenheit, we need to
multiply the Celsius temperature by 9/5 and add 32 to the result.

3. Consider the scaling equation again : Y = (A/B) * X + C.  Since X is the
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Celsius temperature in the controller, this is the value we want to multiply 
by 9/5.  To implement this, we would need to set A equal to 9 and B equal 
to 5.

4.  Adding 32 to this value can be accomplished by setting C equal to 32.

5. Clicking on OK will confirm this operation.  The value displayed on the 
panel will be in Fahrenheit, while the controller data will be in Celsius.  The

dialog box should look similar to the one shown in Figure 3-7.

Figure 3-7
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Example 2

Assume a user has a controller memory location whose numeric value can range
from 0 to 4095.  The user wants to display the actual value in the controller as a
percentage of the maximum value.

1.  Create a numeric field and reference it to the address in the controller that is
reporting the value.  For this example, assume the address is V2040.  Once the
numeric field is created, the define field dialog box will appear.

2.  Since the user wishes to display the actual value in the controller as a percentage
of the maximum value, we need to use scaling.  If the actual value in the
controller is 0, then the panel should display a 0.  If the actual value in the
controller is 4095, the panel should display a 100.

3.  This can be accomplished by using the following method.  Simply divide the
value in the controller by the maximum possible value and multiply this result
by 100 to turn it into a percentage.  To do this we need to set A=100, B=4095,
and C=0.  The dialog box should be similar to the one shown in Figure 3-8.
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Figure 3-8
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3.6 - Indexed Addressing

Indexed addressing mode allows the user to reference many controller memory
locations from a single numeric field.  This enables the user to monitor the values
of many memory locations while using only one field.  This feature can be accessed
by either clicking on the appropriate icon in the Extra ToolBelt or by selecting
Indexed Addressing Mode from the Edit menu.  An example of using indexed
addressing is given below.

Example

For this example, assume a user has a plant in which industrial equipment is
washed.  There are three stages comprising the wash process.  The user wants to
be able to monitor the water temperature, the water pressure, the amount of time
the equipment was in a particular stage, and the stage the process is in; all
without pressing a key on the panel.  The controller memory locations and their
contents for this example are as follows:

DB10 DW0 - Temperature in Stage 1 (ranges between 0 and 9999)
DB10 DW1 - Temperature in Stage 2 (ranges between 0 and 9999)
DB10 DW2 - Temperature in Stage 3 (ranges between 0 and 9999)
DB10 DW3 - Pressure in Stage 1 (ranges between 0 and 9999)
DB10 DW4 - Pressure in Stage 2 (ranges between 0 and 9999)
DB10 DW5 - Pressure in Stage 3 (ranges between 0 and 9999)
DB10 DW6 - Time in Stage 1 (ranges between 0 and 9999)
DB10 DW7 - Time in Stage 2 (ranges between 0 and 9999)
DB10 DW8 - Time in Stage 3 (ranges between 0 and 9999)
DB10 DW9 - The stage the process is currently in (ranges between 1 and 3)

The numeric values are written into the controller by the machine and are
changing constantly.  Note that the memory locations are controller specific;
those listed above are done so only to be able to more easily explain the
procedure of using indexed addressing.
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This example can be broken down into four basic steps:

1.  Creating the ‘Temperature’ indexed addressing field,
2.  Creating the ‘Pressure’ indexed addressing field,
3.  Creating the ‘Time’ indexed addressing field, and
4.  Creating the ‘Stage’ numeric field.

These fields are all related in that the values that are displayed within them are
dependent upon the stage of the process.  The indexed fields will be addressed in a
manner so that whenever the field number is written into the ‘Stage’ numeric field
location (DB10 DW9), the corresponding information will be displayed in each of
the indexed fields.  For example, when a value of 2 is written into DB10 DW9,
each of the indexed fields will display the corresponding data: the temperature in
stage 2, the pressure in stage 2, and the amount of time spent in stage 2.

Creating the Temperature Indexed Field

1.  Either select Indexed Addressing Mode from the Edit menu or click on the
appropriate icon in the Extra ToolBelt.

2.  The addressing mode has been set to indexed.  Now create a field on the screen
where the temperature information for the process will be displayed.  This can
be done in the same manner as when creating a numeric field.

3.  This will bring up a define field dialog box.  The top portion of this dialog box
is controller specific.  The address we are using is DB10 DW9 and can be
entered in this area of the dialog box.  Since the values written into this memory
location will be between 1 and 3, we can enter these as the minimum value and
maximum value, respectively.  This field needs to be a read

     only field, because we have the controller set up so that it will write the numeric
value of the current state (either a 1, 2, or 3) into this location.  A screen capture
of this dialog box is shown in Figure 3-9.
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Figure 3-9

4.  Clicking on the Indexed button will bring up a dialog box that allows the user to
specify which memory location’s contents will be displayed when a particular
value is written into DB10 DW9.  For example, whenever a value of 1 gets
written into DB10 DW9, we want the temperature for stage 1 to be displayed.
Likewise for the values 2 and 3.  To specify the address, simply click on the
value you wish to link to an address and click on the Reference

     button.  This will bring up a dialog box (see Figure 3-10) in which you can
specify the address.  Since we want a value of 1 to display the temperature in
state 1 (whose value is located in DB10 DW0), the value of 1 gets referenced to
DB10 DW0.  This is done in a similar fashion with similar reasoning for DB10
DW1 and DB10 DW2.
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Figure 3-10

Creating the Pressure Indexed Field and the Time Indexed Field

1.  Repeat steps 1 through 3 exactly as stated underneath Creating the
Temperature Field.

2.  Repeat step 4 as stated underneath Creating the Temperature Field, with the
following exceptions:

  • When creating the pressure indexed field, the value of 1 should be referenced to
DB10 DW3.  Likewise, the value of 2 should be referenced to DB10 DW4, and
the value of 3 should be referenced to DB10 DW5.  A configured dialog box is
shown in Figure 3-11.
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Figure 3-11

  • When creating the time indexed field, the value of 1 should be referenced to
DB10 DW6.    Likewise, the value of 2 should be referenced to DB10 DW7,
and the value of 3 should be referenced to DB10 DW8.  A configured dialog
box is shown in Figure 3-12

Figure 3-12
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Creating the Stage Numeric Field

1.  Since we want to create a numeric field, we need to turn off the indexed
addressing mode.  This can be done by either selecting Indexed Addressing
Mode from the Edit menu or by clicking on the proper icon in the Extra
ToolBelt.

2.  Now simply create a numeric field and address it to DB10 DW9.  The dialog
box of this is shown in Figure 3-13.  Note that since this field is only going to be
displaying a single digit, the field width has been reduced to 1.

Figure 3-13

Note that if it were desirable for the user to be able to edit the stage of the
process, that numeric field could have been created as a read/write field instead
of a read only field.
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The Finished Project

A dialog box representing what the finished setup may look like is shown in Figure
3-14.

Figure 3-14
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Chapter 4 - The Keyboard Macro Editor

4.1 - Introduction

The Keyboard Macro Editor is a feature in our Designer for WindowsTM software
package that allows the user to associate certain functions with keys or touchcells
on a UniOP panel.  This feature may be accessed by either selecting Keyboard
Macro Editor from the Project menu or clicking on the appropriate icon in the
Extra ToolBelt.  The Keyboard Macro Editor dialog box is shown in Figure 4-1.

Each of the available functions are called elementary macro commands.  They can
be accessed by clicking on the proper icon in the Commands toolbar from within
the Keyboard Macro Editor.  Advanced commands, called complex macro
commands, are composed of two or more elementary macro commands.  For
example, Go to page 2 is an elementary macro command.  Select field 5, Begin
data entry is a complex macro command composed of two elementary commands.
Complex macro commands function by executing each of the elementary macro
commands in the sequence in which they were entered.
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4.2 - Keyboard Macro Editor Dialog Box

Figure 4-1

At the top of the Keyboard Macro Editor dialog box is a scrollable toolbar of panel
keys that are available for programming.  Use the arrow keys located beneath the
toolbar to maneuver through the panel keys.  Note that not all keys are available
on every panel.  A key is selected by single clicking on it with the left mouse
button.  The selected key will be displayed in a lighter color than the other keys.

Below the toolbar of panel keys are the Key states radio buttons. The state can be
selected by simply clicking on the proper radio button.  The user can program a key
to be active whenever it is pressed, released, or held down.  The latter method is
referred to as fast autorepeat and is useful when dramatically changing the value of
a register.  For example, suppose the user has programmed the F1 key to step a
register up by a value of 1.  If the user wants to change the value in the register
from 20 to 200, they would have to press the F1 key 180 times if it were
programmed in the pressed state.  However, by programming the key in the fast
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autorepeat key state, the user can press and hold the key until it reaches the value of
200.

Underneath the Key states radio buttons are the index tabs.  Each index tab
represents an operating mode of the UniOP panel.  The operating mode that is
selected is indicated by the index tab being displayed in the foreground with respect
to the other tabs.  The small circle located in the upper left-hand corner of each
index tab is a program indicator.  If the circle is red, this indicates that a key is
programmed in that particular operating mode.  Similarly, if the circle is yellow,
there are no keys programmed in that particular operating mode.

Located beneath the index tabs is the Commands toolbar.  Each elementary macro
command is represented by an icon in this toolbar.  If there is not enough room to
display all of the icons, left and right arrow keys will be present at the ends of the
toolbar, allowing the user to access all of the elementary macro commands
available for a particular mode of operation.  Once a command is selected, it will be
displayed in the list box at the bottom left side of the dialog box.  Commands can
be inserted, appended, and deleted by using the buttons located to the right of the
list box.

4.3 - Quick Start Example

This example describes the steps necessary to create a simple macro.

1. Place the panel into Configuration Mode.
2. Connect the panel to the personal computer using either a CA1 or a CA2 

cable.
3. Start the Designer for WindowsTM software package.  Make sure that the 

project file is set up to work with the panel you are using.  This can be 
accomplished by selecting Get Panel Resources from the Transfers menu 
and choosing OK.

4. Activate the Keyboard Macro Editor by either selecting the proper icon in 
the Extra ToolBelt or by selecting Keyboard Macro Editor from the Project 
menu.
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5. The Macro Editor dialog box will be displayed.  Click on the key you wish
to assign a macro to and click on Pressed beside of Key states.  Click on the
All Pages index tab.  The macro is now set up to function whenever the  key
is pressed on any page of the project.

6. Click on the leftmost icon in the Commands toolbar.  This icon represents 
the elementary macro command Go to page.

7. Another dialog box will pop up, allowing the user to enter the page number 
that the panel is supposed to go to whenever the key is pressed.  In this 
case, we are going to have the panel go to page 2 whenever the key is 
pressed.  Therefore, enter a 2 in this box and click on OK.

8.  The list box located at the bottom left hand side of the Macro Editor
dialog box will list the defined macro.  Press OK to confirm the command.
This will return the user to the page editor workspace.

9. Type the text ‘Page 1’ in the topmost row of the current page.
10. Press the F7 key to create another page.  Press the Page Down button on  

the keyboard to move to this page.  Type the text ‘Page 2’ in the topmost 
row of this page.

11. Select Download from the Transfers menu.  The project file will be 
downloaded to the panel.

12. When the download is completed, the panel will go into Operation Mode
and display the text ‘Page 1’ that was entered in step 9.

13. Press the key to which the macro was assigned.  The panel will go to the 
second page of the project, indicated by the text ‘Page 2’ appearing on the 
display.

It is suggested to repeat this example using other macros in order to gain familiarity
with the Keyboard Macro Editor and the effects the macros will have on the
functionality of the panel.
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4.4 - Available Operation Modes

The Keyboard Macro Editor has eight different modes of operation.  Not all
elementary macro commands are available in each operating mode.  The
Keyboard Macro Editor will only display those macros that are available for a
particular mode.

The following modes of operation are available for programming:

•  System - this mode is used for the global setup of toggle keys.
•  All Pages - macros defined here will be active on every page of the 

    project file.
•  Page n - macros defined here will be active only when the panel is 

    on page n (where n is an integer).
•  Data Entry - keys programmed in this mode will be active only when 

   the panel is in Data Entry Mode.
•  Alarm - macros defined here will be active only when the panel is 

    in Alarm Mode.
•  Command Menu - macros in this mode will be active only when the panel is 

  in the Panel Command Menu.
•  Event List - keys programmed in this mode will be active only when 

  the panel is in the Event List Mode.
•  Time & Date - macros defined here will be active only when the panel is 

in the Time and Date Mode.

A Note About the Relationship between All Pages Mode and Page n Mode

The relationship between the All Pages mode and Page n mode is particularly
important to understand.  A single key can be programmed in different operating
modes to perform different functions.  A macro programmed in All Pages mode
will be active in all pages of the project.  A macro programmed in Page n mode
will be active only when the panel is on page n (where n is the page number).
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A macro that is programmed in Page n mode will override a macro that is
programmed in All Pages mode only when the panel is on page n.
For example, suppose a user has F1 programmed to go to page 2 in All Pages
mode, while also having it programmed for begin data entry in Page n mode (say,
page 5).  In this case, the only time that the panel will go into Data Entry Mode
when the F1 key is pressed is when the panel is on page 5.  On all other pages of
the project, pressing F1 will take the user to page 2.

4.5 - Available Elementary Macros

The available elementary macro commands for each mode of operation are listed
below.  The name of the macro is identical to the text that is displayed whenever the
user moves the mouse over the icon.

System

••  Set toggle key - The key that is assigned to this elementary macro command will
function like a toggle push-button, changing the value of the bit each time the key is
activated.  The bit may take on values of either 0 or 1.  The user will be asked to
specify the control relay bit which is to be toggled.  Note that a key programmed in
this mode will function as a toggle push-button in all other modes as well.

All Pages

••  Go to page - This command will cause the panel to display a specific page.  The
user will be asked to input the page number.

••  Return to initial page - This will cause the panel to display the page that was 
displayed before the ‘Go to page’ macro command was executed.

••  Password protect -  This command allows the user to require that a password
be entered before executing any macros that follow.  The panel will not prompt the
user to enter the password, rather the user must enter the password by using the
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Password selection in the panel command menu.  If the password is not active, the
panel will simply not execute any macro commands that follow.  A dialog box will
appear, allowing the user to specify which password(s) must be active.  This dialog
box is shown in Figure 4-2.

Figure 4-2

••  Show Alarm List -  This command will switch the panel to Alarm mode and 
display the currently active alarms.  This is designed to be used when a user does
not want the alarm list to appear every time there is an alarm active.  Rather, the
user wants to be able to bring up the alarm list on demand.  This macro will work
only if there are active alarms.

••  Show Event List - This command will display all of the events that are currently
stored in the event list.  This macro will work only if there are events in the list.

••  Printout on/off - This allows the user to print the current page, the alarm list, or
the event list.  This command toggles the printer; therefore if the printer is not
printing, then toggling the key will cause the printer to begin printing.  Likewise, if
the printer is printing, then toggling this command will cause the printer to cease
printing.

••  Print Report - This command allows the user to print any of the reports that
have been configured.

••  Scroll to line - This command allows the user to specify the page row that is to
be considered the topmost row of the display.  Activating this command will scroll
the panel to the ‘new’ topmost row.  This is useful when there are more lines on a
page than there are viewable lines on the panel.  This macro will function only
when there are enough defined lines to make the selected line the topmost line (for
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example, the user can not specify line 30 to be the topmost line, since there are only
32 displayable lines).

••  Select data entry field - This command allows the user to select the field they
wish to edit.  This only selects the field; to edit it the user must begin data entry.
Note that fields are counted from left to right, top to bottom on the panel.
Attributes, time data fields, date data fields and touchcells attached to the
controller are counted as fields.  The user should keep this in mind whenever
selecting the field number.  From Designer version 5.05 and forward, all references
used in this macro will be re-indexed as fields are inserted or deleted.

••  Begin data entry - This command will switch the panel into Data Entry Mode.
The user may now select the field and press ENTER to begin editing the value.

••  Data editing - This command will allow the user to begin editing the value.  This
functions mainly as an ENTER key and should be used in a complex macro
command following begin data entry.

••  Send command - This command allows the user to send ASCII commands to the
controller.  Note that this command is only available with certain PLCs and motion
controllers.  When used with a motion controller, the user will be able to enter the
ASCII string that is to be sent.  When used with a controller, the user will only be
able to select from a given string of commands.

••  Data Entry Popup toggle - This command is used with a touchscreen panel and
will either enable or disable the numeric keypad that appears on the panel once the
user enters Data Entry Mode and presses the ENTER key (or uses the complex
macro command begin data entry and data editing).  The numeric keypad will
appear on the panel by default.  This command is mainly used when a user wishes
to turn this keypad off.

••  Clear Event List - This command will clear all of the entries from the queue of
events.

••  Send Command – This allows the user to send ASCII commands to the
controller.  Note that this command is only available with certain PLCs and motion
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controllers.  When used with a motion controller, the user will be able to enter the
ASCII string they wish to send.  When used with a PLC, the user will be able to
select from a list of commands.

••  Write to Controller - This command allows the user to write constant values to
the controller memory.  The user will be prompted for the specific memory
location, as well as the value to be written.

••  Toggle Relay - Allows the key to behave as a toggle push-button.  The user will
be prompted for the controller bit which is to be toggled.

••  LED state - This allows the user to set the state of any LED that is attached to
the keys on the panel.  The LEDs may take the value of ON, OFF, BLINK, or
DEFAULT.  The DEFAULT state is determined by the value of the corresponding
LED bit in the reserved data area (RDA).

••  Scroll up - This command will scroll the display up one line.

••  Scroll down - This command will scroll the display down one line.

••  Wait - Allows the panel to pause for a specified amount of time before executing
the next macro command.  The time entered for this command is in tenths of a
second.

••  Step - This command allows the user to increase or decrease the numeric value
of a register.  The user may enter the step size, as well as the minimum or
maximum values the register is not to exceed.

••  Display Text - This command allows the user to display a text message on the
panel.  The user will be asked to enter the row and column number at which the
message is to be displayed.

••  Attribute - This allows the user to specify the display attribute of an area on the
page.  Available attributes are reverse, blink, and highlight.  The user will be
prompted for the row, column, width, and height of the area that the attribute is to
affect.
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••  Recipe Control - Allows the user to perform different Recipe functions,
including downloading a particular parameter set, uploading a particular parameter
set, and selecting a particular parameter set.  The user must enter the page number
and the parameter set that is to be affected.  Entering a 0 for either will cause the
current page/parameter set to be chosen.

••  Passwords - This will request the user to enter a password.  If passwords are not
defined in the project, this command will have no effect.

••  Next page - This will cause the panel to display the next page of the project, 
providing the user is not on the last page.

••  Previous page - This will cause the panel to display the previous page of the 
project, providing the user is not on the first page.

••  Brighter display - This command increases the brightness of a vacuum
fluorescent display panel and the contrast of an LCD display panel.

••  Dimmer display - This command decreases the brightness of a vacuum
fluorescent display panel and the contrast of an LCD display panel.

••  Pass-through Mode - This allows the user to enable or disable passthrough
mode.  This is designed so the user can go on-line with the controller without
disconnecting any cables.  This feature is known to work with some controllers
using RS-232.  Later versions of our software will include more protocols and
controllers.

••  Clear Event List - This command will clear all of the entries from the queue of
events.

••  Control Variable Step - This command allows the user to increment or
decrement a control variable field (such as parameter set select or to change the
language).
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••  Go to Recipe Menu – This macro sets the Recipe Page for Selection and jumps
to the specified page.  Please see the section on Recipe Menus in the Recipe chapter
of this manual for further explanation.

••  Scroll Recipe Menu – This macro is used to move the selection in the Recipe
Menu field.  Please see the section on Recipe Menus in the Recipe chapter of this
manual for further explanation.

••  Confirm Recipe Menu Selection – This macro accepts the selected parameter
set name and sets the current recipe parameter set to the new value.  Please see the
section on Recipe Menus in the Recipe chapter of this manual for further
explanation.

Page n

      Each specific page can use the same elementary macros that are available in All
Pages mode.  In this mode, the programmed macro instruction will be active
only in the selected page.

Data Entry

••  Next field - This will position the cursor on the next read/write field.  Fields are
sorted in the direction left to right, top to bottom.  This directionality defines what
is considered to be the ‘next’ field.

••  Previous field - This will position the cursor on the previous read/write field.

••  Field down - This will position the cursor on the next read/write field directly
below the currently selected field.  If the data fields are not aligned vertically, this
command will have no effect.
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••  Field up - This will position the cursor on the next read/write field directly above
the currently selected field.  If the fields are not aligned vertically, this command
has no effect.

••  Step - This allows the user to increase or decrease the numeric value of a
register.  The user may enter a step size, as well as the minimum and maximum
values the register is not to exceed.

••  Confirm - This confirms the entered value and exits Data Entry Mode.

••  Cancel - This cancels the entered value and exits Data Entry Mode.

••  Erase - This will erase the text that has been entered in the data field.

••  Begin data entry - This will switch the panel into Data Entry Mode.  The user
can now select the field and press ENTER to begin editing the value.

••  Data editing - This command will allow the user to begin editing the value.  
This functions mainly as an ENTER key and should be used in a complex macro
command following begin data entry.

••  Write to Controller - This command allows the user to write values to the 
controller memory.  The user will be prompted for the specific memory location, as
well as the value to be written.

••  Toggle Relay - Allows the key to behave as a toggle push-button.  The user will
be prompted for the controller bit which is to be toggled.

••  Wait - Allows the panel to pause for a specified amount of time before executing
the next macro command.  The time entered for this command is in tenths of a
second.

••  Control Variable Step - This command allows the user to increment or
decrement a control variable field (such as parameter set select or to change the
language).
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Display Scroll

This is a feature that is useful in UniOP panels with small displays.  In the Data
Entry Mode, the macro commands Next Field, Previous Field, Field Down and
Field Up, have a new option that allows the panel to scroll the page to reach data
entry fields that may not be visible at the moment data entry is started.  This feature
is useful when multiple data entry macro sequences have been defined.  Firmware
version 4.20 or greater is required to use this feature.

Alarm Mode

••  Write to Controller - This command allows the user to write values to the 
controller memory.  The user will be prompted for the specific memory location, as
well as the value to be written.

••  Toggle Relay - Allows the key to behave as a toggle push-button.  The user will
be prompted for the controller bit which is to be toggled.

••  Wait - Allows the panel to pause for a specified amount of time before executing
the next macro command.  The time entered for this command is in tenths of a
second.

••  Page Mode - This is used to return the panel to current page mode from alarm
mode.

••  Acknowledge alarm - This is used to acknowledge an active alarm.

••  Scroll up - This will shown the next alarm, assuming more than one alarm is 
active.

••  Scroll down - This will show the previous alarm, assuming more than one 
alarm is active.

••  Print alarms - This will print all of the active alarms.
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••  Go to alarm page - If an alarm page has been specified for the currently active
alarm, this macro command will take the user to that specified page.

••  Control Variable Step - This command allows the user to increment or
decrement a control variable field (such as parameter set select or to change the
language).

Command Menu

••  Page Mode - This is used to return the panel to current page mode.

••  Left - Positions the cursor on the next command to the left of the currently
selected command.

••  Right - Positions the cursor on the next command to the right of the currently 
selected command.

••  Up -  Positions the cursor on the command directly above the currently selected
command.

••  Down - Positions the cursor on the command directly below the currently
selected command.

••  Confirm - Used to select the currently highlighted command (this functions as
the ENTER key).

••  Control Variable Step - This command allows the user to increment or
decrement a control variable field (such as parameter set select or to change the
language).
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Event List

••  Clear Event List - This command will clear all of the entries from the queue of
events.

••  Page Mode - This is used to return the panel to current page mode.

••  Scroll up - Used to scroll the event list up.

•  Scroll down - Used to scroll the event list down.

••  Control Variable Step - This command allows the user to increment or
decrement a control variable field (such as parameter set select or to change the
language).

Time/Date

••  Page Mode - This is used to return the panel to current page mode.

••  Next field - Positions the cursor on the next read/write field.  Fields are
considered in the direction from left to right, top to bottom.

••  Increment - Increments the selected field to the next value.

••  Decrement - Decrements the selected field to the next value.

••  Control Variable Step - This command allows the user to increment or
decrement a control variable field (such as parameter set select or to change the
language).
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4.6 - Tips and Techniques

1. Execution of the macro command requires time and processing power that
comes from the panel’s main processor.  While a macro command is being
executed, any type of keystroke on the panel will be queued and executed as
soon as possible.  This may lead to unexpected results if too many keys are
pressed before the macro has time to execute.  An example of a macro that
might take a relatively long time to execute is given below.  This type of macro
should either be avoided or used at times when the panel’s application is not
critical.

Go to page 1
Print page toggle
Wait 50 tenth(s) of a second
Go to page 2
Print page toggle
Wait 50 tenth(s) of a second
Go to page 3
Print page toggle
Wait 50 tenth(s) of a second
Go to page 4
Print page toggle
Wait 50 tenth(s) of a second
Go to page 5
Print page toggle

2.  When using the macro command Attribute, the command will be written to the
specified screen location.  For example, assume a user has a 4 line panel and
has a key programmed to assign an attribute of reverse to the screen location of
row 2, column 1, height of 1, width of 1.  Wherever the user is at on the page,
executing this macro will assign the reverse attribute to the second displayed
row on the panel.
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3.  Do not program the ENTER key.  Doing so may keep the user from being
able to get into Configuration Mode, confirming data entry, etc.

4.  If the user decides to program the 0 numeric key, they may not be able to edit
values on a page where 0 is also used as the INSERT key.

5.  If the user decides to program the arrow keys, they may lose the ability to scroll
between pages and/or numeric fields within the project.

6.  A key can be programmed in both the pressed and released states.

7.  In general, macro commands that switch operating modes are not valid!
Programming a key to function in more than one operating mode within a single
macro command will not work.  For example, the following macro command
goes from Password Mode to Data Entry Mode to Page Mode and will not work
properly.

Enter Password
Begin Data Entry
Confirm Data Entry
Go to Page 7



The Keyboard Macro Editor

4-18

4.7 - Multiple Field Data Entry

UniOP panels with firmware version 4.07G and greater offer the capability of
multiple field Data Entry Mode.  This feature allows the user to edit more than one
field without exiting Data Entry Mode.  This feature cannot be implemented by
using a touchcell; the user must use a physical panel key.

In order to use this feature, the user will need to create a macro key that is
programmed in the following manner:

•  In the Pressed state, the key needs to be programmed in All Pages Mode or Page
n Mode with the macro Begin Data Entry.

•  In the Released state, the key needs to be programmed in Data Entry Mode and
perform the following elementary macro commands in sequence:

1)  Confirm Data Entry
2)  Begin Data Entry
3)  Go to Next Field

    4)  Begin Editing Value
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Example

If you want to have F1 programmed as the key that performs this function, you
would perform the following steps:

1.  Select Keyboard Macro Editor from the Project menu (you can also click on
the Keyboard Macro Editor icon in the Extra ToolBelt).

2.  Click on the F1 icon at the top of the page.

3.  Click on the Pressed radio button beside Key states.

4.  Click on either All Pages or Page n, depending upon if you want this key to
function in all pages or on only one specific page.

5.  Click on the Begin Data Entry icon in the Commands toolbar (this icon shows a
hand pressing a key).

6.  Click on OK.

Figure 4-3 shows the Macro Editor dialog box after these steps have been
completed.
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 Figure 4-3

Now we need to program the key for the Released state:

1.  Enter the Keyboard Macro Editor as previously described.

2.  Click on the F1 icon at the top of the page.

3.  Click on the Released radio button beside Key states.

4.  Click on the Data Entry index tab.

5.  Click on the Confirm Data Entry icon in the Commands toolbar (this icon is a
green check mark).
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6.  Click on the Begin Data Entry icon in the Commands toolbar (this icon shows a
hand pressing a key).

7.  Click on the Go To Next Field icon in the Commands toolbar (this icon has of a
yellow box with a crooked arrow pointing down to a white box).

8.  Click on the Begin Editing Value icon in the Commands toolbar (this icon is a
small box with the numbers 1, 2, and 3 below it).

9.  Click on OK.

Figure 4-4 depicts the Macro Editor dialog box following the completion of these
eight steps.

Figure 4-4
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Using the Macro to Edit Multiple Fields

To use the macro that was just created, simply press the F1 key.  A read/write data
field will be selected, allowing you to enter the value for that field.  Pressing F1
again will confirm your data entry and advance you to the next read/write field on
the page.  Repeat this process until all of the fields have been edited.  Pressing the
ENTER key will return the panel to normal operation.
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Chapter 5 - Passwords

5.1 – Defining Passwords

UniOP panels have eight different levels of passwords, enabling supervisors to
restrict the amount of control an operator has over the functionality of the panel.
A dialog box representing these levels is shown below in Figure 5-1.

Figure 5-1

The person having the highest level password has access to all of the panel 
functions.  This is done by default so as to allow at least one person the ability 
to change the project file contained within the panel.
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All UniOP panels provide password protection for the following:

CONF - Access to the Configuration Mode.  In this mode, the user 
  may choose to alter the project file and re-download it 

  from the PC.
TIME - Access to the Time & Date Mode.  In this mode, the user 

  may change the time and date information that is stored 
  within the panel.

PAGE - Access to Direct Page Selection Mode.  In this mode, the 
  user can access specific pages of the project.

ACK - The ability to acknowledge alarms.
PRINT - The ability to request printouts.
ALOGI - Automatic login.  This is used to automatically load a 

        specified password whenever there is no valid password
in the system (e.g., when the panel goes from
Configuration Mode to Operation Mode, or when an
incorrect password is entered.  This option can only be
assigned to one password and will work only if there are
no other valid passwords in the system..

ALOGO - Automatic logoff.  This is used to automatically disable a 
  specified password ten minutes after it has been entered.  

       This time is currently a fixed value and is not changeable.
Data entry enable - Access to Data Entry Mode for specific pages.  In this 

  mode, the user will be able to edit any read/write fields 
  contained within the specified pages.

If a checkbox is selected, the user will have access to the respective area providing
the correct password is entered.  If an incorrect password is entered, asterisks will
be displayed on the panel and the previous valid password is lost.
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Example

Assume there are three users who will have access to the operator panel.  User 1
is to have access to all areas of the project.  User 2 is only allowed to
acknowledge alarms and enter data on pages 2, 3, and 4.  User 3 is capable of
entering data throughout the project and is allowed into Configuration Mode.  It
is also desired to have User 3 automatically logged out of the system after 10
minutes.

1.  Select Passwords from the Project menu.  This will bring up a dialog box
similar to the one shown in Figure 5-1 in which we will configure our passwords
for the project.

2.  Since User 1 is to be allowed full access to all areas of the panel, we can assign
the highest level password to him.  Simply click in the top password box and
enter the password for User 1.

3.  User 2 is allowed to acknowledge alarms and enter data on pages 2, 3, and 4.
Click on the second password box and enter the password for User 2.  To allow
access to acknowledge alarms, click on the ACK box.  Doing so should place a
check mark in the box.  Allowing data entry from page 2 to page 4 can be
accomplished by entering a 2 in the Data entry enable From page box and
entering a 4 in the Data entry enable To page box.

4.  User 3 can enter data on all pages of the project, will be automatically logged
out after ten minutes, and can access Configuration Mode.  Click on the third
password box and enter the password for User 3.  By selecting the CONF box,
we can give User 3 access to Configuration Mode.  Similarly, by selecting the
ALOGO box, User 3 will be logged out after ten minutes.  Because data entry is
possible throughout the entire project, no modifications need to be made to the
Data entry enable boxes.

5.  The passwords should now be configured correctly for this situation.  The
dialog box resembling this situation is shown in Figure 5-2.
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Figure 5-2

5.2 - Changing Passwords from the Panel
In previous versions of Designer, if you wanted to change a password, it was
necessary to go into the Designer software, change the desired password, and then
re-download the project file to the panel.  This feature allows you to change any of
the seven possible user passwords defined in the project file directly from the panel.
In order to use this feature, there must be at least two passwords defined, with one
of them setup to be automatically logged in (see Figure 5-3).  This means that
whenever the panel goes from Configuration Mode to Operation Mode, the
specified password is logged in.

In order to use this feature, your panel must be equipped with firmware version
4.10 or later.
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Figure 5-3

Once you have the passwords defined in the project file, you will need to make an
ASCII control variable field for each password that you want to be able to change.
To make a control variable field, you need to perform two steps:

•  Select the Control Variable icon in the Extra Toolbelt.  The Control Variable
icon is the third from the left in the Extra Toolbelt.

•  Create a control variable field.  You can do this in the same way that you create
a numeric field (you can either double click the left mouse button, position the
cursor where you want the field to begin and select the Numeric Field icon in the
Toolbelt or select Edit – Data Field Type – Numeric/ASCII).  Make sure that you
change the display format to ASCII.  Once you do this, you will be able to select
which password (two through eight) you want to create the field for.

For example, suppose that you want to be able to change passwords 2, 3 and 4
(which are 4321, 6574 and 9809, respectively) from the panel.  Once you have
clicked on the Control Variable icon and created the field, you should see the
dialog box shown in Figure 5-4.  Again, make sure that you change the display
format to ASCII!
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Figure 5-4

Since you are going to be changing the value of this field (the actual password),
select Read/Write within the Data Access box.  As you can see, this control
variable is addressed for password 2.  Whenever you click on the OK button, you
will see CCCC on your panel, indicating that you have created a control variable
field.

If you follow the same procedure for creating control variable fields for passwords
3 and 4, your screen may look something like Figure 5-5 when you are finished.
These control variable fields can be edited in the same manner as numeric fields.
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Figure 5-5
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Chapter 6 - Alarms

6.1 - Enhanced Mode Alarms

Enhanced Mode alarms offer the user a maximum of 1024 alarms, which are
broken into 4 blocks (there are some models which offer 256 total alarms in 4
blocks).  The lower the numerical value assigned to the alarm, the higher it’s
priority.  Each block can be addressed to any register within the controller’s
memory.  Each alarm is referenced to a bit in the controller.  Whenever a bit goes
high, the respective alarm message will be displayed.  The features contained within
Enhanced Mode alarms and their functionality are given below.  Following these
descriptions are two examples of using Enhanced Mode alarms.

It is strongly suggested to use Enhanced Mode alarms.  Compatibility Mode
alarms are included in the software only to provide compatibility with older
project files.  Future releases of the panel’s firmware may not support
Compatibility Mode alarms.

If the user wishes to use Enhanced Mode alarms and the RDA, they must first
disable the Alarms area of the RDA.

Select Alarms from the Project menu.  This will bring up the Alarms dialog box
shown in Figure 6-1 (unless the RDA is enabled, in which case the user will be
presented with a dialog box in which they can choose between Compatibility Mode
alarms and Enhanced Mode alarms).
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Figure 6-1

The Block # field allows the user to choose either block 1, 2, 3, or 4.

The # of Alarms field is used to specify how many alarms will be used in a
particular block.  The software will automatically round off the specified number to
a multiple of 16 because the alarms are addressed as words of information.

The Update cycle field allows the user to specify how often the alarms are updated.

The Block start address field allows the user to specify the starting address of the
current block.  Clicking on the Address Reference button will bring up a detailed
dialog box for addressing.  If the panel is accessing multiple controllers, the user
will also have to specify the controller slave ID numbers within this dialog box.
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Clicking on the Advanced button will present the user with a dialog box in which
they can choose how they want the alarm popup window to appear once an alarm
occurs.  This dialog box is shown below in Figure 6-2.

Figure 6-2

Default - Alarms are displayed immediately if no keys are pressed and no keys
have been pressed within the last three seconds.

Disable Alarm Popup - The alarm popup window will not be displayed.

Show Immediately On Any Alarm - The alarm popup window will be displayed
as soon as an alarm occurs.

Set Delay After Last Keystroke - The user can have the alarm popup window
appear at a specified amount of time after the last keystroke or touchcell press
(between 1 second and 127 seconds).

Disable Time and Date Display – This option allows the user to disable the tie
and date display in the UniOP alarm page.  This feature is interesting in all
cases where the time and date information is not of interest to the user.  This
feature requires firmware version 4.20 or greater.

The alarm messages can be scrolled through by using the scroll arrows located to
the right of the alarm message list box.  To create or edit a message, either click on
the desired value or use the Alarm # field to select the value and then enter the
message. Special characters may be added to the message by clicking on the
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Special Chars button.  This will bring up a dialog box (shown in Figure 3-4) in
which the user can select the character(s) to be used by double clicking on them or
by single clicking on them and pressing Select.  After confirming the operation, the
characters will appear in the last position the cursor was in before entering the
special characters dialog box.

The On alarm go to page field can be used to make the panel jump to a specified
page whenever the alarm is activated.  The user will need to program a key in
Alarm Mode in the Keyboard Macro Editor using the following elementary macro
commands in sequence: Acknowledge Alarm (if required), Go to Alarm Page, Page
Mode.  Whenever the alarm occurs, the panel will switch to the alarm screen.  The
user can implement the arrow keys to select the proper alarm and press the key that
was programmed in the Keyboard Macro Editor to take them to the correct page.

The Alarm requires acknowledgment field can be selected if it is desired to have
the operator press a key to acknowledge that the alarm is active.  Once the alarm is
activated, the panel will enter Alarm Mode and display the currently active alarms.
The operator must acknowledge the alarm by pressing the ENTER key for a few
seconds.  Pressing the CLEAR key will return the user to Operation Mode.  Note,
however, that it is still necessary to reset the proper alarm bit.

By selecting Print alarm ON, Print alarm OFF, or Print time of acknowledgment,
the user can have the specific alarm data printed via a serial printer.

The checkbox Enable log to event list will allow the user to send the selected alarm
to the historical event list.  If it is not desired to send the alarm to the event list, the
user can simply unmark this box.

The checkbox Message Only allows the alarm message to be treated strictly as a
message and not a true alarm.  If this checkbox is marked for a specific message,
the Alarm LED on the panel will remain off for the specific event and the first row
of the message will NOT contain the familiar ‘A’, as is the standard for an alarm
message.  It is possible to require that these messages be acknowledged, just as a
standard alarm message.  These messages can also be logged to the Event List if
the Enable log to event list checkbox is marked.  This feature requires firmware
version 4.22 or greater.
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The familiar WindowsTM features cut, copy, and paste are also available for use in
editing messages.  If you have several alarm messages that are similar, you can use
the Copy alarm text and Paste alarm text features to copy messages and then make
any necessary changes.

Simply select which messages to copy by highlighting them.  If you want to copy
several messages that are in successive order, click on the first one and drag the
mouse down until the last one is highlighted and release the mouse button.  If you
have several messages to copy that are not in successive order, hold down the Ctrl
key,  click on each of the messages that you want to copy, and release the Ctrl key.
All of these methods will select the text to be copied.

Now, click on the Copy icon to copy the messages into Windows’ Clipboard.
Highlight the alarm message number where you want to paste the first message and
click on Paste alarm text to copy the messages into their new locations.  You can
also use a Windows based text editor, such as Notepad, to create a list of
messages.  To do this, place each message on a separate line.  Use the Copy
function of the editor to copy the text to the Clipboard and then use the Paste alarm
text feature to copy the messages into their new locations.

Example 1

Assume a user is using a Siemens Simatic TI 435.  They want to use alarms that
begin at V7377 (a word) for their particular controller.  Their alarm messages
and their respective locations in the controller are as follows:

Alarm Location in the Controller Alarm Message
V7377 - Bit 0 Pressure too high
V7377 - Bit 1 Temperature too high
V7377 - Bit 2 Pressure too low
V7378 - Bit 1 Temperature too low

Keep in mind that each alarm message is referenced to a BIT in the controller.
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1.  Once the user has Designer set up for their particular panel and controller, the
Enhanced Mode Alarms can be accessed by choosing Alarms from the Project
menu.  The Alarms dialog box will appear, allowing the user to specify the
starting address for the alarms.  In this example, the alarms begin at memory
location V7377.

2.  The alarm list box is located beneath the Current alarm block options box.  This
list box is where the alarm messages are entered.  Each numeric value
corresponds to a bit.  For example, since the alarms begin at V7377, the
numeric value 1 in this list box corresponds to the address V7377 - bit 0.  The
numeric value 2 in this list box corresponds to the address V7377 - bit 1, and so
on.  In a similar nature, the numeric value 17 corresponds to V7378 - bit 0
(since these are word locations and there are 16 bits in a word).

3.  The numeric values in the list box and their corresponding alarm messages
would be as follows:

1: Pressure too high
2: Temperature too high
3: Pressure too low

   18: Temperature too low
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Example 2

Assume a user wants the panel to go to page 3 whenever alarm 1 is active.
Assume that the alarm requires acknowledgment.

1.  Select Alarms from the Project menu.

2.  Make sure that all of the alarm data is entered correctly, as far as the alarm
message and the beginning address of the alarm block.

3.  Enter a 1 in the Alarm # field.  Following this, enter a 3 in the On alarm go to
page field and click on OK.

4.  Select Keyboard Macro Editor from the Project menu.  Assume that the F1 key
is to perform the function of acknowledging the alarm and going to page 3.  The
dialog box shown in Figure 6-3 is a representation of how this key should be
configured.
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Figure 6-3

5. Keep in mind that the alarm bit must still be reset.  This may be done by
including the macro command ‘Write to Controller’ to the above complex
macro and clearing the proper alarm bit.

6.2 - Compatibility Mode Alarms

The UniOP offers the storage and automatic display of up to 256 alarm messages
in Compatibility mode.  Priority levels (0 - 255) can be assigned to handle
simultaneous alarms.  Alarm importance decreases as the priority level increases.
Therefore, the most important alarms should be given the lowest possible numerical
value.  Alarms are each assigned an individual bit in the Alarm Update Area of the
RDA.  Alarms are triggered by a high bit from the controller.

It is strongly suggested to use Enhanced Mode alarms.  As was mentioned
previously, Compatibility Mode alarms are provided solely for
compatibility reasons with older projects.  Future releases of the panel’s
firmware may not support Compatibility Mode alarms.

Select RDA Setup from the Project menu, and select the Enabled checkbox
in the area marked Alarms.

Select Alarms from the Project menu.  This will bring up a dialog box in which
the user can select between enhanced mode and compatibility mode alarms.
Select Compatibility Mode and click on OK.

The Compatibility Mode alarm dialog box (shown in Figure 6-5) will appear,
allowing the user to enter their alarm messages. Special characters may be added
to the message by clicking on the Special chars button.  This will bring up a dialog
box (shown in Figure 3-4) in which the user can select the character(s) to be
used by double clicking on them or by single clicking on them and pressing Select.
After confirming the operation, the characters will appear in the last position the
cursor was in before entering the special characters dialog box.
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Figure 6-5

As was mentioned earlier, each alarm is triggered by a bit in the RDA.  A
mapping of the Alarm Update Area of the RDA is shown below in Figure 6-6.

bit

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1

bit

0

ALARM
UPDATE AREA 21 A16 A15 A14 A13 A12 A11 A10 A9 A8 A7 A6 A5 A4 A3 A2 A1

22 A32 A31 A30 A29 A28 A27 A26 A25 A24 A23 A22 A21 A20 A19 A18 A17

---------- (break) ---------

35 A240 A239 A238 A237 A236 A235 A234 A233 A232 A231 A230 A229 A228 A227 A226 A225

36 A256 A255 A254 A253 A252 A251 A250 A249 A248 A247 A246 A245 A244 A243 A242 A241

Figure 6-6

By selecting Time of ACK, Time of alarm (ON), or Time of reset (ACK), the user
can have the specific alarm data written into the Event list or printed via a serial
printer.
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The Alarm requires acknowledgment field can be selected if it is desired to have
the operator press a key to acknowledge that the alarm is active.  Once the alarm
is activated, the panel will enter alarm mode and display the currently active
alarms.  The operator must acknowledge the alarm by pressing the ENTER key
for a few seconds.  Pressing the CLEAR key will return the user to Operation
Mode.  Note, however, that it is still necessary to reset the proper alarm bit.

6.3 - Long Alarm Strings in 20 Character Displays

Beginning with Designer 5.06 and firmware version 4.22, the user will be able to
define an alarm message up to 40 characters in length for all UniOP operator
interfaces that have a 20 character display.

In these cases, the complete message associated with an alarm will take up 3 lines
on the display.  The first line will be for time and date indication, the second and
third lines will be for the alarm message itself.
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Chapter 7 - The Reserved Data Area (RDA)

Each UniOP panel may use up to four small reserved areas of controller memory to
establish an interface with the controller.  Each of these four areas are described on
the following pages.  The user can select the starting address of each of these areas
by selecting RDA Setup from the Project menu.

It is not necessary to have a full working knowledge of the reserved data areas to
complete a project.  It is entirely possible to toggle bits in the controller, display
messages and controller data, edit read/write fields, etc. without having any areas
of the RDA enabled.  For this reason, the RDA is disabled by default.  This also
helps to optimize communication between the panel and the controller.  There are,
however, several functions that are only available through the RDA.

Figure 7-1 shows the flow of communication for each of the reserved data areas,
while Figure 7-2 shows a memory map of the entire reserved data area.

Figure 7-1
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bit

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1

bit

0

KEYBOARD
UPDATE AREA 0 F16 F15 F14 F13 F12 F11 F10 F9 F8 F7 F6 F5E F4D F3C F2B F1A

1 F32 F31 F30 F29 F28 F27 F26 F25 F24 F23 F22 F21 F20 F19 F18 F17

2 7 6 5 4 3 2 1 0 K4 K3 K2 K1 up dwn right left

3 K16 K15 K14 K13 K12 K11 K10 K9 K8 K7 K6 K5 +/- . 9 8

PANEL
STATUS AREA 4 Reserved Byte Day of the week

RTC 5 Day Month

RTC 6 Year Hour

RTC 7 Minute Second
Panel Status

Word 8 S15 S14 S13 S8 S7 S6 S5 S4 S3 S2 S1 S0

9 CP (Current page)

10 Reserved Word

11 Reserved Word

12 Reserved Word

13 Reserved Word

CONTROLLER
UPDATE AREA 14 PR (Page request)

LED Control 15 L16 L15 L14 L13 L12 L11 L10 L9 L8 L7 L6 L5 L4 L3 L2 L1

LED Control 16 L32 L31 L30 L29 L28 L27 L26 L25 L24 L23 L22 L21 L20 L19 L18 L17
Controller

Control Word 17 C15 C14 C13 C12 C11 C10 C9 C8 C7 C6 C5 C4 C3 C2 C1 C0

18 Reserved Word

19 Reserved Word

20 Reserved Word

ALARM
UPDATE AREA 21 A16 A15 A14 A13 A12 A11 A10 A9 A8 A7 A6 A5 A4 A3 A2 A1

22 A32 A31 A30 A29 A28 A27 A26 A25 A24 A23 A22 A21 A20 A19 A18 A17

---------- (break) ---------

35 A240 A239 A238 A237 A236 A235 A234 A233 A232 A231 A230 A229 A228 A227 A226 A225

36 A256 A255 A254 A253 A252 A251 A250 A249 A248 A247 A246 A245 A244 A243 A242 A241

Figure 7-2
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7.1 - The Keyboard Update Area

This reserved area is formatted to contain flags for each key on the panel and
extended keyboard.  These flags are set HIGH when a key is pressed and set LOW
when released.  Each key status flag occupies one bit in the controller memory.
These bits can be used by the controller to detect when a particular key has been
pressed and then in turn perform a specific operation.  It is recommended to use the
Keyboard Macro Editor to program keys.  This method is easier and more efficient
than programming a key using ladder logic.

Note:   In the Keyboard Update Area of the RDA, the ENTER key is mapped to 
 K1, the CLEAR key is mapped to K16, and the HELP key is mapped to 
 K15.

7.2 - The Panel Status Area

This reserved area is formatted to contain time and date information from the
panel’s real time clock, a two-byte panel status word, and a current page register.

7.2.1 - The Real Time Clock

The real time clock contains the time and date information.  Depending upon the
type of controller that is being used, this information will be stored in either binary
or BCD.  A listing of various PLCs and how the RTC is stored can be found in the
back of the Installation & Operation Guide that came with the panel.

7.2.2 - The Panel Status Word

The panel sets and resets bits S0-S8 and S13-S15 in the Panel Status Word to
indicate its current status.  Your application logic can monitor these bits to
determine how and when it should interact with the panel.  Table 7-1 shows a brief
description of each status bit.
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Bit # Function

S0 Link status monitor flag

S1 Data entry active

S2 Printing in progress

S3 Printer status

S4 Date and time update in progress

S5 Attempt to access protected function

S6 Battery low

S7 Alarm active

S8 Unacknowledged alarm active

S13 Recipe upload in progress

S14 Recipe download in progress

S15 Recipe file status

Table 7-1

S0 - Link Status Monitor Flag

Bit S0 in the Panel Status Word can be used by the controller to monitor the
communication status between the panel and the controller.  The value of this bit is
changed by the panel with a cycle time of approximately one second.  If a transition
is not detected within 1 second, the controller should consider that the panel is
either not connected or not operating properly.

If the cycle time of the controller program is longer than one second or if there are
numerous communication errors, one transition of the Link Status flag can go

undetected.
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S1 - Data entry active

Bit S1 is set whenever the panel is in Data Entry Mode.

S2 - Printing in progress

Bit S2 is set whenever the panel is in the course of sending data to the printer.

S3 - Printer status

Bit S3 contains the current logic state of the CTS (clear to send) line.  This line is
being driven by the printer and indicates the printer’s readiness to accept data.

S4 - Date and Time Update in progress

Bit S4 in the Panel Status Word is used to synchronize access to the panel’s real
time clock (RTC).  Before writing a new time and date record, the panel sets bit S4
in the Panel Status Word to indicate that it is about to update this data.  The panel
then writes the time and date information to the Reserved Data Area and resets bit
S4.  The controller program should always check the update flag before reading the
time and date record.  If the bit is set, the controller should not use the time and
date information.  Note that this bit is not set when the panel updates only the
seconds field.

S5 - Attempt to access protected function

Bit S5 is set when the user tries to access a function that is not accessible with the
current password.  Since in this case no message is displayed by the panel itself, the
controller can be used to check this status bit and notify the user that the function
they are trying to access is protected.

S6 - Battery Low

Bit S6 is set when the backup batteries become weak.  These batteries maintain
Recipe data as well as time and date information, which is stored in RAM.



The Reserved Data Area

7-6

S7 - Alarm Active

Bit S7 is set when at least one alarm is active.  Bit S7 is reset when all alarm bits
are reset to zero.

S8 - Unacknowledged Alarm Active.

Bit S8 is set whenever there is at least one active alarm that requires
acknowledgment.  It is reset when all alarms have been acknowledged.

Enabling the "Operator ACK Required" attribute when creating alarm
messages guarantees that bit S8 will remain set until the alarm is
acknowledged.  It does not guarantee that the bit associated with the alarm in
the RDA will remain set.  Those alarm bits are controlled by your application
logic, not the panel.

S13 - Recipe Upload in Progress

Bit S13 is set whenever a Recipe is being uploaded from the controller into the
panel.  It is reset whenever the upload process is complete.

S14 - Recipe Download in Progress

Bit S14 is set whenever a Recipe is being downloaded from the panel into the
controller.  It is reset whenever the download process is complete.

S15 - Recipe File Status

Bit S15 displays the Recipe file status.  A 0 indicates that the Recipes contain valid
data.  A 1 indicates that the Recipe data is corrupt or still contains the default
values defined in the project file.
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7.2.3 - Current  Page (CP) Register

The panel writes the number of the currently displayed page into the CP register
whenever the panel is in Page mode or Data Entry Mode.  In all other modes, a zero
is written into this register, indicating that page data is not currently being
displayed.

Page numbers are stored in either binary or BCD format, depending on the controller
being used.  A list of these can be found in the UniOP Installation & Operation Guide.

7.3 - The Controller Update Area

The Controller Update Area allows the controller to access and control certain
aspects of the panel.  All front panel LED’s can be controlled from this area to
provide feedback to the operator.  The controller may also request a specific page
to be displayed by writing the appropriate value into the Page Request register.
The controller control word allows the controller to request the printing of a page,
disable data entry, select an alarm mode, or enable the mailbox function.

All panels include a standard set of dedicated indicators that allow the user to
monitor the status of the panel.  Along with these dedicated indicators, certain
models include a subset of user defined LED’s that can be monitored and controlled
by your application logic.  The control of these LED’s is carried out through the
Controller Update Area.  Each of the registers found there can be copied to bit
address contacts so that the status bits can be referenced as control relays.
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7.3.1 - Page Request (PR) Register

The page to be displayed can be selected either by the operator from the front panel
keypad or by the controller itself.  The controller selects the page to be displayed by
writing the corresponding page number into the PR register in the Controller
Update Area.  Note that once the panel has changed to the corresponding page, the
user needs to write a 0 back into the PR register in order to return control back to
the keys on the panel.  If this is not done, the user will be ‘stuck’ on that page.
When the panel detects a page request from the controller, it checks the front panel
keyboard and the Expanded Keyboard (if present).  If no key has been pressed for
the last three seconds, the page selected by the controller is displayed.

While a controller page request is active (PR not 0), the operator will not be able to
change pages using the arrow keys.

Page numbers are stored in either binary or BCD format, depending on the controller
being used.  To determine which format your controller uses, refer to the UniOP
Installation & Operation Guide.

7.3.2 - LED Control Bits

Bits L1 through L32 control the LED indicators that can be found on various panel
models.  The mappings of these bits are shown below.  Note that the LEDs can be
controlled via the Keyboard Macro Editor (see Chapter 4).

Table 7-2 shows how these LED’s are mapped.  For example, the F1 key is
mapped to L1 and the 0 numeric key is mapped to L17.  All of the panels except
those that have the eight user LEDs are mapped according to this.
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LED KEY
L1 F1
L2 F2
L3 F3
L4 F4
L5 F5
L6 F6
L7 F7
L8 F8
L9 F9

L10 F10
L11 F11
L12 F12
L13 F13
L14 F14
L15 F15
L16 F16
L17 0
L18 1
L19 2
L20 3
L21 4
L22 5
L23 6
L24 7
L25 8
L26 9
L27 .
L28 +/-

Table 7-2
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The mapping in Table 7-3 represents the panels that have the eight user LEDs.
These panels include: MKDF-02, MKDF-04, MKDR-02, MKDR-04, MKDL-16,
MKDR-16, and MKDR-16T.  For example, the F8 key is mapped to L8 and the
number 5 user LED is mapped to L30.

LED KEY
L1 F1
L2 F2
L3 F3
L4 F4
L5 F5
L6 F6
L7 F7
L8 F8
L9 F9

L10 F10
L11 F11
L12 F12
L13 F13
L14 F14
L15 F15
L16 F16
L25 USER LED 0
L26 USER LED 1
L27 USER LED 2
L28 USER LED 3
L29 USER LED 4
L30 USER LED 5
L31 USER LED 6
L32 USED LED 7

Table 7-3
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7.3.3 - Controller Control Word

The bits of the Controller Control Word are set and reset by the controller
according to the application logic.  The panel responds to these bits as shown in the
following table.

Bit # Function
C0 Print Screen
C1 Disable data entry
C2 Select alarm mode

C15 Enable Mailbox

Table 7-4

C0 - Print Screen

When bit C0 in the Controller Control Word is set, the panel sends the currently
displayed page to the printer.  The bit must be reset to 0 before another print
request can be processed.

If the current password enables the user to request printouts, the currently displayed
page can be printed directly from the front panel by pressing the "Prt Scr" or "9 /

PRT" keys (depending on the panel model).

C1 - Disable Data Entry

When bit C1 in the Controller Control Word is set, the operator cannot enter the
Data Entry Mode on the panel, even if the password otherwise enables them to do
so.  In this way, the controller can temporarily or permanently inhibit modification
of variable values in a way defined by its program.

C2 - Select Alarm Mode

When C2 is set, the display will NOT switch to Alarm mode automatically.
Instead, the operator will have to select ALARM from the Panel Command menu
with the proper keyboard actions.  Once inside the ALARM menu, the user will be
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able to view and acknowledge any active alarms (If there are no pending alarms,
the user will not be able to enter the ALARM menu).  When the bit is reset to zero,
the display will automatically switch to Alarm mode when at least one alarm is
active.

Bit C2 only disables the automatic display of the alarm screen. Any alarm attributes
that were set during project development remain active.

C15 - Enable Mailbox

Setting bit C15 enables the panel to cyclically read the data in the Mailbox.  Note
that the Mailbox must be configured prior to setting this bit (see Chapter 8).  When
this bit is not set, the panel will not read the data in the Mailbox, thus reducing
communication time and increasing system performance.

7.4 - Alarm Update Area

This area of the RDA is used in conjunction with Compatibility Mode alarms.  This
area controls the display of up to 256 alarm messages.  Each alarm is assigned one
bit in the Alarm Update Area.  To inform the panel that an alarm has occurred, the
controller application logic must set the corresponding bit.  When an alarm has
been set, the display switches to Alarm Mode and displays the corresponding alarm
message.  All alarms are archived in a circular buffer called the Event List.  This
historical data can be viewed or printed via the Event Mode.

While it is possible to use this area of the RDA with alarms, it is strongly
recommended to use Enhanced Mode alarms instead.  Doing so will result in added
flexibility in structuring the alarms, as well as having a greater number of alarms to
work with.



Exor Electronic R&D                                                              8-1

Chapter 8 - The Interlock Mailbox

The UniOP Interlock Mailbox is a facility designed to allow the operator interface
panel to interact with the controller’s ladder logic program.  The Mailbox is simply
a group of registers in the controller memory (from a minimum of 2 registers to a
maximum of 20).  The Mailbox can be placed anywhere in the controller memory
at an address selected by the user.  When the Mailbox is enabled, the operator panel
cyclically reads the contents of the Mailbox from the controller.  The controller can
command the UniOP panel to perform certain tasks by placing data in the memory
area used by the Mailbox.  When the panel detects that the controller has written
data in the Mailbox, it interprets the data as a numeric code for a required
command.  If the panel recognizes the command, it immediately executes it.  If the
command requires a response from the panel, then the panel places the response
back into the Mailbox itself.

8.1 - Definition of the Mailbox

To enable the Mailbox, select Interlock Mailbox from the Project menu.  The
dialog box shown in Figure 8-1 will then be displayed.

Figure 8-1
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The Mailbox is disabled by default.  To enable it, simply mark the checkbox
entitled Enable within the dialog box.  The two radio buttons allow the user to read
the Mailbox in two different modes:

• Read in cycles
• Read in cycles if CCW (Controller Control Word) flag is set

In the latter case, the panel will cyclically read the data in the Mailbox only when
bit C15 in the Controller Control Word of the Reserved Data Area is set.  The
purpose of this mode is to reduce the overhead of the communication time when
there is no need for the controller to send commands to the panel.

The Read Cycle time specifies how frequently the operator panel will read the data
in the Mailbox to check to see if it contains a new command.  The faster the
Mailbox Read cycle, the faster the panel will respond to commands from the
controller.  However, the update of the variables shown on the display will be
slower.

The Interlock reference is the address of the first Mailbox register in the controller
memory.  The address can be entered directly as a string or with a fill-in-the-blank
dialog box displayed by clicking on the Reference button.  When entering the
starting address, care must be taken to ensure that the controller memory used by
the Mailbox does not overlap with the memory areas reserved for other panel
functions such as alarms, I/O update, keyboard update, etc.
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8.2 - Structure of the Mailbox

The controller can issue different commands depending upon the values written to
the Mailbox.  Some commands require parameters (which have a binary numeric
format) to be included with the command, while other commands require the panel
to respond with data.  The structure of the Mailbox in the controller memory is
shown below in Table 8-1.  The Status Word and the Command/Response Word
are always required for the Mailbox. Parameter 0 - Parameter 17 Words are only
used if required by the particular Mailbox command.

Offset
0 Status Word
1 Command/Response Word
2 Parameter 0
3 Parameter 1
...
19 Parameter 17

Table 8-1

The user can determine the controller memory addresses of all the data elements in
the Mailbox by using the starting address of the Mailbox area (set in the Designer
software) and the memory map shown in Table 8-1.
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Status Word

The Status Word is the main handshaking register of the Mailbox.  Both the
controller and the panel can write to this register.  The status word contains a
binary number, the meaning of which is described in Table 8-2.

Code Status Written by
0 No request, Mailbox is available Controller
1 Pending request Controller
2 Mailbox busy Panel
3 Error code:  Illegal command Panel
4 Command completed Panel
5 Panel restart Panel

Table 8-2

Command/Response Word

The controller specifies which Mailbox command it wants to execute by placing the
command code of the desired command in the Command/Response Word.  The
available Mailbox commands and their command codes are given in Table 8-3.
The UniOP panel writes a binary value to the Command/Response Word when it
has executed the command requested by the controller to indicate the result of the
operation.

Parameters

The Parameter Words are used only when required by a specific command. Some
commands do not require any parameters at all. The following section describes
how to use and what Parameter Words are required for each Command Word.
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8.3 - Available Mailbox Commands

The Mailbox commands are listed in Table 8-3.  The command codes must be
written by the controller into the Command/Response Word register.

Command Description
1 Recipe Status
2 Start Recipe Download
3 Start Recipe Upload
4 Set Parameter Set Number
5 Get Parameter Set Number
6 Get Recipe Transfer Priority
7 Set Recipe Transfer Priority

17 Request Data Entry Mode
33 Password Status
49 Start Controller to Controller Transfer With No Confirmation
50 Start Controller to Controller Transfer With Confirmation
81 Set RTC
97 Clear Event List
113 Start Report Printout
114 Stop Report Printout
129 Get Current Language
130 Set Current Language
145 Start Screen Saver
146 Stop Screen Saver
147 Enable Screen Saver in Alarm Mode
148 Disable Screen Saver in Alarm Mode

Table 8-3
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Recipe Status

The controller can use this command to request information on the status of the
Recipes in the panel.

Command code: 1

No parameters are required by this command. The panel will respond with a code in
the Command/Response Word.  The possible codes are listed in Table 8-4.

Code Description
0 OK, Recipes contain valid data
1 Error:  Recipes contain default data as defined in the project file
2 Error:  There are no Recipes defined
3 Error:  Error in project file

Table 8-4

Start Recipe Download

The controller can use this command to start a Recipe download from the panel
memory to the controller memory.

Command code: 2

Two parameters are required by this command:

Parameter 0 Page Number of required Recipe
                                    (1 - max. page number in project file)

Parameter 1 Parameter set number
                                    (1 - max. number of pre-defined parameter sets)
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The panel will respond back to the Command/Response Word with one of the codes
listed in Table 8-5 after performing the operation.  Note that a Recipe transfer may
take several seconds, depending mainly on the number of bytes that have to be
transferred.

Code Description
0 OK, Transfer completed successfully
1 Error:  Recipes contain default data
2 Error:  There are no Recipes defined
3 Error:  Error in project file
4 Error:  Illegal Page number has been requested
5 Error:  Illegal number of parameter set has been requested
6 Error:  The requested parameter set is locked (that is, it is being

            used by the operator panel for a data entry operation)
7 Error:  A communication error occurred during the transfer

Table 8-5

Start Recipe Upload

The controller can use this command to start a Recipe upload from the controller
memory to the panel memory.

Command code: 3

Two parameters are required by this command:

Parameter 0 Page Number of  required Recipe
                                    (1 - max. page number in project file)

Parameter 1 Parameter set number
                                    (1 - max. number of pre-defined parameter sets)
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After performing the operation, the panel will respond back to the Command/
Response Word with one of the codes listed in Table 8-6.  Note that a Recipe
transfer may take several seconds, depending mainly on the number of bytes that
have to be transferred.

Code Description
0 OK, Transfer completed successfully
2 Error:  There are no Recipes defined
3 Error:  Error in project file
4 Error:  Illegal Page number has been requested
5 Error:  Illegal number of parameter set has been requested
6 Error:  The requested parameter set is locked (that is, it is being

           used by the operator panel for a data entry operation)
7 Error:  A communication error occurred during the transfer

Table 8-6

Set Parameter Set Number

The controller can use this command to select a given Recipe parameter set.

Command code: 4

Two parameters are required by this command:

Parameter 0 Page Number
(1 - max. number of pages in the project file)

Parameter 1 Parameter Set Number
(1 - max. number of pre-defined parameter sets)

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-7.
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Code Description
0 OK
2 Error:  Recipes not defined in project file
3 Error:  Error in project file
4 Error:  Illegal page number requested
5 Error:  Illegal record number requested
6 Error:  Requested record locked

Table 8-7

Get Parameter Set Number

The controller can use this command to get the current Recipe parameter set
number.

Command code: 5

Only one parameter is required by this command:

Parameter 0 Page Number
(1 - max. number of pages in the project file)

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-8.

Code Description
0 OK
2 Error:  Recipes not defined in project file
3 Error:  Error in project file
4 Error:  Illegal page number requested

Table 8-8
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Get Recipe Transfer Priority

The controller can use this command to get the current Recipe transfer priority
level.

Command code: 6

This command requires no parameters.

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-9.

Code Description
0 Normal
1 Highest
2 Error:  Recipes not defined in project file

Table 8-9

Set Recipe Transfer Priority

The controller can use this command to set the current Recipe transfer priority
level.

Command code: 7

Only one parameter is required by this command:

Parameter 0 Priority Level  (0=Normal, 1=Highest)

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-10.



The Interlock Mailbox

Exor Electronic R&D                                                            8-11

Code Description
0 OK
2 Error:  Recipes not defined in project file
3 Error:  Illegal priority setting requested

Table 8-10

Request Data Entry Mode

The controller can use this command to switch the operator panel to Data Entry
Mode.

Command code: 17

Two parameters are required by this command:

Parameter 0 Index Number of required Page
(1 - max. page number in project file)

Parameter 1 Index Number of required Data Field
(1 - max. number of data fields in the page)

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-11.

Code Description
0 OK
1 Error:  Illegal page number has been requested
2 Error:  Illegal field number has been requested
3 Error:  Panel is not ready for Data Entry Mode

Table 8-11
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Password Status

The  controller can use this command to request information about the current
password status.

Command code: 33

The command requires no parameters.

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-12.

Code Description
0 No passwords are defined in the project file
1 No valid password has been entered
2 A valid password has been entered
3 The system default password (0007) has been entered

Table 8-12

If Code 2 is returned, the Parameter Words will contain additional information as
follows:

Parameter 0 Current password level
Parameter 1 First character (ASCII coded) of the current password
Parameter 2 Second character (ASCII coded) of the current password
Parameter 3 Third character (ASCII coded) of the current password
Parameter 4 Fourth character (ASCII coded) of the current password
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Start Controller to Controller Transfer With No Confirmation

This feature allows the user to transfer data in two different manners:

1)  Between two controllers.  In this case, the controllers can be
connected by a controller network or with the UniNET network.

2)  Between two registers located within the same controller.

Note:  Once more than one job has been created, it will be impossible to entirely
 delete the first job without also deleting the second job.  For example,
 assume there are three jobs, created in the order Job 1, Job 2, Job 3.  If

      the user wishes to delete Job 2, they must also first delete Job 3.
 On the other hand, modifications can be made to any job at any time.

We will call one complete data transfer a job.  When the controller requests a job to
be executed, the panel responds immediately back to the controller and executes the
job as soon as possible.  Therefore, the controller does not know when, or if, the
requested job will be executed.

To set up a transfer, select Data Transfer from the Project menu.  The dialog box
shown in Figure 8-2 will then be displayed.

Figure 8-2
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The Job # field is used to select between the different jobs.  Click on the Source
Reference button to specify the register to be read.  The dialog box shown in
Figure 8-3 will then be displayed.

Figure 8-3

These fields will be slightly different depending on the controller that is being used.
Use these fields to specify the type of data, format, and address of  the register that
is to be read.  Once this information is entered, pressing OK will return the user to
the dialog box shown in Figure 8-2.  Enter the number of words to be transferred in
the appropriate box.  Clicking on the Destination button brings up a dialog box
similar to the one shown above in Figure 8-3 and allows the user to enter the
address in which the data is to be written.

If the Job Execution Mode is set to In Cycles, the panel will automatically transfer
the data on each cycle.  The cycle period can be set between 1 second and 127
seconds.  Remember the faster the cycles, the faster the panel will transfer data, but
this will slow down the rest of the system.  If the Job Execution Mode is set to On
request, the controller must send a  request to the Interlock Mailbox before the data
will be transferred.  After completely setting up the dialog box, click on OK.  Now
select Interlock Mailbox from the Project menu.  Set up the Mailbox as described
within the section entitled Definition of a Mailbox.  When the controller sends a
request to the Mailbox, the Mailbox will read the command word and the
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parameter.  The panel will then send a response word back to the controller and
execute the command.
Command code: 49

This command requires only one parameter:

Parameter 0 Job Number (1-255)

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-13.

Code Description
0 OK
1 Error:  Controller to Controller not defined at all
2 Error:  Illegal job number
3 Error:  Queue is full

Table 8-13

Start Controller to Controller Transfer With Confirmation

This command is set up in the same manner as the command Start Controller to
Controller Transfer With No Confirmation.

Command code: 50

This command requires only one parameter:

Parameter 0 Job Number (1-255)

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-14.
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Code Description
0 OK
1 Error:  Controller to Controller not defined at all
2 Error:  Illegal job number
3 Error:  Not used
4 Error:  Communication error while reading source data
5 Error:  Communication error while writing destination data

Table 8-14

Set RTC (Real Time Clock)

This command enables the controller to set the Real Time Clock located within the
panel.

Command code: 81

This command requires six parameters:

Parameter 0 Day (1-31)
Parameter 1 Month (1-12)
Parameter 2 Year (94...99, 00....)
Parameter 3 Hour (0-23)
Parameter 4 Minute (0-59)
Parameter 5 Second (0-59)

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-15.

Code Description
0 OK
1 Error:  RTC error
2 Error:  Requested setting out of range

Table 8-15
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Clear Event List From Controller Mailbox

The controller can use this command to request that the UniOP panel clear its event
list.

Command code: 97

The command requires no parameters.
After performing the operation, the panel will respond back to the
Command/Response Word with a 0, indicating that the event list has been cleared.

Start Report Printout

This command is used to start a report printout.  The method used in defining
reports is described in Chapter 2.

Command code: 113

This command requires only one parameter:

Parameter 0 Report Number

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-16.
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Code Description
0 OK
1 Error:  Printer process already active (if START command is

issued more than once)
Error: Printer process already inactive (if CANCEL command
is issued more than once)

2 Error:  Illegal report number
3 Error:  Activation queue is full

Table 8-16

Stop Report Printout

This command is used to stop a report printout.  The method used in defining
reports is described in Chapter 2.

Command code: 114

This command requires no parameters.

After performing the operation, the panel will respond back to the
Command/Response Word with one of the codes listed in Table 8-17.

Code Description
0 OK
1 Error:  Printer process already inactive

Table 8-17

Get Current Language

The controller can use this command to get the number of the currently active
language from the panel.

Command code: 129
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This command requires no parameters.

After performing the operation the panel will respond back to the
Command/Response Word with one of the codes listed in table 8-18.

Code Description
0 OK
1 Error, the project is not multilanguage.

Table 8-18
If Code 0 is returned, the Parameter Word 0 will contain the number of the active
language.

Set Current Language
The controller can use this command to change the language in the operator panel.

Command code: 130

Parameter 0 Language number

After performing the operation the panel will respond back to the
Command/Response Word with one of the codes listed in table 8-19.

Code Description
0 OK
1 Error, the project is not multilanguage.
2 Error, illegal language number requested

Table 8-19

Start Screen Saver
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The controller can use this command to immediately activate the screen saver
function.

Command code: 145

No parameters are required by this command.  After performing the operation the
panel will respond back to the Command/Response Word with one of the codes
listed in table 8-20.

Code Description
0 OK
1 Error, screen saver not enabled in the project file

Table 8-20

Stop Screen Saver
The controller can use this command to immediately deactivate the screen saver
function.

Command code: 146

No parameters are required by this command.  After performing the operation the
panel will respond back to the Command/Response Word with one of the codes
listed in table 8-21.

Code Description
0 OK
1 Error, screen saver is not enabled in the project file

Table 8-21

Enable Screen Saver Function in Alarm Mode
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The controller can use this command to enable the default behavior of the screen
saver in Alarm Mode.  If UniOP is in Alarm Mode and the time for the screen saver
activation has elapsed, the screen saver will start.  To stop the screen saver, simply
touch a key.  This command code can be used following command 148 (see next
description) in order to go back to the default setting.

Command code: 147

No parameters are required for this command.  After performing the operation the
panel will respond back to the Command/Response Word with one of the codes
listed in table 8-22.

Code Description
0 OK

Table 8-22

Disable Screen Saver Function in Alarm Mode
The controller can use this command to disable the screen saver function when
UniOP is in Alarm Mode.  If UniOP has the screen saver activated and an alarm
occurs, UniOP will turn off the screen saver and display the alarm page.  The alarm
page will be displayed as long as there is one currently active alarm.  Use command
147 (see previous description) to go back to the default behavior.

Command code: 148

No parameters are required for this command.  After performing the operation the
panel will respond back to the Command/Response Word with one of the codes
listed in table 8-23.
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Code Description
0 OK

Table 8-23
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8.3 - Mailbox Programming

To use the mailbox successfully, the panel and the controller must interact tightly.
The interaction between the panel and the controller can be thought of as a short
conversation between two people.

The first person (the controller) tries to start a conversation with the second person
(the UniOP panel) on a particular topic (the Mailbox command code).  After the
first person has introduced himself and the topic of the conversation, the second
person decides whether he feels competent enough to join in.  If the second person
decides not to join in the conversation, he politely informs the first person that he
feels he does not know enough about that particular topic to make an informed
comment and waits for a change in the topic of the conversation.  If the second
person does decide to enter into the conversation, he ponders the topic and then
expresses his well-considered opinion.  The vital ingredient in a successful
conversation is that nobody is interrupted while they are talking.

The flow chart in Figure 8-4 describes the program sequences that must be
executed in parallel by both the UniOP panel and the controller ladder logic
program to ensure a successful Mailbox session.

The following important notes should be kept in mind:
• At system start-up, the UniOP panel writes the special Status Code Panel

Restart to inform the controller that the panel itself has been reset.
• Both the panel and the controller can write to the Status Word and the

Command/Response Word; however, they must not write at the same time to
the same memory location.  Proper operation of the Mailbox is ensured if 

the sequence described in the figure is followed.
• The controller program must always wait for the completion of the current 

Mailbox session before attempting to start a new one.
• The controller program should always check the status returned by the 

UniOP panel on completion of a session.



The Interlock Mailbox

8-24

Figure 8-4
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Chapter 9 - The Font Editor

The Font Editor allows the user to modify the downloadable font of semi-graphical
displays.  Each font consists of 256 characters that can be edited or changed.  This
allows the user to create any necessary characters for a particular project.  In most
cases, the user would not want to edit any of the standard characters such as letters,
numbers, large character blocks, or bargraph blocks.

9.1 - Editing Characters

1. Select Run Font Editor from the Options pulldown menu.

2. The font will appear on the display in the Font Editor as shown below in 
Figure 9-1.

3. By double clicking on a particular pixel, the user is able to toggle the
appearance of that pixel.  For example, if a pixel is initially black,
double clicking on it will change it’s color to white.

Figure 9-1
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9.2 - Defining Symbols

The Designer software offers the user the ability to create their own symbols.
While still included in the software, this feature has become obsolete with the
current graphical release.

1. To select symbol mode, select Define Symbol from the Options pulldown 
menu.

2. Select Symbol Dimensions and enter the height and width of the symbol you 
would like to define. Select OK.

3. Select Define Symbol - Draw New Symbol from the Options menu.

4. The display will then change to the symbol dimensions that were selected.  The
editor will put the selected number of characters from the font in this symbol
edit box, starting with the character that was highlighted.

5. Select Define Symbol - Compose Symbol from the Options menu.  Double click
on each character that makes up the symbol.  Start with the character that will
be in the upper left-hand corner and move across.  The light gray character box
will automatically move to the next character location.  If a mistake is made,
simply single click on the character location to move the cursor box and then
double click on the correct character in the font bar.  When the symbol contains
all the correct characters, click in the small upper box.  Give the symbol a name
by typing it in this box and clicking on OK.
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9.3 - Saving a Font

1. When finished modifying the font, it can be saved by selecting Save or Save As
from within the File menu.  Fonts need to be saved to the Windows System
directory.  When changing a font, it is recommended to use Save As and give the
font a new name so as not to change the original font.

2. The font must then be installed by selecting Install-View installed Fonts under
the File menu within the Font Editor.  Select which display panels this font is to
be used with and click on the Install Font button.

3. Now the user can choose Select Font from the Project pulldown menu
from within Designer and be able to select the customized font.

9.4 - Bargraph Characters, Box Drawing Characters, and  
Large Characters

The Font Editor also provides a method of editing characters that are used in basic
character formation.  Each of these are available from within the Font Editor by
selecting the Options menu.

•  Bargraph Characters - The start code for bargraphs is the first non-blank
character within the bargraph character set.  Keep in mind that the bargraph
character set must be kept continuous (i.e., the characters must be kept in
numerical order).  An example of the start code is shown in Figure 9-2.  Note that
the character code will not remain the same for each font.
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Figure 9-2

•  Box Drawing Characters - By selecting Rectangles from the Options menu, the
user is able to edit the characters that form each of the two rectangles that are
implemented in the Designer software.  Simply highlight the area on the rectangle
you wish to change and double click on the character that you wish to replace it
with.  Figure 9-3 shows the dialog box that will appear when you select this option.
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Figure 9-3

•  Large Characters - The large character set must be kept continuous.  A dialog
box is shown in Figure 9-4 that represents the starting character in a large character
set.  Note that this starting character is not the same for every font.

Figure 9-4
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Chapter 10 - Graphics

By using a UniOP graphics-capable panel , the user is capable of importing,
displaying, and manipulating graphics in a project file.  Once the graphic is
imported into the project file, it may be easily moved or resized.  By selecting the
Graphics pull down menu, the user will be presented with five different selection
possibilities, including Import Bitmap Graphics, Graphics Library, ISA Symbols,
Dynamic Graphics, and Transparent Graphics.  All of these may also be accessed
through the Extra ToolBelt by simply clicking on the appropriate icon, with the
exception of ISA Symbols.

10.1 - Importing Bitmap Graphics

The first option the user is presented with in the Graphics menu is Import Bitmap
Graphics.  Any file having the extension .BMP or .DIB may be imported.  Simply
highlight the area in which the graphic is to be placed, select Import Bitmap
Graphics from the Graphics menu (or click on the appropriate icon in the Extra
ToolBelt), select the graphic file to be used, and click on OK.  This will bring up a
dialog box in which the user can select the graphic label, as well as the dithering
and imaging options.  It is suggested to import the graphic using the default values.
If the user is unsatisfied with the result, import the graphic again using different
settings.  These options are discussed further in the section Recommendations &
Tips.

From Designer version 5.06 and firmware version 4.22, it is possible to import a
256 color bitmap into a project file for any of the UniOP operator interfaces that
utilize a color VGA display (i.e., ETT-VGA, MKDC-VGA, etc.).  To set the
Designer software up to allow for this, select Project-Panel Setup and choose the
model VGA 256 Colors.
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Example

The following steps will help the user to import a bitmap file:

1. Make sure that the Enhanced graphics support is enabled in the Panel
Setup dialog box under the Project menu.

2. Highlight the area in which the graphic is to be placed by clicking and
dragging the mouse.

3. Select Import Bitmap Graphics from the Graphics menu.  This will open a
dialog box that allows the user to select a file.  Select the filename that is to
be used and click on OK.  Another dialog box, shown in Figure 10-1, will
open that allows the user to label the bitmap and select import options.

Figure 10-1

4. The Label will default to the filename of the bitmap file.  However, this label
can be changed.  This label is used to recall the bitmap if it is used again in
the project file.

5. The user can also choose different imaging and dithering options.  It is
suggested to import the graphic using the default values.  If the result is
undesirable, the user can simply re-import the graphic and change these
settings.

6. Figure 10-2 shows how the bitmap file will look after it is imported into the
project file.
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Figure 10-2

7. A graphic can be moved or resized once it is imported.  To move a graphic,
simply single click the left mouse button over the graphic and move it to the
desired location.  To resize a graphic, single click the left mouse button once
on the graphic and use one of the selection handles that will appear.

8. To duplicate or copy a graphic within the same page, hold the Ctrl key down
and click on the graphic.  Drag the duplicated graphic to a new location and
release the mouse button.

9. To delete a bitmap graphic, click on the graphic to select it and either press
the Delete key or click on the Cut tool.
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10.2 - Graphics Library

Another method of bringing a graphic into a project file is by using the Graphics
Library.  Simply highlight the area in which you wish to place the graphic and
select Graphics Library from within the Graphics menu (or click on the
appropriate icon in the Extra ToolBelt).  This will bring up a dialog box, which is
shown below in Figure 10-3.

Figure 10-3

When the ‘External’ Library source radio button is selected, the dialog box will list
all of the bitmap graphic files that are contained within the Graphics subdirectory.
This subdirectory is located within the main directory of Designer that was created
upon installation of the software.   It is recommended that the user place all
graphics files that they frequently use in the Graphics subdirectory.  If the ‘Current
project’ Library source radio button is selected, the dialog box will list all of the
bitmap graphic files that are in use within the current project.

A graphic can be selected by single clicking the left mouse button on the filename
you wish to use.  Once a graphic is selected, a preview of the image will be shown
within the dialog box.
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Example

For this example, assume the user wants to use the graphics library to put a
picture of a blower into the project file.  To do this, the following steps must be
performed.  Note that this is the standard procedure when using the graphics
library, regardless of the graphic file.

1. Highlight the area on the screen in which the graphic is to be located.
2. Either select Graphics Library from the Graphics menu or click on the

appropriate icon in the Extra ToolBelt.
3.  Select the file BLWR.BMP.  A picture of a blower will appear in the dialog

box.
4.  Click on the Import button.  This will bring up a dialog box in which the

user may enter the label, as well as imaging and dithering options.  It is
recommended to use the default selection initially.  If the result is not
satisfactory, try importing the graphic using different combinations to see
what gives the best results.  See the section Recommendations & Tips for
further details.

5. Click on OK and choose Exit.  This will return you to the page editor
workspace.

10.3 - ISA Symbols

The ISA (Instrument Society of America) Symbols floating toolbar allows the user
to have an easy access library of standard industrial symbols.  This feature can be
accessed by selecting ISA Symbols from the Graphics menu.  Doing so will bring
up the floating toolbar of symbols that is shown above.  By placing the cursor over
a symbol, the user will see a popup tip containing the name of that symbol.  The
user may add one of these symbols to their project file by using one
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of two methods.  The first method is to highlight the area in which the symbol is to
be placed, select ISA Symbols from the Graphics menu, and click and drag the
desired symbol to the highlighted area.  The second method is to select ISA Symbols
from the Graphics menu and click and drag the symbol to the desired location.  The
symbol may then be resized by selecting the image and using the handles that
appear around it’s outer border.

10.4 - Dynamic Graphics

This feature allows the user to display different graphics based upon a numeric
value in the controller.  It can be accessed by either selecting Dynamic Graphics
from the Graphics menu or by selecting the proper icon from the Extra ToolBelt.
For example, a user may want to display two graphics, one when a blower is on
and one when a pump is on.  Depending upon which machine is on, the respective
graphic will be displayed at a single screen location.  If neither machine is on, then
no graphic will be displayed.  In another scenario, a user may wish to have a
graphic appear at a different location on the screen, depending upon which machine
is on.  Examples of these situations are given below.

Example 1

In this example, assume a user has a situation in which there are three possible
occurrences.  Either a blower can be on, a pump can be on, or neither can be on.
Depending upon the situation, the user wants to display a graphic at the same
location on the panel.  This can be accomplished by referencing the graphics to a
single register in the controller.  A value of 0 in this register indicates that
neither the blower nor the pump is on.  A value of 1 in this register  indicates that
the blower is on.  A value of 2 in this register indicates that the pump is on.

1.  Highlight the location in which the graphic is to be displayed.
2.  Either select Dynamic Graphics from the Graphics menu or click on the

appropriate icon in the Extra ToolBelt.
3.  This will bring up a dialog box allowing the user to select the memory
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location in the controller in which the values 0, 1, or 2 will be written.  Since
we are using more than two values, the data format can be selected as a
byte.  If we had only used two values, we could have selected the data format
as a bit (assuming the driver supports these data formats).

4.  We have three different values being written into the controller, either a 0, 1,
or 2.  Therefore, our minimum value is 0 and our maximum value is 2.  Once
these have been entered into their respective locations in the dialog box, click
on the Edit Graphics button.

5.  This will bring up another dialog box in which the user can associate the
graphic with a value.  To assign a value to a graphic, either click on the
value that is to be used or select the value by  using the up and down arrow
keys located next to the ‘Current value’ box.  Since we do not need a
graphic for the value of 0 (remember, a 0 indicates that nothing is
operating), leave this value blank and select the value of 1.  This is the first
value that will have a graphic associated with it.

6.  Once the value is selected, a graphic needs to be associated with it.  Since we
are using graphics that are available from the Graphics Library, click on the
From Library... button.  Note that if the graphics were not located in the
Graphics Library, we would need to click on the Import New... button and
select the proper location of the graphic, as well as it’s filename.

7.  A dialog box will appear, allowing the user to select a graphic.  This is the
same dialog box that appears whenever Graphics Library is selected (see
Figure 10-3).  We have the value of 1 selected, which is indicative of a
blower being on.  Selecting the filename BLWR.BMP will give the user a
preview of the graphic for a blower.  Click on the Import button.  This will
bring up a dialog box in which the label, as well as imaging and dithering
options can be selected.  Once these have been set, clicking on OK will
return the user to the dialog box that was present upon entering step 5.

8. Perform the same procedure for selecting the value of 2 and the graphic of a
pump (the filename for the pump is PUMP.BMP).  Once this is completed,
the dialog box that contains the graphics and their values will look similar to
the screen capture shown in Figure 10-4.  Clicking on OK will take the user
back to the dialog box in which the address and the minimum and maximum
values were set up.  Clicking on OK from within this dialog box will
complete the procedure and return the user to the page editor workspace.
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Figure 10-4

Example 2

In this example, assume a user wants to have a graphic appear in one of three
different locations on the screen, depending upon what is happening.  Assume
there are four possible occurrences.  Either a blower can be on, a pump can be
on, both can be on, or neither can be on.  If there is nothing on, the display
screen will be blank.  If the blower is on, the graphic of the blower will appear in
the second screen location.  If the pump is on, the graphic of the pump will
appear in the third screen location.  This can be accomplished by using a
different memory location for each graphic that is to be displayed.
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Since there is to be nothing displayed on the screen when neither the pump
nor the blower is on, we only need to create two graphics fields in the
project file - one field for the graphic of the blower and the other field for
the graphic of the pump.

1.  Highlight the area in which the graphic of the blower is to appear.
2.  Either select Dynamic Graphics from the Graphics menu or click on the

proper icon in the Extra ToolBelt.
3.  This will bring up a dialog box that allows the user to select the memory

location in the controller that is to be used.  Since we are using a memory
location for each graphic, the data format of these fields can be set as a bit
(again, if the selected driver supports this data format).  This is because
there are only two possible cases, either the graphic associated with the
memory location is displayed or it isn’t.

4.  Since there are only two scenarios, the minimum value can be set to 0 and
the maximum value can be set to 1.  If the selected memory location has a
value of 1, the graphic will be displayed.  If the memory location has a value
of 0, the graphic will not be displayed.  Once the minimum and maximum
values have been set up, click on the Edit Graphics button.

5.  This will bring up another dialog box in which the user can associate the
graphic with a value.  To assign a value to a graphic, either click on the
value that is to be used or select the value by using the up and down arrow
keys located next to the ‘Current value’ box.  Since we do not need a
graphic for the value of 0 (remember, a 0 indicates that no graphic is
displayed), select the value of 1.

6.  Once the value is selected, a graphic needs to be associated with it.  Since we
are using graphics that are available from the Graphics Library, click on the
From Library... button.  Note that if the graphics were not located in the
Graphics Library, we would need to click on the Import New... button and
select the proper location of the graphic, as well as it’s filename.

7.  A dialog box will appear, allowing the user to select a graphic.  This is the
same dialog box that appears whenever Graphics Library is selected (see
Figure 10-3).  We have the value of 1 selected, which means that the graphic
will be displayed.  Selecting the filename BLWR.BMP will give the user a
preview of the graphic for a blower.  Click on the Import button.  This will
bring up a dialog box in which the label, as well as imaging and dithering



Graphics

10-10

options can be selected.  Once these have been set, clicking on OK will
return the user to the dialog box that was present upon entering step 5.  Since
this is the only graphic that needs displayed at this memory location, click on
OK to return the page editor workspace.  We are now ready to make another
graphic field in which to place the graphic for the pump.

8.  Highlight the area in which you wish to place the graphic for the pump.
Repeat steps 2 through 6.  In step 7, select the filename PUMP.BMP for the
pump instead of selecting the filename BLWR.BMP for the blower.  Once
the user has imported the graphic and returned to the page editor workspace,
the procedure is complete.  Figure 10-5 shows the what the dialog boxes
should look like when the graphic for the pump and the blower have been
correctly imported.

   
         Pump dialog box Blower dialog box

Figure 10-5
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10.5 - Transparent Graphics

Transparent graphics allow the user to overlay dynamic fields or static text in front
of a bitmap graphic.  An example using this feature is given below.

Example

Assume a user wants to simulate the fill level of a tank.  In this case, a
transparent graphic of a tank could be used along with a bargraph to simulate
the fill level.  The procedure for implementing this feature is as follows:

1.  Highlight the area in which the graphic is to be placed.
2.  Import the graphic that is to be used (a tank in this case).
3.  Either select Transparent Graphics from the Graphics menu or click on the

appropriate icon in the Extra ToolBelt. Note that the graphic can be toggled
from visible to invisible by simply re-selecting Transparent Graphics from
the Graphics menu (or by using the icon in the Extra ToolBelt).  This
allows the user to be able to reposition or resize the graphic.  Also note that
it is necessary to have Transparent Graphics toggled on in order to place
static text or dynamic fields at the same screen location as the graphic.

4.  Highlight the area in which the field (a bargraph field in this case) is to be
placed.

5.   Select the field type by either selecting Bargraph from the Edit - Data Field
Type menu or by clicking on the proper icon in the Extra ToolBelt.

6.  This will bring up a dialog box allowing the user to configure the bargraph.
Click on OK  once the field is configured.  The procedure is now complete.
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10.6 - Recommendations & Tips

1.  If the user is importing graphics using Import Bitmap Graphics or the
Graphics Library, there will be a button labeled Info... present in the initial
dialog box.  Clicking on this button will bring up an additional dialog box
that contains information specific to the graphic file that is selected.  This
information includes the name of the file, the file format, the width and
height of the graphic in pixels, the number of colors used, and if there is
any type of file compression.  This allows the user to know the resolution of
the graphic before it is actually imported into the project file.  If visual
effects are of importance to the user, we recommend using a professional
image processing package to edit color graphics before importing them into
a monochrome panel.

2.  In most cases, a complex image that contains many colors or many levels of
gray looks the best when imported using Bayer dither.  An image composed
of only a few colors (or monochrome - only one color) generally looks the
best when imported using the no dither option.

3.  Graphics can be no larger than the size of the entire screen.  In other words,
you can not place a graphic that is 640 X 400 on a 500 X 300 screen.

4.  Graphics that do not take up the entire screen can be moved, resized, and
copied.  Single clicking the left mouse button anywhere on the graphic will
select it, bringing up selection handles.  The user can utilize these handles to
either move or resize the graphic.

5.  For best visual effects, we recommend resizing graphics in integer multiples.
For example, if the graphic is 32 X 30, recommended sizes would be 64 X
60, 128 X 120, etc.  It is also recommended to use graphics whose
resolution best matches that of the panel.  For example, importing a graphic
that has 1024 X 1024 resolution onto a panel that has 640 X 400 resolution
will result in distortion.

6.  Color graphics can be imported onto a monochrome panel.  Designer will
attempt to cast the graphic in monochrome the best that it can.  This will
produce halftoning effects, which are dots that simulate different levels of
gray using different densities of monochrome pixels.

7. When using more than one graphic, they cannot overlap one another.
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8.  Note that neither static text nor dynamic controller fields (such as the
bargraph in the transparent graphics example) can be placed in the leftmost
column of the transparent graphic.

9.  When importing a graphic, the user can see it’s size in pixels by looking at
the right side of the status bar located at the bottom of the Designer screen.
The selection size status bar indicator, which shows the pixel width and
height of the selected graphic, will be present.  This is a good way for the
user to monitor the change in the size of the graphic.

             Selection size status bar indicator

10.  If a single graphic is to be used more than once in a project with different  
imaging and/or dithering options, there must be a separate label (name)
assigned to each unique imaging/dithering combination.
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Chapter 11 - Color

It is now possible to display any combination of up to 16 different colors on certain
models of UniOP panels.  To access the color option within the software, the user
can select Color palette from the Edit menu, or click on the appropriate icon in the
Extra ToolBelt.  Doing so will bring up the dialog box that is shown below.

Figure 11-1

This dialog box allows the user to change the background color and the foreground
color (either static text or data fields).  The user can select whether to change these
colors on a global level or on a current selection.  If the user wishes to make the
colors the default setting for all subsequently created pages, selecting the colors and
clicking on the Pick text color button will accomplish this.  Likewise, if the user
wishes to change the colors only for the currently selected area, this can be
accomplished by selecting the colors and clicking on the Change button.
The area below the palette bars and above the buttons will indicate the global
setting for the project file.  For example, in the dialog box shown above, the colors
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are set for a white background and a black foreground.  Every page that is created
will have these colors as a default setting unless the user specifies otherwise by
selecting different colors and clicking on the Pick text color button.

NOTE:  The button entitled Pick text color will change to Pick field color
whenever a data field is selected.  Likewise, the area below the palette bars that
shows the global setting will also change from Text color to Field color whenever a
data field is selected.

11.1 - Changing the Background / Foreground Color     
  Globally

1.  Either select Color palette from the Edit menu or click on the appropriate icon
in the Extra ToolBelt.

2.  Select the color(s) to be used and click on the Pick text color button.

11.2 - Changing the Background / Foreground Color for a 
  Highlighted Area

1.  Highlight the area that is to be affected.
2.  Either select Color palette from the Edit menu or click on the appropriate icon

in the Extra ToolBelt.
3.  Select the color(s) to be used and click on the Change button.
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11.3 - Making the Colors of a Data Field or Static Text the 
  Global Default Colors

1.  Position the cursor somewhere on the data field or on the static text.
2.  Either select Color palette from the Edit menu or click on the appropriate icon

in the Extra ToolBelt.
3.  Click on the Pick text color button.

11.4 - Finding Out the Colors of a Particular Area or Field

1.  Either select Color palette from the Edit menu or click on the appropriate icon
in the Extra ToolBelt.

2.  Position the cursor on the desired location by single clicking the left mouse
button.

3.  Click on the title of the dialog box.  The currently selected colors for the area
will be reflected in the color palette bars.

11.5 - 256 Color Support

From Designer version 5.06 and firmware version 4.22, it is possible to import a
256 color bitmap into a project file for any of the UniOP operator interfaces that
utilize a color VGA display (i.e., ETT-VGA, MKDC-VGA, etc.).  To set the
Designer software up to allow for this, select Project-Panel Setup and choose the
model VGA 256 Colors.
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11.6 - Application Notes

1.  Each field can be in only one color.  For example, assume the user has a field
that displays a two digit number.  If the first digit is blue, the second digit can
not be displayed in any other color but blue.

2.  If the user tries to make the background color and the foreground color the
same, the software will display a text message asking the user if this is what
they wish to do.  If the background color and the foreground color are the same,
everything will appear transparent and no data fields or static text will be
visible.
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Chapter 12 - Recipes

12.1 - Introduction

All versions of Designer above or equal to 4.00 offer the possibility of storing data
inside the panel in data retentive memory.  The available amount of data retentive
memory varies depending on the UniOP model.  This data retentive memory can be
used to permanently store data for use by an attached controller.  This data can be
written to the controller, and, conversely, the data can be read from the controller
and then placed in the data retentive memory.  This concept is termed Recipes and
offers a powerful way to extend the capabilities of the controller.  This is especially
true for controllers that have a limited amount of internal memory.

All UniOP panels offer memory for usage with Recipes, with the exception of the
CP11, CP13, MD00, MD01 and the MD03, which are not Recipe capable.

Recipes are configured by simply adding the required controller data items to the
page as Recipe data items.  To add a Recipe data item, the user can perform the
same procedure used to create a numeric field almost exactly.  The only change
necessary is to select Data Field Source - Recipe Data from the Edit menu instead
of selecting Data Field Source - Controller Data (or select the Recipe icon from
the Extra ToolBelt instead of the Controller Data icon).

Recipe data items contain all the information associated with normal controller data
items, but rather than the data being read and written directly to the controller
during the course of normal operation, the data is instead read from and written to
the UniOP memory that is reserved for the data item.  Only when the user explicitly
asks the UniOP panel to write the data to the controller is the data sent to the
controller.  Similarly, only when the user explicitly asks the UniOP panel to read
the data from the controller is the data actually read from the controller.
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12.2 - A Quick Start Example

It is not necessary to create a complex project to try Recipes.  This example will
show the user how to define a very simple Recipe in a few steps.

1. Make sure that the panel is in Configuration Mode.
2. Connect the panel to the personal computer and the controller using the

correct cables.
3. Start the Designer software.
4. Define some background text and two numeric fields with different addresses

as shown in Figure 12-1.

Figure 12-1

5. Go to the Edit menu and select Recipe Data from the Data Field Source
option or choose the Recipe icon in the Extra ToolBelt.
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6. Define two Recipe data items with the same addresses as given to the
numeric fields that were created in step 4.  The two Recipe data fields will be
shown on the Designer page with the placeholder 'R' instead of the '9' used
for numeric fields (see Figure 12-2)

Figure 12-2

7. Go to the Page menu and select the option Recipe Configuration.  This will
bring up the dialog box that is shown in Figure 12-3.

8. Enter 4 for the Number of Parameter Sets and initialize the Recipe values as
shown in Figure 12-3.  Note that the Recipe Item addresses will be the
addresses of the fields that were defined earlier.  Select OK to confirm the
operation.
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Figure 12-3

9. Enter the Keyboard Macro Editor and configure the F1 key using the
command Recipe Control to download the current parameter set.

10. Download the project to the panel either by pressing the F2 key on the
computer keyboard, by selecting the Download icon in the Extra ToolBelt,
or by choosing Download from the Transfers menu.

11. When the download is finished, the panel will go into Operation Mode.  The
variables in the left column represent the content of the controller memory.
The column on the right will represent the content of the first Recipe
parameter set once the F1 key is pressed.

12. Pressing the F1 key will cause the panel to begin downloading the current
Recipe parameter set (which is parameter set 1).  After a few seconds, the
operation will be completed and the content of the controller memory will
show the same values as those that are stored in parameter set 1.
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12.3 - Adding Recipe Data Items with Designer

The user can add Recipe data items to a page using Designer by selecting Data
Field Source - Recipe Data from the Edit menu.  From the Data Field Source
menu, the user can specify that the data item is either Controller Data (the default),
Recipe Data, or a Panel Control Variable.  The Control Variable, which will be
discussed later, offers a means of controlling and monitoring Recipes.

Note:  When Recipe Data has been selected in the Data Field Source menu (or
with the icon), all data items that are subsequently added to the page by the
user will be Recipe data items.

Specifying Initial Values for Recipe Data Items

A Recipe is associated with a particular page and is composed of all the Recipe
data items on that page.  However, there can be different parameter sets of a
Recipe.  A Recipe parameter set is created by assigning particular values to the
Recipe data items on a page.  It is possible with Designer to create many parameter
sets that are contained within a single Recipe.  All of these different parameter sets
of the Recipe can contain different values and control different processes.  This
allows the user to enter many different sets of parameters for the controller.  One
set may be used to configure the controller to control the production of 2 mm
screws, another set may be used to configure the controller to control the
production of 5 mm screws, and yet another to control the production of 7 mm
screws.  Each set of parameters would be stored in a different parameter set within
the same Recipe.

The user can specify the number of parameter sets contained within a Recipe, as
well as assign the initial values to the different parameter sets of a Recipe with the
Recipe Configuration dialog box.  This dialog box is accessed by selecting Recipe
Configuration from the Page menu. The initial values entered for a particular
Recipe data item are in the format that was specified in the define field dialog box
for that data item.  For example, if a numerical format of hexadecimal was entered
in the define field dialog box for a Recipe data item, then all the values entered in
the Recipe Configuration dialog box for this Recipe data item will also be in
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hexadecimal.  If the user specifies a numeric data format of hexadecimal for a
Recipe data item, and then enters a value of 10 in the Recipe Configuration dialog
box, the 10 will be interpreted as 10 hexadecimal (16 decimal).

Note:  The user must have Recipe data items defined on the current page before
entering the Recipe Configuration dialog box.

The Recipe Configuration dialog box is in the form of a spreadsheet.  Each row is
associated with a particular Recipe data item.  The controller address of the
Recipe data item is displayed at the far left hand side of the row, enabling the user
to tell which row is associated with which Recipe data item.

Each column is associated with a particular parameter set of the Recipe.  The
initial values for a particular parameter set can be fully specified by entering a
value for each row in the column.  Each parameter set is identified by a numeric
number.  The first column corresponds to parameter set 1, the second column to
parameter set 2, and so on.

12.4 - Selecting Parameter Sets & Controlling Transfers

As mentioned earlier, Control Variables offer a means of controlling and
monitoring the Recipes.  Control Variables are special data items that are stored in
the UniOP panel memory.  The user can control certain operations of the panel by
modifying the values held in these internal variables.  Control Variables can be
added to the project in exactly the same way as controller variables.  The user must
first select Data Field Source - Panel Control Variable from the Edit menu.  With
this selection in force, all newly added data items will be Control Variables.

There are 8 types of Control Variables:  Recipe File Status, Recipe Parameter Set
Selection, Recipe Action, Data Entry Status, and Data Entry Field Number,
Recipe Page for Selection, Language and Passthrough Status.  The first five will
be discussed here.  The other control variables can be found within their respective
sections in the text (i.e., Language is explained in the Multilanguage section,
Recipe Page for Selection is explained with Recipe Menus, Passthrough Status is
explaned with Remote Passthrough).
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Recipe File Status

In the UniOP panel memory there is a single memory location that is used to store
the status of the entire Recipe data in the panel.  This memory location is called the
Recipe File Status.

The Recipe File Status cannot be modified by the user of the panel; it is controlled
by the internal logic in the panel.  The Recipe File Status can take on only 2 values,
0 or 1.  A value of 0 indicates that all of the Recipe data for every page in the
project is valid.  A value of 1 indicates that an error in some part of the Recipe data
was found.  This means that the integrity of the Recipe data is compromised.  It is
very rare for this to happen, but it can feasibly occur if the UniOP panel is powered
off while the user is modifying the value of a Recipe data item.

If the Recipe File Status has a value of 1 the user must physically change the value
of one of the Recipe data items to reset the Recipe File Status to 0.  Until this
occurs, the user will not be able to perform Recipe transfers.

Recipe Parameter Set Selection

For each page that contains a Recipe, the UniOP panel reserves a separate memory
location for the Recipe Parameter Set Selection for each Recipe page.  The Recipe
Parameter Set Selection memory location stores the numeric identifier of the
currently selected Recipe parameter set for the Recipe page.

The user can add Recipe Parameter Set Selection data items to the project.  These
data items can then be used to visually display the currently selected Recipe
parameter sets of the various Recipes in the project.

When the user adds these data items to the project, they must specify which Recipe
is to be monitored by the data item.  This is done by specifying the page number
that contains the required Recipe.

For example, a project might contain three Recipes, one on page 2, one on page 3
and the other on page 7.  To monitor the currently selected Recipe parameter sets of
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these three different Recipes, it is necessary to add three Recipe Parameter Set
Selection data items to the project.  One of these data items will be used to monitor
the Recipe on page 2, one to monitor the Recipe on page 3 and the other to monitor
the Recipe on page 7.  These three Recipe Parameter Set Selection data items could
all be placed on any page of the project.  Regardless of where they are placed in the
project, the address of the first data item would be Recipe Parameter Set Selection
2, the address of the second data item would be Recipe Parameter Set Selection 3
and the address of the third data item would be Recipe Parameter Set Selection 7.

The user can also change the parameter set of a Recipe on a particular page by
modifying the value held in the Recipe Parameter Set Selection variable.  This is
done in the same way as changing the value of a normal controller data item.
For example, to make Recipe parameter set number 3 the current parameter set,
the user would enter a value of 3 in the appropriate Recipe Parameter Set
Selection variable.  In order to do this, the user must select the Recipe Parameter
Set Selection variable as a Read/Write variable.

Recipe Action

For each page that contains a Recipe, the UniOP panel reserves a separate memory
location for the Recipe Action for that Recipe page.  The Recipe Action memory
location stores the current status of operation of the Recipe for the page.

The user can add Recipe Action data items to the project.  These data items can
then be used to visually display the current state of the various Recipes in the
project.

When the user adds these data items to the project, they must specify which Recipe
is to be monitored by the data item.  This is done by specifying the page number
that contains the required Recipe.

A Recipe Action data item can take on only 3 values: 0, 1 or 2.
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A value of 0 indicates that the Recipe is in its normal state of operation.  In this
mode of operation, the values of the Recipe data items are displayed on the screen
of the panel and the user can modify the values of the Recipe data items.
A value of 1 indicates that the Recipe data for the currently selected parameter set
is being transferred to the controller.  When the transfer is complete the value is
automatically reset to 0.

A value of 2 indicates that the Recipe data for the currently selected parameter set
is being transferred to the panel.  When the transfer is complete the value is
automatically reset to 0.

The user can start a Recipe transfer by entering a value of 1 or 2 for the Recipe
Action data item.  By entering a value of 1, the user can force the UniOP panel to
send the Recipe data for the currently selected parameter set to the controller.  By
entering a value of 2, the user can force the controller to transfer the Recipe data
for the currently selected parameter set to the panel.

Data Entry Status

This control variable will be set to a 1 while the UniOP panel is in Data Entry
Mode.  In all other modes it will be set to 0.

Data Entry Field Number

This control variable simply contains the field number of the selected data entry
field whenever the panel is in Data Entry Mode.
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12.5 - Recipes and the Keyboard Macro Editor

Recipe transfers can also be performed by using the Keyboard Macro Editor. When
doing so, the user should program the keys using Page n mode (where n is the
page on which the Recipe of interest is located).  By selecting the Recipe Control
macro command from within the Commands toolbar of the Keyboard Macro
Editor, the user can either download, upload, or select a parameter set on any given
page.  By using the Control Variable Step macro command, the user can assign a
key or touchcell to toggle through the different parameter sets.

12.6 – Recipe Menu Support

A Recipe Menu is a feature that simplifies recipe parameter set selection on UniOP
through a user-friendly interface.  It provides a menu-like field that will can contain
names to describe the parameter set instead of using numbers.  Each name
represents one Recipe Parameter set.

In order to make usage of Recipe Menu possible, each Recipe Parameter set must
be given a name.  This is achieved by adding a Recipe Data Item field with a
display format of ASCII on the page where the recipe is located and filling the
Recipe Item values with a name for each parameter set.  This ASCII field is called
a Recipe Name field.

Note: This field is not a field type name; it only describes the field’s purpose.
A Recipe Name field must be defined to enable Recipe Menu support.

There are three specific fields that support the Recipe Menus:
• Recipe Menu field,
• Recipe Page For Selection field and
• Recipe Key field.

The Recipe Menu field is the actual field that displays the menu with recipe names.
The currently selected recipe parameter set is indicated using user defined attribute
combinations (blink, highlight, reverse).
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The Recipe Page For Selection field shows the number of the page containing the
actual recipe data referred to by the Recipe Menu.

The Recipe Key field is not directly connected with Recipe Menus.  It is a less
user-friendly way of selecting a recipe parameter set by name.  In order to choose a
recipe parameter set, the user has to edit the field and type the wanted recipe name
(instead of being able to select it from a menu). It can also be used to show the
currently selected Recipe Parameter Set name for a specific page.  The Recipe Key
field must refer to a specific page with a defined Recipe Name.

All three of these fields do not depend on each other and can be freely put on any
page in the project in any combination.

A set of keyboard macro commands support Recipe Menu:
• Go To Recipe Menu,
• Scroll Recipe Menu and
• Confirm Recipe Menu Selection.

The Go To Recipe Menu macro jumps to a specified page and sets the value of the
Recipe Page For Selection.

The Scroll Recipe Menu macro is used to move the selection in the Recipe Menu
field.  This is the way that a new Recipe Parameter set name is chosen from the list.

The Confirm Recipe Menu Selection macro changes the current recipe parameter
set to the one selected in the Recipe Menu field.
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Defining a Recipe Name
The Recipe Name should be defined for all of the pages containing recipes that are
going to be handled using Recipe Menu.  It is also necessary for the pages that are
referred to by Recipe Key field(s).

The Recipe Name is defined by adding a Recipe Data Item field of ASCII display
format on the page with recipes and filling the Recipe Item values with a name for
ach Parameter set.

Note: This ASCII field is not an internal variable in the panel memory.  It needs
to be addressed to a physical location in the PLC memory. The amount of
memory required depends on the length of the ASCII string: one byte per
character.

Here is the procedure that describes how to add a Recipe Name definition.  It
assumes that the current page is the page with defined recipes and that it is the page
for which you want to add a Recipe Name.  Figure 12-4 shows the Recipe
Configure dialog box.

1. Add one Recipe Data Item field.
2. Set the Display format to ASCII.
3. Set Data Access to Read/Write if you want to make recipe names editable.
4. From the Page menu choose “Recipe Configuration …” to open Recipe

Configure dialog box.
5. Fill the new Recipe Item with names for each Recipe Parameter Set.
6. Select this new Recipe Item by clicking on the button with the record number.

Note that the entire row highlights.
7. Click on the Set As Recipe Name button to set this Recipe Item to be the

Recipe Name. Note that the asterisk (“*”) appears to the right of the Recipe
Item name.

8. Click on the OK button to accept the changes.
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Figure 12-4

Creating a Recipe Menu Field

The Recipe Menu field is the field that displays the menu with the Parameter Set
names.  It displays recipe names for the page which number is contained in the
Recipe Page For Selection internal UniOP variable.  The value of this variable can
be displayed and changed using the Recipe Page For Selection field.  Its value can
be automatically set by the Go To Recipe Menu macro command.
The currently selected recipe name is indicated with a user defined attribute
combination (blink, highlight, reverse).

To enable Recipe Menu support, at least one page with Recipe Name must be
defined.
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Note: The only field on the page needed for displaying a Recipe Menu is the
Recipe Menu field. Other fields can show additional information but are
not necessary.

If Recipe Page For Selection contains the page number of a page without a Recipe
Name field defined, the Recipe Menu field will display asterisks (“*”).

The following procedure describes how to add a Recipe Menu field.
1. Select an area on the panel screen by dragging the mouse.  This area will

contain the Recipe Menu field.
2. From the Edit menu choose Recipe Menu or press Ctrl-R.  Click once anywhere

on the panel screen to clear the selection; a solid box represents the Recipe
Menu field.

3. Double click on the Recipe Menu field to open the Recipe Menu dialog box (see
Figure 12-5).

4. Adjust the width and height if not satisfied.
5. Choose the attribute combination for indicating the selected recipe name.
6. Select Yes or No for Shown Record Numbers before Record Name, depending

on whether you want to show record number (which is just the parameter set
number) together with the recipe name.

7. Click on the OK button to accept changes.
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Figure 12-5

Recipe Page for Selection Field

The Recipe Page For Selection is a Control Variable.  The purpose of the Recipe
Page For Selection field is to show the number of the page containing the actual
recipe data referred to by the Recipe Menu.

It can be placed on the same page with a Recipe Menu field to show the “recipe
page number”.  It can also be edited to change the page for which Recipe Menu
field displays information.  If Recipe Page For Selection contains the page number
of a page without a Recipe Name field defined, the Recipe Menu field will display
asterisks (“*”).  After powering up the UniOP, the Recipe Page For Selection is set
to zero.
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Recipe Key Field

The Recipe Key field is an ASCII field of type Control Variable.  The Recipe Key
field displays the currently selected Recipe Parameter Set name for the referred
page.  Like a Recipe Menu field, it can be used to change the selected recipe
parameter set by name but in a less user-friendly way.  Using this method, the user
has to edit the field and type the wanted recipe name (versus selecting it from a
menu of choices).

The page to which a Recipe Key field refers to must have a defined Recipe Name
field.  If the referred page has no Recipe Name field defined, the Recipe Key field
will display asterisks (“*”).

Recipe Menu Keyboard Macros

Three special keyboard macros support Recipe Menus (see 12-6).

They are:
• Go To Recipe Menu,
• Scroll Recipe Menu and
• Confirm Recipe Menu Selection.

The Go To Recipe Menu macro sets the Recipe Page For Selection and jumps to
the specified page.  This is the preferred way of going to a Recipe Menu page (page
with Recipe Menu field).  The other way is to set the page number in the Recipe
Page For Selection field and then go to the Recipe Menu page using any other page
changing macros (Go To Page, Next Page, etc.).

The Scroll Recipe Menu macro is used to move the selection in the Recipe Menu
field.  With this macro command you can choose a new Recipe Parameter Set from
the list.  Positive values for the scroll step move the selection down, while negative
values move the selection up.
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If there are many recipe parameter sets, more than one key can be assigned to
Scroll Recipe Menu macros: two keys with step of 1 (-1) for “fine” scrolling and
two other keys with step greater than 1 for “fast” scrolling.
The Confirm Recipe Menu Selection macro accepts the selected parameter set
name and sets the current recipe parameter set to the new value.  It can be assigned
to a key together with Return To Initial Page macro to “close” the Recipe Menu
page and return to the page jumped from with the Go To Recipe Menu macro.

Figure 12-6
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12.7 - Recipes and the Interlock Mailbox

The Interlock Mailbox offers a powerful way to control the operation of Recipes
from the controller.  There are seven mailbox commands available to function with
Recipes:

- start Recipe download
- start Recipe upload
- Recipe status
- get parameter set number
- set parameter set number
- get Recipe transfer priority
- set Recipe transfer priority

The mailbox commands allow the choice of the Recipe page and also of the
parameter set.  All mailbox commands related to Recipes return a completion code
describing the results of the operation.  The mailbox interface to Recipes is
particularly useful if it is necessary to transfer a sequence of Recipes to and/or
from the panel.

Please refer to the chapter on the Interlock Mailbox for command specific
information.
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12.8 – Multipage Recipe Support

So far, UniOP has supported a straightforward recipe organization: while many
recipes could be defined in a UniOP Project, each one was limited to a single
project page.  Many users found this solution to be clear and easy to use and quite
sufficient for their application.

This chapter describes the Multipage Recipe organization introduced Designer 5.05
and supported by firmware version 4.20 and later.  In these versions of UniOP
firmware and Designer software, the ‘one page-one recipe’ restriction has been
removed.  Now, the data which is logically part of a single recipe can be scattered
over several project pages and still be selected, downloaded or uploaded with a
single command

A recipe spanning several pages is called “Multipage recipe”.

Multipage Organization

Currently, the user can define only one multipage recipe and as many standard,
single-page recipes as he/she wishes.  The multipage recipe can contain any number
of pages, even all pages in the Project.
This simple solution with just only one multipage recipe per project results in only
a minor change in Designer software use for the user.

Designer Configuration
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In order to enable Multiple Page Recipe feature in Designer software you should
define the desired number of single page recipes in your project and for each of
these pages you should check the “Multipage recipe” checkbox in the Recipe
Configuration dialog box as shown in Figure 12-7.

Figure 12-7

By marking the checkboxes, all multipage recipe pages are linked together and any
recipe-related action done in run-time (i.e. on the UniOP) on any linked page will
result in the same action being done for all the pages.  This refers to parameter set
selection, upload and download.

In other words, the set selection, the download and upload process can be done by
referring to each page contained in the multipage recipe.

You should respect the fact that in Designer, the definition of parameter sets
number and values for the multipage recipe is still done pagewise, as it was for
standard, single-page recipes.
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You should make sure to define an equal number of parameter sets in all pages
belonging to the multipage recipe, otherwise the upload and download of the recipe
may be aborted in the middle.  In addition you have to make sure that the variables
on the pages of the multipage recipe are different. Otherwise, you could have
problems in data integrity during download and upload operations.
For any recipe page not contained in the multipage recipe, the user should simply
leave the checkbox unchecked, as it is by default.  In all pages belonging to the
multipage recipe, the checkbox must be checked.

Menu Recipe Feature in Multipage Recipe

Of course, the Recipe Menu features are enabled on multipage recipe and you can
manage it with the menu in the same way as single page recipes.

You should make sure that the recipe name is defined in only one page of the
multipage recipe.  If you want to display names in the recipe menu for the
multipage recipe the Recipe Page for Selection field must refers to the page that
contains the ASCII field declared as “Recipe Name”.
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Chapter 13 - The UniNET Network

13.1 - UniNET Network Overview

The UniNET Network is a feature of the operator panels that enables them to be
connected together in a network and to communicate with each other.  It is now
possible to connect two or more panels (the maximum number is 32) with a simple
RS-232, RS-422, or RS-485 connection.  This offers the ability of displaying on
one panel either the data from the controller attached to the panel itself, or data
from other controllers attached to other panels on the network.

Symbols Used

The following are descriptions of the symbols used in this section.

Bus Terminal and RS-232 to RS-485 converter without termination
resistor

Bus Terminal and RS-232 to RS-485 converter with termination resistor

Bus terminal with termination resistor

Bus terminal without termination resistor

Network cable
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Clients and Servers

The operator panels attached to the UniNET Network can be classified in two
categories, depending on the type of communication that they can support once they
are placed in the network:  Server type panels and Client type panels

• A panel is a Server when it is connected directly to a controller.  It makes
available to other panels in the network the data in the controller to which it is
attached.

• A panel is a Client when it requests data from a controller attached to a Server
on the network.

Note:  MD00, MD01 and MD03 panels can only act as clients since they do not have a
PC/Printer port with the following exception:  When using the Aux port for
connection to the PLC (as in a bus network), these panels can act as a server in
the UniNET network.

A panel can be, in certain cases, both a Server and a Client.  This means that the
panel both satisfies the requests from other panels that require access to the data in
the controller to which it is attached, and also requests data from the controllers
attached to other Servers.

• The configuration shown in Figure 13-1 allows many panels to access data from
a single controller via a panel acting as the single Server.  The client panels can
perform all of the normal operations as if they were connected directly to the
controller, including:  displaying of variables, modifying of variables, handling of
Recipes, handling of the Reserved Data Area, etc.
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PLC

Panel 1 Panel 2 Panel 3
(Client) (Client)(Server)

Figure 13-1

• Figure 13-2 shows a configuration in which many controllers are accessed.
The panels that are connected to a controller can function both as Servers and
Clients.  Therefore, they can read data from the controller to which they are
directly attached and also from the controllers attached to other Servers.  The
Client panel can also read data from the controllers attached to the Servers.  In
this way, every single panel in the network has access to every single controller
attached to the Servers in the network.

PLC

Panel 1 Panel 2 Panel 3 Panel 4
(Server) (Server) (Client)(Server)

PLC PLC

Figure 13-2



The UniNET Network

13-4

Note: An external RS-232 to RS-485 converter is required for each panel used
as a Server. This is because Servers must be connected to the network
using their PC/Printer port which, in the current hardware version, only
has an RS-232 interface.  The Client panels do not need an external
converter to be attached to the UniNET network because they can be
attached to the network using their PLC port which has an RS-485
interface as well as an RS-232 interface.

The TSI01 Bus Terminal and Converter provides additional optical
isolation between the panel and the UniNET network.  If you are using
a Client panel attached to the network through a simple TSI02 Bus
Terminal, there is no optical isolation.  Optical isolation is
recommended whenever panels are to be operated in a noisy
environment or powered by different power sources.  A completely
optically isolated network can be obtained  using a TSI01 Bus Terminal
and Converter for each panel attached to the network.

Network With Different Controller Types

The network configuration shown in Figure 13-2 works even if the controllers are
of different model types or if they are of different manufacturer brands.  Designer
allows the user to specify the addresses of the data items added to the project file
using controller-specific addressing.

It is also possible to transfer data from one controller to another using the 'Data
Transfer' feature supported by the operator panels.  The transfer of data can be
performed even if the controllers are of different manufacturer brands.  The
panels act as bridges connecting different controller worlds.
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Technical Data

The main technical features of the UniNET Network are shown in the table below:

Maximum speed: 19200 baud
Physical interface: RS-485 Half Duplex
Connection cable: Shielded twisted pair
Maximum length: 1200 m
Access control: Token passing
Maximum number
of stations: 32

One of the main benefits of the token passing method is that every station on the
network gets the chance to communicate, even in conditions of heavy
communication load.

13.2 - Network Configuration

The UniNET network can be configured using Designer.  The configuration entails
specifying the number of Clients and the number of Servers on the network,
amongst other things.  The following sections describe the steps that need to be
taken to configure the UniNET network.

The Configure Network Option

By selecting Configure Network from the Options menu, the network configuration
required by the application can be initially defined or subsequently modified.  The
Network Type Selection dialog box, shown in Figure 13-3, will be displayed.
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Figure 13-3

This dialog box allows the choice between the three main network configurations
supported by UniNET:

• Single Server, multiple Clients
• Multiple Servers, multiple Clients (same controller types)
• Multiple Servers, multiple Clients (different controller types)

In the first case, Designer will ask the user to enter the number of Clients to be
included in the network and then choose the optimal default values for all of the
network configuration parameters.

In the second case, Designer will ask the user to enter both the number of Servers
and the number of Clients to be included in the network and will then choose the
optimal default values for all of the network configuration parameters.
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The third case is the most advanced option.  With this type of network, the user has
complete control over the network to be configured.  This allows the user to make
full use of the powerful capabilities of the UniNET network such as adding
multiple Servers for different controller manufacturer brands.  This complete
control over the network is gained at the expense of having to explicitly specify all
of the configuration parameters for the network.

The parameters for the network are automatically configured if it is selected to be
of either the Single Server, Multiple Client  type or of the Multiple Server, Multiple
Client (same controller types) type.  However, Designer allows the user to make
slight modifications to the network parameters, by using the Network
Configuration dialog box shown in Figure 13-4.  This dialog box is invoked by
again selecting Configure Network from the Options menu.

Similarly when the Multiple Servers, Multiple Clients (different controller types)
option is selected, the Designer will automatically display the Network
Configuration dialog box to allow the user to explicitly enter all of the parameters
for the required network.
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Figure 13-4

The main elements of the Network Configuration dialog box are as follows:

Maximum Node Number:  This specifies the node number of the highest node that
will be allowed to receive the network token.  Nodes that have a node number
higher than this value will not be able to communicate over the network.  The
Maximum Node Number should be set as low as possible to minimize the amount
of time that will be required for the token rotation.
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Panel Node:  Node number of the node being selected for configuration.  It must be
a number greater than 0 and smaller or equal to the Maximum Node Number.

Printout Node:  Node number of the node to be used for the network printout
function.  This feature is currently not available.

Comm Port for Network:  Selection of the Communications port to be used for
attaching the panel to the UniNET network.  The Server panels MUST be
configured to use the Printer port; the Client panels should be configured to use the
PLC port.  Currently the hardware does not support the Network port; so this
option is disabled.

Num Comm Retries:  Number of times a network message is retried in case of
communication errors.

Comm Time Out:  Value of the time out interval used in the network
communication.

Panel Type - Network Server/Client:  List of communication protocols available
for the network configuration.  During the configuration process all the Client
panels must be assigned the 'Network Client'  protocol, all the Server panels must
be assigned the protocol of the controller they are directly attached to.  This list
becomes active only when a valid node number is entered in the Panel Node field.

Configured Nodes:  List of the already configured network nodes.  Each node in
the list is described by its node number, controller protocol and version numbers of
protocol and Designer DLL.  Client panels are identified by the 'Network Client'
protocol.

Add/Modify:  Click this button to add a new node to the list of configured nodes or
to modify the parameters of an existing node.  To modify an existing node you must
first select the required node from the list of already configured nodes.  The
parameters for the configured node will then be displayed.  When the data has been
modified as required, pressing Add/Modify will make the changes permanent.
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Delete:  Click this button to remove an already configured node from the list of
configured nodes.  To delete a node from the list you must first select the required
node from the list of already configured nodes.

Net Comm:  Pressing this button displays the dialog box for the configuration of
the communication parameters for the UniNET network.  In the current version,
communication speeds up to 19200 baud are supported.  To obtain the best results
the highest baud rate possible should be used.

Import:  Any UniNET network configuration may be saved to disk for later use or
for sharing it between multiple project files designed for the same network.  Click
on the Import button to load an existing configuration from disk.  The UniNET
network configuration files have extension .NET.

Export:  Click on this button to save the existing network configuration to a disk
file.  The network configuration may the be loaded from disk with the Import
button.  The UniNET network configuration files have extension .NET.

The Panel Setup Dialog Box

Once a network configuration has been defined, you must assign a valid network
node to the current project file.  The Panel Setup dialog box includes the checkbox
Enable UniNET Network.  If the network is enabled, checking this checkbox will
cause the dialog box to unfold to show the current list of all configured UniNET
nodes.  To assign a node number to the current project just select one item from the
list.
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Figure 13-5
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The Data Field Definition Dialog Box

When designing a project for a network application, the Data Field Definition
dialog box is used to specify the addresses of the required data items in the same
way as for non-network projects.  The only difference is that if the network
contains more than one Server, it becomes necessary not only to specify the address
of the controller data item, but also to specify which controller the data item is to be
read from.  This is specified by first selecting the node number of the panel that is
attached to the controller that contains the required data item.  The Data Field
Definition dialog box, specific to the controller type, is used to specify the address
of the data item within the controller.  Depending on the type of network
configuration selected, the Designer will operate as described below:

• Single Server, multiple Clients

In this configuration, data can only be read from a single controller (the one
that is attached to the single Server).  In this case, there is no need for
Designer to prompt the user for the node number of the Server, as there is
only one.  Therefore, there is no need to specify any additional addressing
information.

• Multiple Servers, multiple Clients (same controller type):

In this configuration, data can be read from more than one controller.
Therefore, it is necessary for Designer to prompt the user for the node
number of the required panel before allowing the user to enter the address of
the data item.  Before showing the Data Field Definition dialog box,
Designer will display the Node Selection dialog box, which will display the
list of available Servers.  The user can select the required panel from this list.
Doing so will then cause the Data Field Definition dialog box for that node
to be displayed.  Since the controllers connected to the servers are all of the
same type, the same Data Field Definition dialog box will be shown
regardless of the panel selected in the Node Selection dialog box.
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• Multiple Servers, multiple Clients (mixed controller types):

In this configuration, data can be read from more than one controller.
Therefore it is necessary for Designer to prompt the user for the node number
of the required panel before allowing the user to enter the address of the data
item.  Therefore, before showing the Data Field Definition dialog box,
Designer will display the Node Selection dialog box which will display the
list of available Servers.  The user can select the required panel from this list.
Doing so will then cause the Data Field Definition dialog box for that node
to be displayed.  Since the controllers connected to the Servers are of different
types, the Data Field Definition dialog box specific to the controller type of
the selected Server will be shown.

The Node Selection dialog box in the case of a mixed controller network
configuration is shown in Figure 13-6.

Figure 13-6
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13.3 - A Quick Start Example

Most of the features of the UniNET Network can be tried by using a very simple
configuration.  This section will describe the steps required to set up a UniNET
network composed of a single Server operator panel connected to a controller and
two Client operator panels which will access the controller data via the Server
through the network services.

Note:The complete system is composed of three operator panels; you will have to
create an individual project file for each of them.  All three project files
must include the same network configuration information in order to enable
the three panels to exchange information.  To ensure that the project files
contain the same network configuration information, you can define the
network configuration once in the first project file.  Save the network
configuration to disk by exporting the network configuration by selecting
Export in the Network Configuration dialog box.  When creating the other
two project files, you can then import the network configuration from disk
by selecting Import in the Network Configuration dialog box.

Setting Up the Network Configuration

1. Select New from the File menu to clean up the workspace.
2. Select the Change Controller Driver from the Project menu and choose the

controller type required for the Server.
3. Select the Configure Network from the Options menu.
4. Choose the first option Single Server, Multiple Clients by clicking on the

topmost button and then selecting OK.
5. When the dialog box Number of Clients/Servers is shown, enter 2 for the

number of Clients and click OK to configure a network with one Server and
two Clients.

The network configuration is now completed.  Designer will automatically assign
default values to node numbers and to all of the other network parameters.
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Creating the Project File for the Server

6. Select Panel Setup from the Project menu.
7. Click on the Enable UniNET Network checkbox.  The dialog box will unfold

and show the network configuration with the list of existing nodes.
8. Choose the node number 1 corresponding to the Server panel.
9. Create the first page of the application with some text and one data field with

the Read/Write option enabled.
10. Connect the computer to the operator panel that is designated as the Server

and download the project.  When the transfer is complete, detach the cable
from the PC/Printer port of the panel and connect the RS-232/RS-485
converter.

Creating the Project File for the First Client

11. Repeat steps 1 through 5.
12. Select Panel Setup from the Project menu.
13. Click on the Enable UniNET Network checkbox.  The dialog box will unfold

and show the network configuration with the list of existing nodes.
14. Choose the node number 2 corresponding to the first client panel.
15. Create the first page of the application with some text and one data field with

the Read/Write option enabled.
16. Connect the computer to the operator panel that is designated as the first

Client and download the project.  The panel must be attached to the network
through its PLC port.

Creating the Project File for the Second Client

17. Repeat steps 1 through 5.
18. Select Panel Setup from the Project menu.
19. Click on the Enable UniNET Network checkbox.  The dialog box will unfold

and show the network configuration with the list of existing nodes.
20. Choose the node number 3 corresponding to the second Client panel.
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21. Create the first page of the application with some text and one data field with
the Read/Write option enabled.

22. Connect the computer to the operator panel that is designated as the second
Client and download the project.  The panel must be attached to the network
through its PLC port.

Running the Network

Once all three panels are in Operation Mode, they should display the variable on
the screen.  In the case of the Client panels, the variable is read from the controller
after the Server receives a request from the Client to read the data.

23. Verify that all three panels do not report any communication error.
24. The variable itself may be modified using the Data Entry Mode.  A change in

the value of the data entered from any operator panel, will quickly be shown
by the other panels.
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13.4 - Advanced Network Programming

Handling the Reserved Data Area

The UniNET network fully supports the use of all of the panel Reserved Data
Areas (RDA), including Alarms and Mailboxes.  These Reserved Data Areas can
be placed in any controller attached to any Server on the network.  This is
especially interesting since the RDA concept offers a simple and efficient method to
have the controller program interact with the operator panel.  Note, however, that
since most RDA activities are carried out on a cyclical basis, even with a small
number of nodes in the network, the result may be that most of the network traffic
will be for the RDA updates.  This may cause an exceedingly slow update time for
the displayed variables.

Network and Recipes

Recipes may also be used in a UniNET network system.  A single Recipe may
contain data items for different controllers attached to different Servers on the
network.

The following considerations should, however, be taken into account:

• Recipe transfers may be considerably slower when they contain data items for
controllers attached to other Servers in the network than when they only contain
data items for the controller attached directly to the operator panel.

• The panels in the network can be configured so that they each store copies of
the same Recipe parameter set.  In this case, special care must be taken to
ensure the consistency of the parameter sets stored in the different nodes.  It is
recommended that in a network configuration, only one node be assigned for
the storage of the Recipe data.



The UniNET Network

13-18

13.5 - Connecting Operator Panels to the Network

Pinout for the PLC Communications Port

The PLC Communications port is used to connect Client panels to the network
using a bus terminal unit.  The pinout of the PLC port is shown here for easy
reference.

Note: Panels to be used as Servers must have a dedicated PC/Printer port.

Pin # Description Pin # Description
1 Frame Ground 9
2 RXD 10 RTS
3 TXD 11 CTS
4 +5V 12
5 Signal Ground 13
6 CHA- 14 CHA+
7 CHB- 15 CHB+
8

Table 13-1
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Pinout for the PC/Printer Communications Port

Use the PC/Printer Communications port to connect Server panels to the network
using a bus terminal unit with an RS-232 to RS-485 converter.  The pinout of the
Printer port is shown in Table 13-2 for easy reference.

Pin # Description Pin # Description
1 Frame Ground 9
2 RXD 10 RTS
3 TXD 11 CTS
4 +5V 12
5 Signal Ground 13
6 14
7 15
8

Table 13-2

The TSI01 Bus Terminal with RS-232 to RS-485 Converter

The TSI01 Bus Terminal is a special module designed for use in the UniNET
network.  It is an optically isolated RS-232 to RS-485 converter that can be directly
connected to the Printer port of an operator panel.  The power supply is derived
from the panel connector; an on-board isolated DC/DC converter provides the
power for the RS-485 section of the converter.  The converter additionally provides
the possibility of properly terminating the line with a simple switch.

The pinout of the RS-232 connector of the converter is shown in Table 13-3.  The
connector type is D-type 15 pin male.
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Pin # Description Pin # Description
1 Frame Ground 9
2 TXD 10 CTS
3 RXD 11
4 +5V external 12
5 Signal Ground 13
6 14
7 15
8

Table 13-3

The pinout of the RS-485 terminal block of the converter is shown in Table 13-4.

Pin # Description
1 Frame Ground
2 A (-)
3 B (+)
4 Shield

Table 13-4
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The TSI02 Bus Terminal

The TSI02 Bus Terminal is a special module designed for use in the UniNET
network.  The use of the TSI02 Bus terminal makes it easier to wire a panel to the
network and additionally provides the possibility of properly terminating the line by
means of a switch.  The TSI02 has been designed for connection to the PLC port of
an operator panel equipped with RS-485 interface.

The pinout of the RS-485 connector of the converter is shown in Table 13-5.  The
connector type is D-type 15 pin female.

Pin # Description Pin # Description
1 Frame Ground 9
2 10
3 11
4 12
5 Signal Ground 13
6 CHA- 14 CHA+
7 15
8

Table 13-5

The pinout of the RS-485 terminal block of the converter is shown in Table 13-6.

Pin # Description
1 Frame Ground
2 A (-)
3 B (+)
4 Shield

Table 13-6
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RS-232 Cable to TSI01 Bus Terminal with Converter (Printer port)

Use the cable CA74 to connect the Printer port of a Server panel to the TSI01 Bus
Terminal with converter.  The maximum length of the cable is 12m.

Figure 13-7

Panel connector: D-type 15P
TSI02 connector: D-type 15S

RS-232 Cable to TSI01 Bus Terminal with Converter (PLC port)

Use the cable CA73 to connect the PLC port of a Client panel to the TSI01 Bus
Terminal with converter.  The maximum length of the cable is 12m.

Figure 13-8

Panel connector: D-type 15S
TSI01 connector: D-type 15S



The UniNET Network

Exor Electronic R&D                                                           13-
23

RS-485 Cable to TSI02 Bus Terminal

Use the cable CA75 to connect the PLC port of a Client panel to the TSI02 Bus
Terminal.  The maximum length of the cable is 1 m.

Figure 13-9

Panel connector: D-type 15S
TSI02 connector: D-type 15P

Installing the Network Cable

The UniNET communication cable consists of a number of cable segments daisy
chained together connecting all the network nodes.  The total length of the cable
segments cannot exceed 1200 m.  It is recommended to use a shielded cable with
one twisted pair.

Note: Only a daisy-chained network is recommended. For example a star-like
connection is not recommended.

The Bus Terminals at both ends of the networks must have the termination
resistance connected with the switch.  This connects the termination impedance
(120 Ohms) that is built in each Bus Terminal.  Intermediate Bus Terminals must
not have the termination connected.
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13.6 - UniNET Technical Description

The UniNET network has been designed to pass information between operator
interface panels operating on the plant floor.

The UniNET network features are the following:
• interconnection of up to 32 operator panels
• multi-master capability
• token-passing capability
• maximum network length of 1200 m

All operator panels connected to the network may initiate a message transfer.  The
network protocol uses a token passing algorithm to determine which initiator has
the right to transmit.  A node holding the token is allowed only one transmission
each time it receives the token.  After a node sends one message packet, it attempts
to give the token to its successor by sending a 'token pass' message.  If no network
activity occurs, the initiator will attempt to find a new successor.
The maximum node address that the initiator will search before wrapping to zero is
the value of the configurable parameter Maximum Node Number (see the Network
Configuration dialog box).
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Chapter 14 - TouchScreen Programming

14.1 - Introduction

The method for creating touchcells has been improved tremendously.  There is now
a floating toolbar for creating touchcells.  This toolbar is shown below in Figure
14-1.

Figure 14-1

Below is an explanation of each key in the toolbar and it’s functionality:

Used for selecting and resizing an object

Used for creating a touchcell as an ASCII character

Used for creating a touchcell as an illuminated pushbutton

Used for creating an indicator lamp

  Used for creating a touchcell as a panel key (i.e., F1, ENTER, -->)

Used for creating a touchcell as a pushbutton

Used for creating a touchcell as a 2, 3 or 4 position selector switch

Generic command button used for creating a touchcell as a panel key (i.e.,
ENTER, -->), macro command (i.e., show alarm list), or ASCII character.
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14.2 - A Note on Touchscreen Projects

To aid in programming, whenever a user touches a read/write numeric field, a
keypad will appear, allowing the user to enter data.

In order to use the features described in this chapter, the operator interface panel
being used must contain firmware version 4.20 or greater.

If a user attempts to create a touchcell in a project file that was created using a
previous version of Designer, they will be asked if they wish to transform their old
touchcells into the new format that is used.

If the panel being used doesn’t have firmware version 4.20 or greater, select No.
The user will then be able to create touchcells using the methods implemented in
previous versions of Designer for Windows (see section 14-12,  Alternative
Touchcell Creation).

If the panel being used does contain firmware version 4.20 or greater, select Yes.
Doing so will transform the touchcells into the new format.

Data Entry Page for Touchscreens

The default data entry page in all touchscreen UniOP panels now includes the
display of the minimum and maximum value associated with the field under data
entry.  Note that if the user tries to define their own custom data entry page, the min
and max values will no longer be displayed.  This feature requires firmware version
4.20 or greater.
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14.3 - The Display Window

The display window is a preview window that will appear whenever the user begins
defining a touchcell.  This window allows the user to see how the touchcell will
look before it is actually created and placed into a project file.

Clicking the left mouse button on the touchcell in the preview window will simulate
pressing the touchcell.  Clicking the right mouse button in the preview window will
simulate the indicator light or the light on the illuminated touchcell changing state.

14.4 - The TouchScreen Menu

The TouchScreen menu will appear whenever the user has selected a touchscreen
panel in the Designer software.  The menu items include:

Show Touchscreen Grid – This will show the grid in which touchcells can be
created.  Touchcells can be made as small as a single character and as large as the
entire screen.

Show Touchscreen Cells – This feature gives the user the ability to view or not to
view the touchcells in the project file.  If this item is selected, the user will be able
to see the touchcells as they will appear on the panel.  If this item is not selected,
the user will not be able to see the touchcells in the project file.  Note:  Whenever
the project file is downloaded, all touchcells will be visible on the operator interface
panel.

Show Toolbox – This selection allows the user to toggle the Toolbox on and off.
The Toolbox is a floating toolbar that is used to create various types of touchcells
and indicators.  In order for the user to create touchcells, this item must be
selected.
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Delete All Touchcells – This allows the user to delete all of the touchcells and
associated graphics and commands on the current page of the project file.

Select Touch Font – This allows the user to select the font to be used for a
particular touchcell.  Once a font is selected, it will continue to be used for all
touchcells that are subsequently created.  This font is NOT a global font and may
be changed at any time without affecting any of the previously created touchcells.

14.5 - Creating a Touchcell as a Panel Key

To create a touchcell as a panel key, select the area where the touchcell is to be
located and click on the Panel Key icon in the Toolbox.  Doing so will bring up the
dialog box shown in Figure 14-2.

Figure 14-2
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Within the General index tab, the user can specify how the touchcell is to look by
selecting one of the radio buttons within the Looks area of the dialog box.

By clicking on the Select panel key … button, the user will be able to select the
panel key that the touchcell is to represent.  The key that is selected will be
highlighted so that is appears as a different shade from the other keys.  To access
keys other than F1 through F8, click on the right arrow located on the slide bar
underneath the function keys.

Figure 14-3

Clicking on the Text and Colors index tab, will display the dialog box shown in
Figure 14-4.
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Figure 14-4

Legend allows the user to specify the text that is placed either on or on top of the
touchcell.  The position can be selected by choosing either the Top or Center radio
button within the Legend position section of the dialog box.

On shows the color that the touchcell will be when it is pressed, while Off indicates
the color that the touchcell will be when it is in the not-pressed state.  Background
color is the color of the touchcell background.  The touchcell background is a part
of the rectangle around the circular or elliptical touchcell not covered by the cell.
Rectangular touchcells have no background if the touchcell text is centered, but if it
is positioned on top, a strip of background appears above the cell.

Fg indicates the color of the touchcell text.  Bg indicates the background color of
the touchcell text.  This color will only be seen when the Transparent checkbox is
not marked, otherwise the background of the touchcell text will appear either in On
or in Off color for centered text and in the Background color if the text is on top.
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Clicking on the Select Font … button will allow the user to select the font for the
touchcell.  This is shown in Figure 14-5.  Keep in mind that this is NOT a global
setting.  It is possible to use different fonts on all of the touchcells in a single
project file.

Figure 14-5

Within the General index tab, if Custom is selected within the Looks portion of the
dialog box, the user will be able to import bitmap graphics for the different states
of the touchcell.  For example, if Custom were selected in this example, the Custom
index tab would appear as is shown in Figure 14-6.
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Figure 14-6

The graphic to be imported can be loaded from disk or from the Graphics Library
that is installed with the Designer software.

To import a graphic from disk, perform the following steps:

• Click on the External radio button within the Image source portion of the
dialog box.

• Click on the Load image … button.
• Select the path and the filename of the bitmap graphic that you wish to import.
• This will bring up a dialog box that will allow the user to specify the label that

is associated with the graphic (which defaults to the filename without the
extension) and whether or not to reverse the image.
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To import a graphic from the Graphics Library, perform the following steps:

• Click on the Library button within the Image source portion of the dialog box.
• Click on the Load image … button.
• This will bring up a dialog box in which the user can choose to use a graphic

from the Graphics Library or a graphic that is already used elsewhere in the
project file.  To use a graphic from the Graphics Library, select the External
radio button within the Library source portion of the dialog box.  To use a
graphic that is used in the current project file, select the Current Project radio
button.

• Click on the name of the graphic that is to be used (a preview of the graphic
that is selected will be shown) and click on the Import button.

• Another dialog box will appear that allows the user to specify the label that is
associated with the graphic (which defaults to the filename without the
extension) and whether or not to reverse the image.
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14.6 - Creating a Touchcell as an ASCII Character

To create a touchcell as an ASCII character, select the area where the touchcell is
to be located and click on the ASCII Character icon in the Toolbox.  Doing so will
bring up the dialog box shown in Figure 14-7.

Figure 14-7

The user can specify how the touchcell appears by selecting one of the radio
buttons the Looks portion of the General index tab.  The ASCII character that is to
be transmitted when the touchcell is pressed can be entered in the Type character
box.

The legend and colors of the touchcell can be specified within the Text and Colors
index tab.  Custom images can be imported by selecting the Custom radio button
within the General index tab and then selecting the Custom index tab.
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14.7 - Creating a Touchcell as a Pushbutton

To create a touchcell as a pushbutton, select the area where the touchcell is to be
located and click on the Pushbutton icon in the Toolbox.  Doing so will bring up
the dialog box shown in Figure 14-8.

Figure 14-8

The appearance of the pushbutton can be chosen by selecting a radio button from
the Looks portion of the General index tab.  The action of the pushbutton can be
selected by picking a radio button from within the Behavior portion of the General
index tab.

The legend and colors of the pushbutton can be specified within the Text and
Colors index tab.  Custom images can be imported by selecting the Custom radio
button within the General index tab and then selecting the Custom index tab.

The memory location that the pushbutton affects can be set up by selecting the
Reference index tab and clicking on the Button reference … button.  This will bring
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up the dialog box shown in Figure 14-9, which allows the user to select the exact
memory location to be written to.  This dialog box will contain the data types that
are present in the PLC being used.

Figure 14-9

14.8 - Creating a Touchcell as an Illuminated Pushbutton

To create a touchcell as an illuminated pushbutton, select the area where the
touchcell is to be located and click on the Illuminated Pushbutton icon in the
Toolbox.  Doing so will bring up a dialog box exactly like the one shown in Figure
14-8.

The only difference between an illuminated pushbutton and a pushbutton is that the
face of the illuminated pushbutton can reflect the status of a bit in the PLC.  The
memory location whose status is shown on the face of the button can be specified
by selecting the Reference index tab and clicking on the Light reference button.
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14.9 - Creating a Touchcell as a Selector Switch

To create a selector switch of N states (where N represents an integer from 2
through 4), the user must select an area that is N characters wide, or some integer
multiple of N characters and then click on the Selector Switch icon in the Toolbox.

For example, if the user wishes to create a 3 position selector switch, the selected
area must be either 3, 6, 9, 12 … characters wide.

Once the user clicks on the Selector Switch icon, the dialog box shown in Figure
14-10 will appear.

Figure 14-10

From within this dialog box, the user can specify the looks of the selector switch, as
well as the number of states.
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By selecting the Text and Colors index tab, the user can define the legend for each
state of the touchcell, as well as the color scheme for each state (in other words,
each state of the selector switch can have a different color), which is shown in
Figure 14-11.

Figure 14-11

Likewise, by selecting the Reference index tab, the user can configure what
memory location in the controller is affected by each state of the selector switch.
This is depicted in Figure 14-12.
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Figure 14-12

14.10 - Creating an Indicator Light

To create a touchcell as an indicator light, select the area where the touchcell is to
be located and click on the Indicator Light icon in the Toolbox.  Doing so will
bring up the dialog box shown in Figure 14-13.
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Figure 14-13

The legend and colors of the indicator light can be specified within the Text and
Colors index tab.  Note that the indicator light can be configured to handle up
to 4 different states.  A different color can be assigned to each state in order to
reflect the contents of the memory location in the controller.  The memory location
in the controller that the indicator light is to reflect can be specified within the
Reference index tab.
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14.11 - Creating a Touchcell as a Generic Command

To create a touchcell as a generic command, select an area for the touchcell and
then click on the Generic Command icon in the Toolbox.  This will bring up the
dialog box that is shown in Figure 14-14.

Figure 14-14

The looks of the touchcell are defined exactly as they were before.  To define the
functionality of the touchcell, select one of the three radio buttons within the
Functionality portion of the dialog box and click on the Configure function …
button.

Depending on the functionality selection, the user will get either a list of panel keys
to choose from or the list of macro commands available.  If ASCII key is chosen,
the user simply needs to enter the character to be sent in the box beside of the
ASCII key radio button.



TouchScreen Programming

14-18

The legend and colors of the pushbutton can be specified within the Text and
Colors index tab.
An LED indicator can be added to a touchcell if, within the Looks portion of the
General index tab, Windows, Windows + Custom, or Custom is selected.  If this is
the case, the Reference index tab will appear as is shown in Figure 14-15.

Figure 14-15

By marking the Attach to controller reference box, the user will be able to click on
the Button reference … button.  This will allow the user to specify a bit in the
controller whose status will be reflected by the LED on the touchcell.
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14.12 – Multilanguage with Touchcells

With Designer version 5.05 and later, and firmware version 4.20 and later, it is
possible to integrate multiple languages within the same touchcell.  Whenever a
user defines a touchcell in a project file that has more than language created, an
additional button will be present in the Text and Colors index tab called Change
Language.  Clicking on this button will bring up the Language floating toolbar
which allows the user to choose the language that they wish to work in.  The user
may specify the text for the touchcell in each language that is used in the project
file.  See the chapter on Multilanguage for more information about multiple
languages within a single project file.

14.13 – Alternative Touchcell Creation

If the operator interface panel does not contain firmware version 4.20 or later, the
user will need to create touchcells using methods implemented in previous versions
of the Designer for Windows programming software.

To do this, the user will need to select the Generic Command icon in the floating
toolbar.  Doing so will display the dialog box shown in Figure 14-16.
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Figure 14-16

Each of the sections of the dialog box are explained on the following pages.
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Cell Functionality

A touchcell may be configured as a panel key, an alphabetic character, or a macro
command.

• Panel keys represent all of the function keys, numeric keys, and arrow keys, as
well as the help key, the clear key, the enter key, the +/- key, and the decimal
point key.

• Alphabetic characters represent all of the upper case and lower case letters.  This
allows the user to enter alphanumeric characters in Data Entry Mode.

• Macro commands represent all of the elementary macro commands that are
available from the Keyboard Macro Editor.
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Press Indicator

The different radio buttons within this group box represent the attribute that the
touchcell will have whenever it is pressed.  Note that the press indicator can be used
with touchcells that have graphics associated with them; however, attributes can
best be seen on touchcells that are not associated with graphics.

• None - There will be no attribute associated with the touchcell when it is pressed
and the user will not be able to tell when the key has been pressed.
Therefore, this option should be used only when there are graphics
associated with a touchcell.

• Reverse - A touchcell having this attribute will have its colors inverted upon being
pressed.  For example, if the touchcell has a black border with black
text and a light background when it is not pressed, it will have a white
border with white text and a dark background when it is pressed (see
the screen capture shown below).

   

 Not Pressed         Pressed
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      Figure 14-17

• Highlight - With this attribute, the touchcell will toggle between two 
 appearances when it is pressed.  These appearances are a 
 combination of the reverse attribute and the blink attribute.

• Blink - When the touchcell is pressed, it will alternate between the appearance of
a normal touchcell and a blank screen.

Select Cell Graphics

The user has the capability of implementing graphics with their touchcells.  The
different possible choices are:
•  No graphics, no character borders
•  No graphics, character borders
•  3D graphics + user defined legend text
•  3D graphics + user defined face image
•  User defined
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The first option, no graphics, no character borders will create a touchcell that is
entirely invisible.  An example of the functionality of this feature is as follows.  A
user may have a graphic that encompasses the entire screen.  For descriptive
purposes, let’s say that this graphic represents a control process in a factory.  It

contains images of flow control valves, motors, and blowers.  By using this option,
the user can create touchcells on the separate images and configure them to perform
certain tasks.  For instance, if the user presses the touchcell that is on the image of
the motor, the motor may turn on.  If the user presses the touchcell that is on the
image of a valve, the valve may close, etc.  All that will be seen on the screen will
be the image of the process; the touchcells will be invisible.

If no graphics, character borders is chosen, a touchcell will be created that is
visible only by the border that surrounds it’s outer limits.  The user can choose
between two borders, which are shown in the screen capture below.

Figure 14-18

Choosing 3D borders + user defined legend text gives the user the ability to
implement a touchcell with text and 3D borders.  The 3D border will give the
touchcell the appearance that it is moving into the panel when it is pressed.  This
allows the cell to appear that it is three dimensional (having height, width, and
depth) as opposed to being two dimensional (having only height and width).  The
text that appears on the face of the touchcell must be entered by the user.

Selecting 3D borders + user defined face image allows the user to specify the
image that appears on the face of the touchcell.  The 3D border will have the same
characteristics as the border that was discussed above in 3D borders + user
defined legend text.  The image that is selected will appear on the touchcell in both
the pressed and not pressed states.
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If User defined is chosen, the user can select the source of the graphic that is to be
used on the face of the touchcell.  This feature gives the user the ability to import
separate graphics for the pressed and not pressed states.  These graphics can be
imported either from an external file or from a library.
Types of Graphics

There are two different selections available from within the Types of graphics
group box.  The first, Attached to Controller, allows the user to attach the graphic
to a bit in the controller.  This option is available whenever the 3D borders + user
defined legend text radio button, 3D borders + User defined face image radio
button, or the User defined radio button is selected.  Whenever you use this option
with either of the 3D borders graphics options, an LED indicator will be present on
the graphic.  This indicator will be ‘on’ whenever the controller memory location
that the graphic is referenced to is in the on state (a value of 1 in the controller
memory location corresponds to the on state, while a value of 0 corresponds to the
off state).  The other selection, Not pressed state and Pressed state, is only
available when the User defined radio button is selected.  This allows the user to
select the image that is to be displayed on the face of the touchcell whenever the cell
is pressed, as well as when it is released.
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14.14 - Special Pages and Page Modes

The items located within the Special Pages and Page Modes portion of the Page
menu include Data Entry Screen, Command Menu, System, Passwords, Direct
Access, Direct Page Selection, Time & Date, Alarm Page, Event Page, and
Current Page Mode.  This option allows the user to place any combination of static
text and touchcells on these pages.  Note that these items should be placed on the
lower portions of the page, due to the fact that these modes reserve some of the area
contained in the upper portions of the page for display information.

Whenever the panel enters Password mode or Data Entry Mode, a default numeric
keypad will appear on the screen.  In all of the other modes, a row of default keys
will appear that contains the arrow keys, an ENTER key, and a CLEAR key.  If the
user wishes to create their own screen that contains static text and touchcells, they
may do so by selecting Special Pages and Page Modes from the Page menu.
Please be aware that a screen created in any of the panel’s special pages will
result in the default keys for that mode not being displayed.
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14.15 - Digital TouchScreen Menu

As was mentioned earlier, users with our digital touchscreens will have a different
set of menu options presented to them upon opening the TouchScreen menu.  The
two choices available are Show Touchscreen Grid and Show Key Assignments.
The touchcells can be programmed using the Keyboard Macro Editor.

Show Touchscreen Grid

Selecting this option will produce a grid on the screen which will assist the user in
programming the touchcells.  This allows the user to know the true boundaries of
each and every touchcell on the page.

Show Key Assignments

This option becomes available after the user has selected Show Touchscreen Grid.
Selecting this will show the key assignments for the panel (see Figure 14-19).  Note
that the touchcells are fixed in their location.  The HELP, CLEAR, and ENTER
keys are pre-defined and do not need to be configured.  This is also true for the
numeric keypad and the left and right ARROW keys.



TouchScreen Programming

14-28

Figure 14-19

The touchcells can be programmed using the Keyboard Macro Editor to perform a
vast array of functions, such as changing pages of the project file, scrolling down a
line, entering Data Entry Mode, and writing a value to the controller.
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Example

In this example, the user will configure a touchcell to write a value to the
controller.

1. Select Show Touchscreen Grid from the Touchscreen menu.  This will
present the user with a grid, which will be helpful when we are ready to
program the functionality of the touchcell.

2. Highlight the area in which the touchcell is to be located.  In this example,
let’s assume that if the user presses touchcell locations F21 or F22, the panel
will write a value to the controller.  In order for this to occur, we need to
click and drag the mouse to highlight the area encompassing cells F21 and
F22.

3. It is suggested to program the touchcells with a reversed attribute when
they are pressed.  In this manner, the operator will have immediate
feedback when the cell is pressed.  This can be done within the Keyboard
Macro Editor.  Since we have already highlighted the area in which we are
working with, we can enter the Keyboard Macro Editor by either clicking on
the proper icon in the Extra ToolBelt or by selecting Keyboard Macro
Editor from the Project menu.

4.  This will bring up the Keyboard Macro Editor dialog box.  Since we are
programming this cell for area F21 and F22, we need to program both of the
keys.  Let’s begin with F21.  Scroll through the keys at the top of the dialog
box until F21 is highlighted.

5. Click on the Pressed radio button and the select the Page n index tab.  This
will allow the touchcell to perform it’s assigned function only on this page in
the project.

6. Select the Attribute icon from within the Commands toolbar.  Select the
Reverse attribute.  Since we already highlighted the area in which this
attribute is to occur, the dimensions are set automatically.

7. It is necessary to set a small delay before turning off the attribute in order to
give the user time to see the attribute.  Click on the Wait icon and enter a 3
in the dialog box that will appear.  This will add a 3/10 second delay.
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8. Now we need to turn the attribute off.  This is done by selecting the Attribute
icon and unchecking all of the attribute options.

9. The next step that needs to be taken is to write the value to the controller.
Let’s assume that we want to write a value of 10.  Click on the Write to
Controller icon.  This will bring up a dialog box in which we can enter the
specific address within the controller that we want to write to.  Enter the
address and click on OK.  This will bring up a dialog box that allows us to
specify the value that is to be written.  Enter a 10 and select OK.

10. The macro screen should look as shown below in Figure 14-20.

Figure 14-20
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The same programming needs to be repeated for the F22 key.  Simply select the
F22 key and repeat steps 5 through 9.  Once this is finished, we can add some static
text or a rectangle to the area to let the operator know the functionality of the
touchcell.

Note:  Rectangles can be added by selecting Rectangles & Symbols from the Edit
menu.  This will bring up a dialog box (see Figure 14-21) in which the user
can simply select which one to use and press Exit.  Text can then be added
by simply moving the cursor inside the rectangle and entering the
information.

Figure 14-21

The result may resemble Figure 14-22 below.

Figure 14-22
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Chapter 15 – Multilanguage

15.1 - Introduction

This feature allows you to create a single project file that contains multiple
languages.  Your panel must contain version 4.10 or later to utilize this feature.
The language that the project file uses can be selected at run-time.  To set up your
languages, go to the Project menu and select Languages.  Doing so will bring up
the dialog box shown in Figure 15-1 in which you can define the languages that you
are going to be using.

Figure 15-1

You can use the Add… or Insert… buttons to add a new language.  When you do
this, it will give you the opportunity to name the language and the option to copy
the default language’s character set.  The Edit… button can be used to change the
name of a language.  The Remove button can be used to remove a language from
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the list and the Set Default button can be used to make the selected language the
default language for programming.
For example, assume you want to have a project file that contains text in English,
Italian, German, Spanish and French.  Your Languages dialog box may resemble
the one shown in Figure 15-2.

Figure 15-2

You will now be able to enter text in any of the languages listed in Figure 15-2.
Keep in mind that you will still be using the standard ASCII character set.  Also
note that Designer does not translate between languages.  In other words, if you
enter text in English and then select Spanish as the language, you will also have to
enter the text in Spanish.  To choose a language to work in, select Project-Select
Language.  This will bring up the dialog box that is shown in Figure 15-3.
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Figure 15-3

To select a language to work in, simply click on the language and then click on the
Select button.  The advantage of this feature is that it allows you to create a single
project file with multiple languages used.  For one application, you may need to use
the English language.  For another application, you may want to use the same
project file with the Spanish language.

For example, Figure 15-4 shows the project file used with the English language,
while Figure 15-5 shows the same project file used with the Spanish language.
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Figure 15-4
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Figure 15-5

In Designer version 5.05 and later, the cut/copy/paste commands work in the usual
way unless the ‘Multilanguage Mode’ in the Edit menu is set.  When working on
multilanguage projects, the default behavior of the cut/copy/paste commands is to
operate only on the language currently active.  If ‘Multilanguage Mode’ is set, the
commands operate on all the languages.

It is important to mention that multilanguage can also be used with the alarms and
message fields.
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15.2 - Changing the Language After Downloading

In order to change the language that the project file uses once it has been
downloaded to the UniOP, the user can create a control variable with a data type of
Language.  To create this control variable, three steps need to be performed:

•  Select Edit – Data Field Source – Panel Control Variable
•  Select Edit – Data Field Type – Numeric/ASCII

This will bring up the Control Variable field dialog box.  Then,

•  Underneath Data Type, select Language.  Make sure that this field is created as
read/write so that it can be edited.

To change the language that is being used, the user will need to increment or
decrement this field.  This can be done in one of two ways.  One way is to simply
edit the field and enter the number of the language that you want to use (in our
example above, English would have a value of 1, German would have a value of 2,
etc.).  The other way is to program a key or a touchcell using the macro command
Control Variable Step.  The user could program one key (or touchcell) to step up
the value of the language control variable field, and another key (or touchcell) to
step down the value of the language control variable field.
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Chapter 16 - Designer's Initialization Files

16.1 - DESIGNER.INI

DESIGNER.INI is used to store the latest configuration of the Designer software upon
exit.  Each time you start the Designer, this information is used to restore the page
editor workspace, panel setup, and communications parameters.

[Designer] Default startup values
ToolBelt 1=Show, 0=Hidden
ToolBelt1               1=Show, 0=Hidden
Statusbar 1=Show, 0=Hidden
ZoomSize Initial zoom just after startup, allowed values are: 1 - 5
GridMode 0=No grid, 1=Point grid, 2=Line grid
TargetLib Last controller library used
ApplPath1 Last project file opened
ApplPath2      Second most recent project file opened
ApplPath3 Third most recent project file opened

[Graphics Library]
ApplPath1 Where graphics files are located

[Communications]        (PC  to  UniOP)
CommPort 1=COM1, 2=COM2, 3=COM3, 4=COM4
BaudRate 300, 600, 1200, 2400, 4800, 9600, 19200, 38400
Parity None, Odd, Even
StopBit 1 or 2
DataBits 7 or 8

[Net Communications]
BaudRate 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600
Parity None, Odd, Even
StopBit 1 or 2
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DataBits 7 or 8

[Panel Setup] Default values for panel setup dialog
DisplayType Last display used
Font Last font used
InternalRam     Panel memory
DateFormat     MM/DD/YY or DD/MM/YY
TimeFormat 12:00:00 or 24:00:00
TouchUsed 0=Not used in last project, 1=Used in last project
LastTouch Touchscreen code

[Touch Font]
FaceName           Last touch font used
LFData           Various font characteristics

[PLC Communications]
BaudRate           300, 600, 1200, 2400, 4800, 9600, 19200
Parity           None, Odd, Even
StopBit           1 or 2    
DataBits                      7 or 8

[Panel Printer]
PrinterType TTY-printer
BaudRate 300, 600, 1200, 2400, 4800, 9600, 19200
Parity None, Odd, Even
DataBits 7 or 8
StopBit 1 or 2
PageWidth Number of characters printable across page
PageLength Number of printable rows per page
AutoLF 0=Off, 1=On
UseFFLF 0=Off, 1=On
Protocol 0=None, 1=XON/XOFF

[Look]
Look      0=Light Background, 1=Dark Background
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[Panel Capabilities]
1.2    Flags for creating ROM files
3.19    When creating ROM files with Designer, the user
3.99    should select the highest firmware version closest
4.2    to the one contained in their panel

[Modem Info]
Enable    0=No phone list or dialing menu present, 1=Present
LastCall    Last number dialed
DialPrefix    Modem dialing prefix
DialSuffix    Modem dialing suffix
Init    Modem initialization string
Hangup    Modem hangup string
DropDTROnHangup 0=No, 1=Yes
Connect    Modem connection message
NoConnect1    First non-connection message
NoConnect2    Second non-connection message
NoConnect3    Third non-connection message
NoConnect4    Fourth non-connection message

[Phone List]   Filled in when modem menu options are used

[IOModules]
NumModules Number of supported I/O modules

16.2 - DISPLAYS.INI

DISPLAYS.INI should NOT be altered.  Designer uses this file internally to initialize
various dialogs and other data.  DISPLAYS.INI will expand in the future as more
display models and features are added.  Contact your distributor for details.
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Chapter 17 - Documenting a Project

17.1 - Overview

Once a project has been completed, it may be documented by generating a printed
report.  With the desired project loaded into Designer, select Print from the File menu.
This will bring up the dialog box that is shown in Figure 17-1.

Figure 17-1

Select the desired report style by marking the respective checkbox.

Summary
Includes application setup parameters and page statistics.

Pages
Prints all page data, including a complete description of page text and data fields.
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Variables
Prints all the variables defined in the project.

Alarms
Prints a complete list of alarm messages defined in the project including the priority
level and alarm attributes.

Passwords
Prints a list of all passwords and privileges.

Macros
Prints a complete list of macros defined in the project.

All
Includes all the information contained in the options above.

•  It is recommended to print in Text mode.
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Chapter 18 - Application Notes

18.1 - Communication Optimization

When in Operation Mode, the panel cyclically updates all dynamic fields that are
displayed in the current page.  Generally, the panel will use a different communication
session to update each field.  This is because the user variables may be stored at
locations very far from each other.  Different communication sessions will be required
when different data types require specific communication messages.
It is however possible to use a single session communication message to update more
than one displayed field, provided that the controller addresses of all the data fields are
limited in a pre-defined range and are of the same type:

The general rule is as follows:
Max Address - Min Address <= 30 words

Due to the high overhead of some controller communication protocols, it may be
convenient to create an optimized message even for only two variables that are not
stored in contiguous addresses.

Example:  The Siemens AS511 protocol has an overhead of about 40 characters per
session, that is, if two bytes must be read from the  controller, the whole session will
require more that 40 characters exchanged between UniOP and the controller.   If
UniOP wants to read the word 0 and the word 14 in a data block, it will be still more
convenient to start a single session to read all words 0-14 (it will be 30 bytes in all)
and not to start two separate communication sessions.

•  Therefore, for best update times, it is an advantage to have displayed data on a
    page that is of the same type and close in address to each other.

Some data types for specific controllers cannot be optimized due
 to the characteristics of the controller communication protocol.
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18.2 - Allen Bradley

Connecting to SLC500

The panel is interfaced to SLC500 using either DH485 or DF1 protocols.  On some
models, you may connect either to the 9-pin programming port (DF1) using a CA12
cable or to the DH485 port with a CA25 cable.  Selection of DF1 or DH485 is made
under "Project - Change Controller Driver" in the Windows Designer configuration
software.  The communication protocol is embedded in the configuration software and
downloaded to the panel during the configuration stage.

Another way to connect to the SLC is via a AIC link coupler, useful in cases where
more than one panel is connected to a controller or when you want to put a display
panel on the DH485 network.  An additional advantage in using the AIC link coupler
is that you can monitor and program the SLC while the display is operating by
connecting the programming terminal to the peripheral port on the AIC.

For DH485 networks, UniOP is considered an initiator and acts as a unique node.
DF1 protocol is RS232 and used as a point to point connection.

DH485 communication can be made using a CA25 cable connected to the
programming port of the fixed I/O brick type (1747), 501, 502, and 503 processors.  If
it is desired to monitor / program the SLC while the UniOP is communicating, use an
Allen Bradley AIC Link coupler and connect the UniOP panel to the AIC on the screw
terminals using a CA29 cable.  The Allen Bradley programming software can then
connect to the J2 port on the AIC using a CA26 cable.

It is possible to connect more than one display panel to a network of controllers by
using an AIC link coupler.  Attach each panel to the AIC DH-485 Interface as shown
in Figure 18-1.
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Figure 18-1

Communication Parameters:

DH-485 DF1 channel setup
19200 Baud
Even parity
One stop bit

9600 Baud
Even parity
One stop bit
No handshaking
Remote mode change disabled
Duplication detection off
ACK time out = 100 ms
BCC check
NAK retries = 3
DF1 ENQs = 3

Table 18-1

The baud rate, parity, stop bits, and stop bits must be set to the same values in
Designer.  This can be accomplished by selecting Controller Setup from the

Project menu and clicking on the PLC Comm button.
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Slave ID’s and Nodes

Note that the Slave ID field is actually the node of the SLC.  Normally your SLC will
be node number one.  Panel Node is the node address of UniOP.

•  Set the panel node to the next consecutive node after the controller.

    Panel node = (PLC node + 1)

•  Max nodes for the panel should be equal to the panel node.

    Max nodes = Panel node

•  For best performance, PLC max nodes should be equal to the panel node.

    PLC Max nodes = Panel Node

Node Used by..
0 Programming Software
1 Controller
2 Panel 1
3 Panel 2

Table 18-2
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Logical Addressing

When addressing Allen Bradley I/O data, the panel uses logical addressing rather than
physical addressing.  Physical addressing refers to the element number as simply the
slot number.  Logical addressing, UniOP method, refers to the first element for the
first I/O card of a specific file type.

For example, consider a modular I/O system consisting of the CPU in slot 0, an output
card in slot one, an input card in slot 2, an input card in slot 3, and an output card in
slot 4.

The output card in slot 1 would be logically addressed as follows:
File Type: Discrete Output
File Number: 0
Element: 1

The output card in slot 4 would be logically addressed as follows:
File Type: Discrete Output
File Number: 0
Element: 2

The input card in slot 2 would be logically addressed as follows:
File Type: Discrete Input
File Number: 1
Element: 1

The input card in slot 3 would be logically addressed as follows:
File Type: Discrete Input
File Number: 1
Element: 2
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Testing Communications

To test the communication between the panel and the controller, make a simple project
file with one numeric field.  Reference this field to S4:0.  Keep in mind that all fields
must exist in the SLC.  If you try to read a file or element that does not exist, a
communications error will occur.

Once the project file has been downloaded to the panel, a value should appear on the
display.  Hold the ENTER key in for about four (4) seconds.  This will cause the panel
command menu to appear.  Select the SYSTEM option and press ENTER again.
Cursor down to the PLC field.  If all is well, the system will report COM ON.  If there
is a problem with communications, the system will report COM OFF or COMM
ERROR.

On the CP-series and MD-series panels, the LED will flash ON during a
communication error.  On all other panels, the LED will flash OFF.  Note that on all
panels that are not CP-series or MD-series, the LED will be ON even if the panel is
not attached to the controller.  This is because the panel is always transmitting trying
to attach to DH-485.  If you check the SYSTEM option from within the panel
command menu with the cable not connected to the controller, the status will be
reported as COMM OFF.
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Connecting to SLC5/04

The SLC5/04 DB9 connector supports 2 protocols on an RS-232 signal.  UniOP
panels are capable to utilize DH485 and DF1 Channel 0.  However, it is recommended
to use the DF1 protocol for the 504 processor.

Example using DF1 protocol
Access Multiple PLC: No
PLC Node: 1 (refer to PLC settings (source ID))
PLC Model: SLC500
Data Bits:  1
Stop Bits:  8

     Match Baud Rate, Parity with controller settings

Channel 0 Configuration
Current Communication Mode: System
System Mode Driver: DF1 Full Duplex
User Mode Driver: Generic ASCII
Write Protect: Disable
Mode Change: Disable
Mode Attention Character: \1B
System Mode Character: S
User Mode Character: U
Edit Resource File: 60
Pass-thru Lind ID: 2

Channel 0 System Mode Configuration
Baud Rate: 9600
Duplication Detect: Disable
Ack Time Out: 50
Source ID: 1
Control Line: No Handshaking
Parity: Even
Error Detection: BCC
Nak Retries: 3
Enq Retries: 3
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Embedded Response: Enable

Connecting to PLC 5

UniOP can be connected to a PLC 5 on channel zero using cable CA7 and the DF1
protocol.

Channel zero (RS232 Port) is included on models:
PLC5-11
PLC5-20
PLC5-40
PLC5-60

Other models that DO NOT have channel zero include:
PLC5-10
PLC5-15
PLC5-25

To connect to a PLC5-10, PLC5-15 or PLC5-25, you must use either:

A 1785-KE or 1770-KF2 module with DF1 protocol, or
A 1760-RB module with a defined protocol.

Connecting to Micrologix

When using a Micrologix PLC, the user cannot directly access timer presets and
counter presets with the Designer software.  The user can access these areas by simply
using a register instead of the preset and then using a ladder logic statement to move
the contents of the register into the memory location of the preset.
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18.3 - Simatic TI and Koyo

Koyo 205 Series

The Koyo DL240 has 2 ports that either can be connected to a UniOP panel using a
CA71 cable.

Connecting to TI 425/435 or Koyo 405 Series

The Simatic TI435 and the Koyo 405 series have two ports that can be used for
communication with UniOP.  The top port is  used for programming the PLC .  This
port uses a communications protocol called the "K" protocol.  The lower 25-pin port
on the PLC is the network port.  The network port uses a protocol called "N" protocol,
but it also supports the "K" protocol.  UniOP supports both of these protocols as
defined by a PLC model change in "Project - Controller Setup".  You may connect to
the network port on a TI435 with cable CA9 or CA7 and use the "N" protocol or the
"K" protocol.  Usage of the programming port requires that you use cable CA8 and the
"K" protocol only.  The TI425 does not have a network port and you must use cable
CA8 only.  On the series 305 PLC's connect to the DCU with cable CA7 or CA13
(depending on DCU model) and use the "N" protocol only.  The communication
protocol is embedded in the Designer configuration software and transferred to panel
when you download your project file.

 “N” protocol:
1. Select Project- Controller Setup to open the Controller Setup dialog box.
2. Choose "1) TI435 Net port " from the PLC Model list box.
3. Use cables CA7 or CA9 to connect to the network port only.

“K” protocol:
1. Select Project- Controller Setup to open the Controller Setup dialog box.
2. Choose "4) TI425/435 Prog. Port" from the PLC Model list box.
3. Use cables CA7 or CA9 to connect to the network port or CA8 on the program 

port.
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If you are using a TI435 with the network port you may need to configure this port.
Use TISOFT and connect on-line.  Select "AUX", then "Set Secondary address”,
then "Protocol mode" = HEX.  UniOP defaults to the HEX mode.

If you are using the "K" programming port protocol, you must leave the CPU switch
in the TERM position, otherwise UniOP will not be able to write data to the PLC.

 TI 425/435 Communication Parameters

When you select either of the TI 425/435 drivers (“N” or “K” protocols) the Screen
Designer software will preset the following default communications parameters:  Baud
Rate = 9600, Parity = Odd, and Stop Bits = 1.

Setting the Dip switches on  the TI 435:
SW1 ON  = CPU battery DISABLED

OFF = CPU battery ENABLED
SW2 ON  = Station Address is one

OFF = Station Address set by programming system
SW3 Baud rate selection -  Baud rate = 9600    ON
SW4 Baud rate selection -  Baud rate = 9600    OFF

Connecting to TI 505

UniOP connects to the RS232 programming port on TI505 models using cable CA12.
On TI models with an additional RS485/422 port, use cable CA42 (RS422).  It is
possible to connect one panel to each port.  You may also connect UniOP to the
remote base controller using a CA12.  CTI offers a module that adds 4 more ports.
Verify the configuration of the PLC switch settings.  On the TI545, the switches are
located on the front of the CPU under the access cover.

Switch 1 ON (1) for RS422
Switch 3 OFF (0) for 9600 baud (RS232)
Switch 4 ON (1) for 9600 baud (RS232)
Switch 5 ON (1) for 9600 baud (RS232)
Switch 6 OFF (0) for 9600 baud (RS422)
Switch 7 ON (1) for 9600 baud (RS422)
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Switch 8 ON (1) for 9600 baud (RS422)

18.4 - Siemens S5  and Westinghouse PC 50 / 55 / 500 / 2000

3964R Applications

The UniOP driver referred to as “Siemens 3964R” supports the communication with
SIMATIC S5 systems equipped with the CP524 or CP525-2 Communication
Processors.  The communication supports the RK512 Interpreter and the 3964R
protocol.  More information on this can be obtained from TechNote 20.

Using the Siemens S5 PLC with AS511

The UniOP driver referred to as Siemens S5 (AS511) supports communication with
SIMATIC S5 systems connected to the program port.  Connection to the program port
is via a 20 mA current loop with a CA97 cable (panels with a -004x suffix ONLY).

18.5 - Simatic S7 - MPI

The Designer software offers support for the Simatic S7-300 and S7-400 family of
controllers.  In order to use the MPI protocol, the user must have a panel with a -0044
suffix.  More information can be obtained by requesting TechNote 61.

18.6 - API Motion Controller
Designer offers support for the API motion controller.  More information can be
obtained by requesting TechNote 50.
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18.7 - Unidrive and Quantum III
Designer supports both the Control Techniques’ Unidrive and Quantum III.  CA81 is
an RS-232 cable used only for the Unidrive.  However, the CA116 is a RS-422 cable
that can be used on both the Unidrive and the Quantum III.  For more information on
these, please request TechNote 69.

18.8 - Omron C Series
All models of the Omron C-series PLC's have an LK201(RS-232) or LK202(RS-422)
Host Link Unit except the C20H, CPM1, and CQM1 that have a built in
communication port.  The LK201 unit connects to UniOP by cable number CA7 (RS-
232) or CA65(RS-422).  The C20H is RS232, but uses cable CA44.  The CQM1
series use a CA58 cable, while the CPM series uses either CA58 (RS-232) or CA126
(RS-422).

The Omron C-series PLC's have panel setup defaults when using the Designer for
Windows.  You must change these defaults according to your Omron PLC settings.

1. Model:  The default is C2000H, change according to your particular model.
2. Multiple point:  This is often overlooked, and can lead to no communication 

from UniOP to your PLC.  The Screen Designer for Windows defaults to single 
link.  If you have problems with communication then you must verify your 
configuration.  This depends on the setting of the switch on the back of the 
LK201 Host Link Unit, and your system configuration.  Most systems default 
utilize multiple point connection.

3. Slave Number:  The default is zero.  This setting depends on the LK201 front 
panel switches - MACHINE NUMBER.  The switches are numbers 1 and 2.  
Number 1 is the most significant digit and number 2 is the least significant digit.  
A unit from 00 to 31 can be set.

4. Baud Rate:  This next setting must match the transmission speed of the Host 
Link Unit and the UniOP.  The switch on the LK201 is number 3.  The settings 
on this LK201 switch and the designer panel setup can be selected from 300 to 
19,200 baud, but the UniOP will only communicate from 1200 to 19,200 baud.
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5. Command Level, Parity, and Transmission Format:  The UniOP panel setup
default is even parity and 7 bits with 2 stop bits.  The switch numbered 4 on the
LK201 front panel must match a setting you select with the UniOP Designer Panel
Setup dialog box.

The dip switches on the back of the LK201 are used to select multilink or single link
operation via switch number 3.

 All of these settings on the LK201 host link unit are initialized when the unit’s power is cycled.
 If a setting is changed on the LK201, you must restart the PLC.

Typical Settings for the Designer and LK201

Project-Panel Setup:
MODEL   = C200H
1:N  MULTIPLE POINT
=

YES
SLAVE   = 0
BAUD RATE   = 19,200
PARITY   = EVEN
BITS   = 7
STOP BITS   = 2

LK01 Front Panel:

UNIT # SWITCHES 1 AND 2 ARE 0
This number coincides with the slave number for “Project-Panel Setup”

TRANSMISSION SPEED SWITCH #3 SET AT 6 FOR 19,200 BAUD
This setting coincides with the baud rate set in
“Project - Panel Setup - PLC communications”

COMMAND LEVEL, PARITY, AND
TRANSMISSION FORMAT SWITCH #4 IS SET AT 2
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This setting is synonymous with a Designer Panel Setup consisting of even
parity, 7 bits and 2 stop bits

18.9 - Eagle Micro 190

UniOP supports Eagle Signal's Micro 190 and Micro 190+ ECOM networks.  The
UniOP operator interface can be connected on a secondary link to communicate with
all of the PLC's on that link.  You can read/write data, messages, bargraphs,
attributes, etc., referencing any of the PLC's on the link.  One PLC  link will operate
on the Reserved Data Area or RDA, the main interface for controlling the UniOP with
ladder logic.  The RDA is 23 registers long, reduced from it's standard 37 registers due
to the limited memory of the Micro 190 series. The total number of alarms is 32.

   The Micro 190 series operate at 9600 baud max.  It is sometimes necessary to
   reduce the baud rate down to 4800 baud when the control system includes PID
   loops.  The smaller CP type display panels can operate at 4800. All other
   standard panels must be ordered as an LB (4800, low baud) panel.

   To connect to the Micro 190, use cable number CA19.

18.10 - GE Fanuc Series 90

The GE 9020 fixed I/O brick has only one port, a second port is not possible.  All
other GE 90 series PLCs have an option of adding a CMM module.  Use a CA10
cable to connect a UniOP panel to the programming port on all models.  Use a CA90
(RS-422) or CA7 (RS-232) to connect to a CMM module.

The panel uses a feature of the communication protocol, (SNP) whereas all of the
defined data on each page is optimized (regardless of data type or address range) in
one communication exchange (Datagrams).  Designer now offers support for the SNP-
X protocol, which will offer better communication performance in most cases.
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18.11 - Aromat / Matsushita

With the FP1 controllers, the panel connects directly to the programming port using
cable CA15 using RS422.  A switch next to the programming port under an access
cover can select the baud rate, 9600 or 19200.  On some PLC models it is possible to
use an additional RS232 port.  You must configure the port using the PLC
programming software in order to make the port active.  Refer to the PLC manual for
further details.

Designer also supports FP3, FP5, and FP10, all of which do not have an additional
RS-232 port.

18.12 - Idec

UniOP can connect directly to the IDEC programming port, or to the link adapter.  If
connected to the programming port directly, the signal exchanges are not purely
RS232.  A special cable is used containing signal conditioning electronics.  The
Micro3 PLC uses a CA76 cable to connect to a UniOP panel.

Information on addressing the FA-series controllers is available by requesting
TechNote 57.

18.13 - Keyence

Use a CA61 cable to connect a UniOP panel to the programming port on the KV300
PLC.  A second port can be added using a KV-L2 module.  Use a CA80 cable to
connect to this module.
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18.14 - Mitsubishi A Series

Use a CA66 cable to connect a UniOP panel to the A series PLC programming ports.
The driver “Mitsubishi A” is used for the programming port.  A second port may be
added using a MELSEC module.  Use a CA32 cable to connect to this module and
select the “MELSEC A” driver.  More information is available by requesting
TechNote 49.

18.15 - Telemecanique

Use a CA94 cable to connect a UniOP panel to a TSX17.  A second port can be added
using a Unitelway coupler module.  Use a CA72 to connect to this module.  A TSX47
can have a Unitelway module added, but a CA84 cable is used to connect to this
module.

Designer also supports TSX-07 and TSX-27, using Unitelway on their programming
ports.  The panel is also capable of acting as a Unitelway slave station.  See TechNote
34 for more information on Unitelway

18.16 - Klockner-Moeller

Designer offers support for Klockner-Moeller.  More information can be obtained by
requesting TechNote 51.  The following PLCs are supported:

- PS4-200
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- PS306
- PS316
- PS416

18.17 - Compumotor

Several models of Compumotor products are supported by the Designer software.
When using a Compumotor motion controller, the following lines MUST be at the top
of the motion control program for initialization:

ERRBAD13,10,63,32
ERRDEF13,10,45,32
ERROK13,10,62,32
ECHO0
ERRLVL3

If you are using the  Compumotor network, where you are daisy chaining two or more
Compumotors together, you need to replace the last two lines in the above initialization
with the following two lines:

ECHO1
ERRLVL1

18.18 - Hitachi
Designer offers support for the following Hitachi PLCs:

- H Series
- EM Series
- EC Series
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18.19 - The VT100 Driver

For additional information on the VT100 driver, request TechNote 27.

Description

The VT100 panels can be configured in either point to point or multi-drop
configurations.  In the multi-drop configuration, a number of panels, each sharing a
common transmit line and a common receive line, can be attached to a single host.
The host unit might be a computer or a PLC, programmed to control the multi-drop
network.  A separate document is available for VT100 that provides complete details
for VT100 applications.

The type of configuration required can be specified in the Communication menu of the
panel.  The default configuration is point to point.  The multi-drop configuration can
be enabled by specifying YES for the Multi Drop option.  The communications port is
the lower port labeled “PLC”.

In the multi-drop configuration each panel can be enabled or disabled as a Receiver.
A disabled Receiver only listens for the multi-drop commands from the host.  It
ignores any other data that is transmitted from the host.  Each panel can also be
disabled as a Transmitter or enabled as a Permanent Transmitter or as a Short Span
Transmitter.

A Disabled Transmitter does not transmit any data at all to the host.  A Permanent
Transmitter is free to transmit to the host until the host disables it as a transmitter.  A
Short Span Transmitter uses a simple token passing mechanism.  A Short Span
Transmitter transmits all of the current data in its' transmit buffer to the host.  When
the transmit buffer is empty it terminates its transmission by passing the transmission
token (the right to transmit) back to the host together with the ID of the next panel that
should receive the token.  The host can then enable the specified panel as the next
Short Span Transmitter.
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In the multi-drop configuration, each panel must be assigned a unique ID number
between 1 and 255.  An ID of 0 is used as a NULL ID.  A panel can be assigned a
NULL ID but in this case it does not transmit or receive in the multi-drop
configuration.  Each panel is also given the node ID of the next panel that it is attached
to in the network.  In this way a network ring can be created

In VT100 mode, panels have the following characteristics:

•  A 7-bit character set is used.
•  There is no local echo.
•  Characters are received from the host in a queue before processing and 
    XON/XOFF protocol can be enabled to prevent overload of that queue.
•  Characters to be sent to the host are placed into a queue before transmission.  
    The host can use XON/XOFF protocol to control the transmission of these 
    characters, if XON/XOFF is enabled in the panel, to prevent overload of its

         own queue.
•  Characters received from the host are displayed by the panels if they are     

within the ASCII range 20 - 7E Hexadecimal.
•  Received escape sequences that are erroneous, not recognized or         
    unsupported are ignored.
•  Control functions are performed without displaying character(s) to       
    represent the function.
•  Characters moved outside the margins are lost.
•  Cursor can not be positioned outside the margins.
•  All displayed characters can be erased.
•  Received characters replace characters at the cursor position.
•  Keyboard can not be disabled.
•  Positioning units are characters and lines.



Application Notes

Exor Electronic R&D                                                               18-
21

Escape Sequences

The following table lists the supported control characters and the response of the
VT100 panel when they are received:

Short HEX Function
Null NUL 00 ignored
Backspace BS 08 move cursor left
Tab HT 09 move cursor to the next tab stop
Line feed LF 0A linefeed or new line
Vertical tab VT 0B same as line feed
Form feed FF 0C same as line feed
Return CR 0D left margin of current line
XON DC1 11 continue transmitting
XOFF DC3 13 stop transmitting
*BELL BEL 07 sounds the bell tone
Escape ESC 1B start escape sequence

Two types of escape sequences are recognized and at least ignored if sequence is not
supported.

•  Escape sequence (ANSI):  ESC + 0 or more chars
    in range 0x20 - 0x2F + final character in range 0x30 - 0x7E

•  Control sequence (ANSI):  ESC + [ + 0 or more chars
    in range 0x20 - 0x3F + final character in range 0x40 - 0x7E
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The following table lists the escape sequences supported by the VT100 panels:
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Command Command Sequence
Cursor up one line ESC [ A
Cursor down one line ESC [ B
Cursor right one column ESC [ C
Cursor left one column ESC [ D
Cursor up ESC [ nn A
Cursor down ESC [ nn B
Cursor right ESC [ nn C
Cursor left ESC [ nn D
Cursor position ESC [ ll ; cc H
Cursor home ESC [ H
Cursor On ESC [ ? 25 h
Cursor Off ESC [ ? 25 l
Autowrap On ESC [ ? 7 h
Autowrap Off ESC [ ? 7 l
Horizontal and Vertical position ESC [ ll ; cc f
Index ESC D
Reverse Index ESC M
Next Line ESC E
Save cursor and attributes ESC 7
Restore cursor and attributes ESC 8
Scroll Up ESC [ nn S
Scroll Down ESC [ nn T
Exit attribute mode ESC [ m
Exit attribute mode ESC [ 0 m
Bold ESC [ 1 m
Blink ESC [ 5 m
Reverse ESC [ 7 m
Double height line (top) ESC # 3
Double height line (bottom) ESC # 4
Single width line ESC # 5
Erase to end of line ESC [ K
Erase to end of line ESC [ 0 K
Erase from beginning of line ESC [ 1 K
Erase entire line ESC [ 2 K
Erase to end of screen ESC [ J
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Erase to end of screen ESC [ 0 J
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Erase from beginning of screen ESC [ 1 J
Erase entire screen ESC [ 2 J
Show page ESC [ nn P
Set LED on ESC [ nn q
Set LED off ESC [ nn x
Set all LED’s off ESC [ 0 x
Set Buzzer on ESC [ 65 q
Set Buzzer off ESC [ 65 x
Increase Panel Brightness ESC [ ? 5 h
Decrease Panel Brightness ESC [ ? 5 l
Identify Terminal ESC Z
Receive Control ESC [ nn {
Transmit Continuous Control ESC [ nn }
 Transmit Short-Span Control ESC [ nn |

Only graphic units will support VT100 double size characters.
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